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1. INTRODUCTION 

1.1. Purpose of this Document 
 

The purpose of this document is to provide an overview of the 
installation and configuration process for Biotics. In addition, this 
document provides information on how to perform administrative 
functions, such as defining new users and backing up the system. 

For complete details on how to use Biotics, refer to the Biotics User's 

Guide available on-line within Biotics. 

 

 

1.2. Overview of the Installation and Configuration Process 
 

Installation and configuration of Biotics is done in the following steps: 

The prerequisite hardware and software is acquired, installed, and 
configured for the server(s) and client machines.  Oracle and MTS are 
installed and configured on server and client machines as detailed in the 
document Oracle and MTS Installation and Configuration Guide for 

Biotics 4. 

 

Data are converted from legacy database(s) and imported to Biotics 4 
database. 

 

Tracker and Administrator software is installed on the server and client 
machines. 

 

Extensible tables are created, dynamic tabs are configured, and optional 
data are loaded. 

 

Mapper software is installed on the server and client machines. 

 

The coordinate system to be used for all theme data are defined. 

 

Prepare Technical 
Environment 

Convert Data 

Install Tracker and  
Administrator 

Create Extensibility 

Install Mapper 

Define Coordinate 
System 
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General settings, such as the province/state code, are set. 

 

Reference theme data are acquired, imported, restructured, and defined 
to Mapper.  Legends are established for the themes. 

 

The index theme used to set the "work area" is defined. 

 

Themes are made available for use with the Zoom By function, which 
allows users to quickly zoom to a specific geographic location by 
searching existing theme data. 

 

The scenes that Mapper automatically loads when working with element 
occurrences, managed areas, and sites are modified to include local data. 

 

Information to be automatically calculated by Mapper when a feature is 
created is defined. 

 

The database views that Mapper joins to the shapefile data are 
customized. 

 

Themes are created for Managed Areas and Sites. 

 

Themes are created for Element Occurrence Sources and Element 
Occurrence Representation Polygons. 

 

Map types and templates are defined. 

 

The system is tested, staff are trained, and Mapper is put into production. 

 

 

Set System Settings 

Integrate Reference 
Theme Data 

Define Index Theme 

Configure Zoom By 

Modify Scenes 

Define Spatial Attributes 

Modify Database Views 

Create Managed Area 
and Sites Themes 

Create Element 
Occurrence Themes 

Configure Powerpack 
Mapper 

Put Mapper into 
Production 
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Clients Servers 

Tabular Data 

Spatial Data 
File Server 

PCs within LAN/WAN 

Tabular Data 
“ New HDMS ” Application 

Clients Servers 

Tabular Data 
Biotics Tracker Application 

Biotics Mapper Application

Data 

Database 
Server 

Tabular Data 
Biotics Tracker Application 

PCs Outside LAN/WAN Connecting via the Internet 

Application 
Server 

Web Server 

1.3. Biotics Software Components 
Biotics includes four primary applications, described below.  Each application provides a 
windows interface and manages data stored within a common Oracle database. 

 
Provides data management capabilities for all of the tabular data 
ported from BCD and a number of new methodological 
enhancements.  
 

Provides spatial data management capabilities through a custom 
ArcView GIS interface.  Supports the spatial EO methodology.  

 
Interface for managing security, system options, and extensibility. 

 
Utilities for data import/export and bi-directional data exchange. 

 

Figure 1-1 – Biotics Architecture Components 

The above figure illustrates all of the logical components.  The server components may be 
installed on separate computers or may be installed on the same computer.  Biotics 
requires software to be installed on the client (each user’s computer) and one or more 
servers depending on a member program’s configuration.  Each application accesses data 
stored within the Oracle database.  The Biotics Tracker application connects to the 
database through a middle tier called an Application Server, while the Biotics Mapper 
application connects to the database directly.  Users unable to directly access a member 
program’s computer network may use the Biotics Tracker application (but not the Biotics 
Mapper application) by connecting through the Internet.  A web server is required to 
support this configuration.  Biotics Mapper accesses spatial data stored in ArcView shape 

Tracker 

Mapper 

Administrator 

Exchanger 
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files that reside on a file server. The following tables provide a more detailed look at each 
component.   

 
Components in common between the Biotics Tracker and Biotics Mapper applications: 

Component Description Required Software 

Database Server Manages all of the non-
spatial Biotics data. 

Oracle server (8.1.7 or later) running on 
any supported operating system. 

 
Components specific to the Biotics Mapper application: 

Component Description Required Software 

Biotics Mapper 
Client 

The user interface for 
the Biotics Mapper 
application. 

Windows NT/2000/XP 
ArcView (3.1, 3.2, 3.2ª, or 3.3) 
Oracle client (8.1.7 or later) with a 
configured Net Service Name. 
If accessing map data from an ArcInfo 
or ArcStorm server, NFS must be 
installed. 

Biotics Mapper 
File Server 

The Biotics Mapper 
application software and 
managed spatial layers 
are stored on a file 
server.  Other GIS 
reference layers can be 
stored elsewhere as long 
as they can be mapped 
to a drive. 

Microsoft Windows NT, 2000, or 2003 
will perform best for the Mapper 
application software, but GIS reference 
data may be served from any operating 
system. 

 
Components specific to the Biotics Tracker application: 

Component Description Required Software 

Biotics Tracker 
Client 

The user interface for 
the Biotics Tracker 
application. 

Windows 98/NT/2000/XP 

Application Server Manages the Biotics 
COM objects that 
perform business logic, 
data access, and data 
transport. 

Microsoft Windows NT with Microsoft 
Transaction Server (MTS) (MTS is 
free), Windows 2000, or Windows 
2003.   

Web Server Manages http requests.  
Required for Biotics 
Tracker application 
users connecting 
remotely via the 
Internet. 

Microsoft’s IIS (comes with NT, 2000, 
and 2003) 
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The following table lists the deployment options for Biotics: 
 

Option Description Comments 

Biotics Tracker 
and Mapper 

Both Biotics Tracker 
and Mapper applications 
are installed.   

Not all users need to run both 
applications. 

Biotics Tracker 
only 

The Biotics Tracker 
application may be 
utilized by itself without 
Biotics Mapper.  
Programs who need 
more time to prepare for 
Biotics Mapper or who 
want to use their own 
GIS may deploy this 
option.   

Programs can add Biotics Mapper at a 
later date. 
 
Programs can use their own GIS 
application.  These programs will be 
responsible for any integration with 
Biotics Tracker. 

 
1.4. Biotics Mapper Architecture 

 

Biotics Mapper is made up of a number of components that all work together.  This section 
briefly describes these components. 

 

Figure 1-2 – Biotics Mapper Software Architecture 
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ArcView (by ESRI) provides the GIS engine, the user interface, map 
display, and GIS functions used by Mapper. It is installed prior to 
Mapper. All Mapper tools are embedded in the standard ArcView user 
interface (to the user they appear as normal ArcView functions).   
Mapper tools make extensive use of Avenue scripts (Avenue is 
ArcView's programming language). 

The ArcView component of Biotics Mapper shows up on the Windows 
task bar as follows: 

 

Powerpack is a product within a product. It provides 75% or more of the 
GIS functionality required in Mapper. These extensions extend the 
functionality of ArcView, and make common tasks easier to perform. 
The extensions are written using ArcView's programming language, 
Avenue. 

Powerpack Navigator allows you to add or remove themes from the 
view, manage legends, manage filters, zoom to locations, and manage 
multi-user shapefiles. 

Powerpack Designer helps users create, edit, delete and query shapes. 

Powerpack Mapper produces paper maps. 

The Powerpack component of Biotics Mapper does not show up on the 
Windows task bar. 

 

The Biotics extension provides the remaining GIS functionality that 
Powerpack does not deliver (the functionality that is specific to the 
Heritage Business), such as the “Examine Separation Distance” function, 
and the generation of EO Representation Polygons from Source 
Features.   

The extension does not show up on the Windows task bar. 

 

Shapefiles are ArcView’s proprietary, native, storage format for shape 
data. They are used to store the Source Feature, EO Representation, 
Managed Area, and Site shapes, and consist of at least 3 files: 
 .SHP 
 .SHX 
 .DBF 

Typically there are 4 additional index files for each shapefile: .AIN, 
.AIH, .SBN, and .SBX. 

The default location of the “master” shapefiles is the 
\Biotics\Themes\Biotics directory on the server. 

ArcView 

Powerpack 
Extensions 

Biotics Extension 

Shapefiles 
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There is also a mirror set of “archive” shapefiles for each Biotics 
shapefile that stores edited & deleted shapes. 

The default location of the “master” archive shapefiles is the 
\Biotics\Themes\Biotics\Archive directory on the server 

Shapefiles are created during installation, and do not appear on the 
Windows Taskbar. 

 

ODBC is a standard that allows any software program (ArcView, Excel, 
Word, etc) to talk to any database (dBase, Oracle, SQL Server, etc). It is 
implemented by a main ODBC program and “ODBC Drivers” that must 
be installed on each machine. 

The main ODBC program (EXE and DLLs) is usually installed with 
Windows (into the winnt\system32 directory).  If it is not present, the 
Oracle installation program will install it. 

The ODBC Drivers (DLLs) are installed by each database program 
(usually into the winnt\system32 directory).  The Oracle ODBC Driver 
will be installed by the Oracle installation program. 

The ODBC program is accessed using the Windows Control Panel. 

Using the ODBC program, you create and configure “Data Sources” for 
each database that you want to access.  Mapper will create an ODBC 
data source for the Biotics database during installation.  Data Sources 
are saved in the Windows Registry. 

A Data Source based on an Oracle ODBC Driver (as is the case in 
Mapper) simply references the name of an Oracle “Alias”. 

Beware of the old 16 bit version of the ODBC program on the computer.  
The current/proper version of the ODBC program is the 32 bit version.  
The 16 bit version will cause problems (ArcView will not be able to 
access the Data Sources). 

ODBC does not appear on the Windows Taskbar. 

 

SQL*Net is the Oracle software that allows client machines 
(workstations) to talk to the Oracle database on the server. It must be 
installed before Mapper. 

Once installed, you must configure a Net Service Name that specifies the 
physical location of the Oracle database. 

SQL*Net does not appear on the Windows Taskbar.  

 

Complex application components, such as the data entry forms and 
Navigator, are provided by custom windows-based programs.  These 
programs communicate with ArcView through DDE, and are developed 
in PowerBuilder. 

ODBC 

SQL*Net 

Powerpack Library 
and Biotics EXE 
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The PowerBuilder component of Mapper shows up on the Windows task 
bar as follows: 

 

Tabular data created and maintained using Mapper are stored in a 
relational SQL database (Oracle). It is a fully multi-user environment. 
Oracle starts up automatically with Windows, and stops when Windows 
shuts down. 

Oracle does not show up on the Windows task bar when Mapper is 
running. 

DDE (Dynamic Data Exchange) allows two programs to talk to each 
other (send messages to each other). It is built into the Windows 
Operating System. This is how the ArcView part of Mapper 
communicates with the PowerBuilder part of Mapper. 

Most DDE communications are logged in the ArcView Interface 
Monitor. 

Occasionally the DDE connection between the ArcView and 
PowerBuilder parts of Mapper can be broken.  When this happens, the 
application will stop working properly.  For example, you will click on 
the Navigator button, but the Navigator window will not open.  You 
must exit Mapper (and manually end the PowerBuilder part using the 
EXIT button on the PowerBuilder window) to rectify this problem. 

 

 

 

 

 

 

Oracle Database 

DDE 
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2. PREPARING THE TECHNICAL 

ENVIRONMENT 

Before you install and configure Biotics, you must first prepare your 
technical environment.  This includes the server, database, and client 
machines. 

2.1. Server 
The server components can be deployed on a single computer or across 
multiple computers.  As a very general guideline, here are some ways the 
components might be deployed starting from the most minimal 
configuration: 

1. Database server, application server, and file server all on one 
computer. 

2. Database server on one computer; application and file server on 
another computer. 

3. Database server, application server, and file server all on 
separate computers. 

For the Biotics server, use the guidelines below to estimate whether your 
current hardware will be adequate to support the Biotics Mapper and 
Tracker applications. 

Factors to consider when selecting a server include: 

1. Number of users: Under 4 is small, 4 - 12 is medium, above 12 is 
large. 

2. Oracle installation on the server (if Oracle is on another server,  
the resource load will be spread across the two machines). 

3. The Size of GIS datasets (especially images)  

4. Number of Element Occurrences in database,  

       less then 4000 is small, greater then 20,000 is large. 

5. The size and quantity of database queries by users   

Depending on the current technical environment, some or all of the 
following steps may be required to prepare the server: 

1. Install the hardware. The recommended hardware configurations for 
the server machine are: 

 

 Minimum 

Configuration 
Medium 

Configuration 

Large 

Configuration 

CPU 1 GHz 2.4 GHz Dual 2.4 GHz 

RAM 2 GB  3 GB 4 GB 
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If the server is hosting a large amount of GIS data such as images, dual 
network cards on the server will impove throughput. 

2. Install Windows 2000 (server version preferred, with Service Pack 
4) or Windows 2003 for the application and file servers.  A Unix 
server can be used for the Oracle database. 

3. Decide where the Biotics Mapper software and theme data will be 
installed, and share the drives/directories if necessary.  For example, 
you might install the Mapper software into \\server1\apps, and the 
theme data into \\server1\data. 

4. Define Windows users. 

5. Refer to the Oracle and MTS Installation and Configuration Guide 

for Biotics 4 for details about installing and configuring Oracle and 
MTS for your Biotics server. 

2.2. Configuration instructions for Windows 2003 server 
Default settings changed significantly from Windows 2000 server to Windows 2003 server, 
necessitating a number of additional configuration changes in order for Biotics to work. 

Enable Network COM+ Access 
1. Click Start, point to Control Panel, and then click Add or Remove Programs. 

2. Click Add/Remove Windows Components. (left side of window) 

3. Select Application Server, and then click Details. 

4. Click Enable network COM+ access and DTC access, and then click OK. 

5. Click Next, and then click Finish. 
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Configure MSDTC Security: 

1. Click Start, point to Control Panel, Administrative Tools, and then click Component 
Services. 

2. Expand Component Services to My Computer. 

3. Right click on My Computer in the tree view and select Properties. 

4. Click on the MSDTC tab. 

5. Click on the "Security Configuration..." button. 

6. Configure based on the below screen shots (different if service pack 1 has been applied or 
not): 

Windows 2K3 Server (no SP) 
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Windows 2K3 Server SP1: 

 

 

Ensure the executing user has Access and Launch permissions 

For Windows Server 2003 SP2+ 

Server 2003 SP2 has a special group called "Distributed COM Users" which is automatically 
added in the COM+ Security Limits of the machine.  Users need to be added to this group 
who will need access to run COM+ components (i.e. usually the ALL_DOMAIN_USERS 
groups for the domain will be added). 

1. Click Start, point to Control Panel, Administrative Tools, and then click Computer 
Management. 

2. Expand "System Tools" and then "Local Users and Groups" 

3. Click on the "Groups" folder and double click the "Distributed COM Users" group in the 
right hand window. 

4. Ensure that all domain/machine users which need to run COM+ components are added to 
this group.  Typically the "Domain Users" group for the domain will be sufficient. 

a. Right click “My Computer” located on the desktop or the Start menu and choose 
Manage. 

b. Open the “Local Users and Groups” part of the tree and click Groups. 

c. Double-click “Distributed COM Users” and click the Add button. 

d. Add a domain-level group (e.g., NATURE\Tracker_Users) that contains users you want 
to have access to Tracker. 

e. Click OK to confirm your choices and close the Group Properties window. 
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For Windows XP SP2 (and Windows Server 2003 SP1) 

Open COM+ Component Services. 

1. Click Start, point to Control Panel, Administrative Tools, and then click Component 
Services. 

2. Expand Component Services to My Computer. 

3. Right click on My Computer in the tree view and select Properties.view and select 
Properties. 

4. Click on the COM Security tab. 

5. Click on "Edit Limits…"  (the next step will need to be applied to both "Edit Limits…" 
buttons under "Access Permissions" and "Launch and Activation Permissions". 

6. Ensure all Domain/Computer users who will be accessing the COM+ components have 
both Local and Remote Access.  Typically the "Domain Users" group for the domain will 
be sufficient. 

a. Right click “My Computer” located on the desktop or the Start menu and choose 
Manage. 

b. Open the “Local Users and Groups” part of the tree and click Groups. 

c. Double-click “Distributed COM Users” and click the Add button. 

d. Add a domain-level group (e.g., NATURE\Tracker_Users) that contains users 
you want to have access to Tracker. 

e. Click OK to confirm your choices and close the Group Properties window. 

 

Ensure Windows Firewall allows MSDTC to access port 135 

Configure Windows Firewall to include the MSDTC program and to include port 135 as an 
exception. To do this, follow these steps:  

1. Click Start, and then click Run. 

2. In the Run dialog box, type Firewall.cpl, and then click OK 

3. In Control Panel, double-click Windows Firewall. 

4. In the Windows Firewall dialog box, click Add Program on the Exceptions tab. 

5. In the Add a Program dialog box, click the Browse button, and then locate the Msdtc.exe 

file. By default, the file is stored in the <Installation drive>:\Windows\System32 
folder. 

6. In the Add a Program dialog box, click OK. 

7. In the Windows Firewall dialog box, click to select the msdtc option in the Programs and 
Services list. 

8. Click Add Port on the Exceptions tab. 
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9. In the Add a Port dialog box, type 135 in the Port number text box, and then click to 
select the TCP option. 

10. In the Add a Port dialog box, type a name for the exception in the Name text box, and 
then click OK. 

11. In the Windows Firewall dialog box, select the name that you used for the exception in 
step j in the Programs and Services list, and then click OK. 

 

2.3. Client 
Depending on the current technical environment, some or all of the 
following steps may be required to prepare the client machines: 

1. Install the hardware. The minimum and recommended hardware 
configurations for the client machine are: 

 Minimum 

Configuration 
Recommended 

Configuration 

CPU 400 MHz 1 GHz or better 

RAM 256 MB 512 MB or better 

Screen 
Resolution 

1024 x 768 or higher 1024 x 768 or higher 

 

2. Install Windows 2000 Professional, Windows XP, or Windows 
2003. 

Notes: Windows 3.x, Windows 95, and Windows 98 are not 
supported.  The setup program will prevent you from 
installing the Biotics Mapper client on these versions of 
Windows. 

For maximum performance and stability, make sure the file 
system on the computer is NTFS (Windows NT) not FAT 
(DOS). 

3. In addition to these operating system requirements, a minimum of 
Internet Explorer 5 is required for Tracker clients. 

4. Define users 

In a peer-to-peer network environment, it is necessary to define users 
on each client machine (on Windows NT choose User Manager, on 
Windows 2000 choose Computer Management, Local Users and 
Groups).  In a true client-server environment, where users are all 
defined centrally on the server, this is not necessary. 

5. Install ArcView (3.2a or 3.3) 

Note: ArcView can be installed on the server instead of the client 
if you prefer, but will run slower. 

Rnning Arcview 3.x on XP requires the XP patch from ESRI. 

6. Install Oracle client 
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The Oracle client software must be installed on each client machine.  
This must include at least SQL*Net (2.x or higher) and the Oracle 
ODBC driver. 

Choose the “Administrator” installation type for machines belonging 
to Biotics administrators, and choose “Custom” installation type for 
all other (end-user) machines, ensuring the ODBC driver for Oracle 
is loaded. 

Once Oracle is installed, you must create a “Net Service Name” that 
points to the database.  The Net Service Name can be any value (e.g. 
oracle_server). 

Refer to the Oracle and MTS Installation and Configuration Guide 

for Biotics 4 for details about installing and configuring Oracle for 
your Biotics clients. 

7. Establish drive mappings 

Every client machine must have one or more drives mapped to the 
location of the Biotics Mapper software and theme data on the 
server. The drive letter(s) that are assigned must be the same on all 
the machines.  For example, every user might have a drive T: 
pointing to the location of the themes, and drive O: pointing to the 
Mapper software. 

Further, if you choose to have each user's workspace on the network 
instead of on the local hard drive, you must also establish drive 
mappings to the workspace.  For example, each user might have an 
H:\ drive that points to a personal workspace.  In reality, H:\ maps to 
\\server1\users\smith when smith is logged in, \\server1\users\jones 
when jones is logged in, etc.   

Drive mappings are best established using login scripts.  However, 
they can also be established manually using “My Computer” or the 
“Windows Explorer”. 

The drive mappings must be established before installing the 
software, because the full path to both the software and themes is 
stored in several places within the Mapper program. If you install 
Mapper as the system administrator to one location (e.g. 
D:\Software\Biotics), with the intention that users will access it from 
a different location (e.g. O:\Biotics, where O: is mapped to 
D:\Software), you will run into trouble.  You should install the 
software to the location where it will be used (e.g. O:\Biotics). 

In addition, if Mapper is to access map data from an ArcInfo or 
ArcStorm server, NFS must be installed and operational on each 
computer that will run Mapper, and drive mappings established to 
the NFS drives. 

Existing Biotics Installations: Installing Biotics without first 
uninstalling a previous version of Biotics is not supported at this time.  

General Notes 
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Please be sure to uninstall an existing Biotics installation before 
installing again. 
 

Installed Files: The installation package includes some software that 
Biotics depends on to run.  If the software already exists on the target 
machine it will not be installed.  See Section 23 for a complete listing of 
software that is checked/installed during the Biotics installation.   
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3. CONVERSION TO BIOTICS 

3.1. Run the Master Build Script 
 
This section details the steps necessary to build the Biotics 
database schema from scratch, should it ever be necessary to do so.  
This is a time consuming and meticulous process that should only 
be done when absolutely necessary.   
 
The database is built using the master_db_script.sql script, also 
known as the master build script.  This is merely a shell script that 
executes many, many other scripts.  It will automatically spool 
output into log files for each step taken so that you can review 
them for errors.  As a part of each step, a commit statement is 
generated to save the work previously done.  When the script is 
completed, a table tracking the version of the script used to build 
the database is updated, a final commit is issued, and spooling is 
turned off.   
 
The master build script does not include commands to build 
extensible tables.  If you have extensible tables, you should modify 
this script to include a command that will build those tables or 
build them separately afterwards.  Where you place this command 
depends on what tables you are building.  They must be built after 
the main tables and indexes have been built, since extensible tables 
are dependent on one or more of these tables.  You should consider 
any other dependencies when deciding when these tables are built.  
Currently, the script has a commented out field to build Central 
only extensible tables.  If there are special dependencies, you 
should consider placing your command at this location. 
 
Given the nature of the database, the master build script builds the 
schema in a specific order so that tables linked to other tables are 
built at the proper time.  You should avoid at all costs rearranging 

the order of any commands in the master build script.  Doing so 
may cause errors that may be difficult to identify until you attempt 
to install and use the application.   
 

Before you start 
1. You should have already created the tablespaces in which 

your tables and indexes will reside.  You should have these 
names handy because you will be prompted for them. 
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2. You should be logged into SQL+ as the user used by the 
Biotics application. 

 
3. You have downloaded the master build script and all the 

scripts it executes to your hard drive.  At Home Office, you 
would need to check out everything in the 
projects\hdms\sql folder from CVS in order to obtain the 
latest scripts. 

 
4. You have read the master build script at least once to 

understand and appreciate its execution. 
 

Running the master build script 
1. Execute the script with the following command: 

@ <path where file resides>\master_db_script.sql 
 

2. You will be prompted to supply the path name again 
without the backslash.  This is used to locate the scripts that 
are executed.  The output logs that the scripts generate are 
also placed in this path. 

 
3. You will be prompted to supply the names of your 

tablespaces.  The script allows for separate tablespaces for 
each type of table and index.  For example, you may wish 
to place all of your spatial tables in one tablespace, and 
your element data tables in another, with system tables in 
yet another.  The script also allows you to place indexes in 
separate tablespaces.  This is not required, so if you have 
just one or two tablespaces, supply them for each 
appropriate prompt.  If you make a mistake in typing a 
name, you will need to hit CTRL+C to abort the script and 
start over. 

 
4. The script will then drop all main tables and indexes.  If 

this is the first time you are building the database, you may 
wish to comment out this command to skip this step.  This 
step is only necessary if you are rebuilding an existing 
database. 

 
5. Next, the Tracker business and system tables and indexes 

are built. 
 
6. Various Tracker utilities (particularly those used in Data 

Exchange) are built next. 
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7. Views used by both Tracker and Mapper are built next. 
 
8. Sequences, stored procedures, and functions used by both 

Tracker and Mapper are then built. 
 
9. Next, the domain tables are populated using scripts that 

insert the values for each table.  The only domain tables not 
populated by this method are D_MAPSHEET and 
D_WATERSHED.  Since these are exceptionally large lists 
of values, they are usually populated by dump files.  The set 
of domain table insert scripts includes scripts for both of 
these tables, however.  So if you wish to populate them at 
this time with an insert script, you should modify the 
master build script to include a command to execute these 
scripts.   

 
10. Mapper-specific tables are built next. 
 
11. The Data Exchange tables are then built. 
 
12. The DB_VERSION table is updated to show the version of 

the master build script that was used to build the database. 
 
13. A final commit is issued and the script is exited. 

 

After running the master build script 
As noted previously, the master build script spools the output of 
the above steps to output logs.  These files are placed in the path 
that you specified at the beginning prompt.  You should open each 
of these files and search for any occurrences of the word “error” in 
order to see if any errors were taken during execution.  This is the 
most tedious part of the process, as some of the logs can be quite 
long and searches on “error” will flag things that aren’t actually 
errors (like words in exception code and user messages).  But this 
is the best way to find out if any problems were encountered while 
the schema was being built.  Some errors will be minor, like if an 
index was dropped that didn’t previously exist.  But all errors 
should be investigated before proceeding further.  If it becomes 
necessary to start over, this can be done by merely rerunning the 
script.  Everything built previously will be dropped and the 
previous output logs will be overwritten. 
 
The log files are listed below: 

• hdms_drop_indexes.log 

• hdms_drop_tables.log 
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• tables_indexes.log 

• audit_system01.log 

• utilities.log 

• primaryentity.log 

• sec_wl_ddl.log 

• create_views.log 

• NAVIGATOR_TABLES.log 

• DESIGNER_TABLES.log 

• MAPPER_TABLES.log 

• BIOTICS_TABLES.log 

• seq_proc.log 

• dmla.log 

• dmlb.log 

• dmlc.log 

• data_exchange.log 
 
The last step in building the schema is to load data from 
System_Working_List.Dmp file.  This data is in a dmp file  
because some of the columns are too long to be loaded through 
SQL+. 

1. Disable constraints so data can be loaded.  Perform the 
following commands:  
alter table system_working_list_menu 

modify constraint sys_wl_menu_wrk_list_type_fk disable; 

 

alter table system_working_list_menu  

modify constraint sys_wl_men_p_sys_wl_menu_id_fk 

disable; 

 

alter table working_list  

modify constraint wrk_list_working_list_type_fk disable; 

 

alter table system_working_list_base_table  

modify constraint fk_system_w_system_wo_system_w 

disable; 
 

2. Edit the batch file 
C:\Projects\hdms\hdms\sql\linnet_scripts\ImpData.Bat 
which loads System_Working_List.Dmp.   

 
3. Run the batch file.  Verify the results by comparing the 

import file log (System_Working_List_IMP.log) to the 
export file log (System_Working_List_EXP.log) 
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4. Enable the constraints that were disabled with the following 
commands:  
alter table system_working_list_menu 

 modify constraint sys_wl_menu_wrk_list_type_fk enable; 

 

alter table system_working_list_menu  

modify constraint sys_wl_men_p_sys_wl_menu_id_fk 

enable; 

 

alter table working_list  

modify constraint wrk_list_working_list_type_fk enable; 

alter table system_working_list_base_table  

modify constraint fk_system_w_system_wo_system_w 

enable; 

 

5. Load the following table that depends on the data loaded in 
step 2. 
@ <path where the file 

resides>\dml\system_dml\System_Working_List_Base_Tabl

e.sql 

 

3.2. Run the Data Conversion Software 
 
Below are the steps needed to prepare a computer for data conversion. 
These instructions assume that the target database has been prepared, 
with core tables and stored procedures loaded. Though not included as 
part of this process, it might be useful to install a Windows client such as 
DBVisualizer to query the contents of the data conversion logs. Of 
course, the client doesn’t need to reside on the same computer where 
data conversion is to take place but it does need to be able to access the 
target database. 
 

Required software on the target computer: 
1. Oracle client 8.1.7 or above 
2. WinZip  
 

Prepare Computer for Using Conversion Program 

1. Get Oracle configured on the target computer (if necessary):  Set 
up a Net Service Name to connect to the conversion database.   

 
2. Download the latest xml2biotics.zip file from: 

http://cvs.natureserve.org/index.cgi/hdms/dataconversion/Perl/ 
by clicking on Download Tarball, and save it to a directory. 
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3. Un-package the Data Converter onto the target computer by 
double clicking on the tarball saved in the above step.  When it 
opens in WinZip, use the ‘Extract’ option and set the ‘Extract to’ 
path to any valid mapped drive or path (i.e., ‘c:\’, ‘d:\’, 
‘c:\mypath\dataconversion’, and so on). 

 
4. Once the Data Converter is unzipped onto the Target computer, 

download the conversion spreadsheets from: 
http://cvs.natureserve.org/index.cgi/hdms/dataconversion/conver
sion_spreadsheets/ and scrolling all the way down to the bottom 
and clicking on download Tarball. 

 
5. Place the configuration spreadsheets in the unzipped directory 

structure:  The conversion spreadsheets should be put in <extract 
drive>\<optionalpath>\projects\hdms\dataconversion\conversion
_spreadsheets. For subnational data, the name is 
‘subnational_configuration.xls’. If edits are made, make sure 
that the configuration spreadsheet is also saved as a tab-
delimited ‘.txt’ version as well. 

 
6. Get the latest data files:  Place these in a local XML directory 

(make sure that you specify the right path when running the 
GUI). Note that the default path that shows up in the GUI entry 
box is c:\projects\hdms\dataconversion\xml_files\<version> 
(subnational version names here are defaulted to “<version>hp”) 

 
7. Invoke the GUI application:  Using Windows Explorer to 

navigate to the <extract drive>\<optional 
path>\projects\hdms\dataconversion\Perl\bin directory and 
double-click on the ‘xml2biotics_gui.exe’ application. This 
action will spawn three separate “windows” that are all part of 
the application but before enabling the application you will be 
required to login to the target database were data conversion will 
take place. The three windows that become visible after login 
are: 

 

DOS prompt: where run-time messages are spooled. 

Data Conversion Application Window:  used to validate files, 
prepare for and initiate the actual data conversion. 

Warnings/Messages Window: where warnings and messages 
are logged during the validation, preparation, initiation phases, 
and after the application has been kicked off. 

 

Initiate Data Conversion 

Set the fields on the ‘Data Conversion Application’ window. Each step 
is described briefly below: 
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1. Specify the output file name: File into which messages/warnings 
are spooled during run-time. This text may also get sent to the 
‘Warnings/Messages’ window. 

 

2. Pre-load conversion related tables: This step will be bolded as 
mandatory if the application detects that key tables are missing. 
If not explicitly recommended, skip. 

 
3. Set the org_unit_code: For subnational data, this usually 

matches the state code abbreviation. To the right of the codes 
option menu the org_unit_id value that corresponds to the 
selected org_unit_code is displayed. 

 
4. Set the version. For subnational data, this also includes sub-steps 

4b, setting the nation, and 4c setting the subnation (the 
application will attempt to set the appropriate values). 

 
5. Set the XML file path. If ignored, defaults to value shown. If the 

path is change, use the ‘Validate Path’ button to verify that both 
the new path exists and contains the necessary XML files in it. 

 
6. Run the ‘populate_ranks’ script. If no data are detected in the 

RANKPATTERNS table this step will be bolded as mandatory 
and the box automatically checked. 

 
7. Run the ‘cleanup_logs’ script. The application will 

automatically check/uncheck box as necessary. 
 

8. Validate conversion spreadsheets: This step brings up a separate 
application that allows validation of one or more conversion 
spreadsheets associated with the current conversion (i.e., if 
subnational, all spreadsheets specified in the 
‘subnational_configuration.xls’ file are displayed).  

 
9. Set the selection mode: Setting it to ‘Single’ brings up the list of 

tables associated with the selected subject area (but restricts the 
run to one subject area at a time).  

 
10. Select Areas/XML files: Selecting from one or the other 

scrolling list automatically finds its matching elements. These 
are extracted from the subnational_configuration.xls’ 
spreadsheet). 

 
11. Run the data converter:  A pop-up box summarizing all the 

conversion parameters will appear allowing you to back-out if 
any of the displayed parameters haven’t been set correctly. 

 

Monitoring the conversion 
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The easiest way to monitor the conversion is using a Database Query 
tool to query the tables being converted. 

 
 

3.3. Generate Error Reports 
 
There are standard reports created in Crystal Reports for reporting errors 
in data conversion.  These reports can be sent to the installing program 
with a brief document interpreting the errors after initial and final data 
conversion.  Crystal Reports 8.5 is required to run the reports: 
 

1. Copy the following reports onto a local drive: 
\\cypress\groups\projects\Biotics\networkrollout\conversion\reports\ 
DataTruncation.rpt 
\\cypress\groups\projects\biotics\networkrollout\conversion\reports\ 
DataConversion.rpt 

 
2. Create an ODBC connection to the destination database and 

schema.  This is most likely in the location where the conversion 
was initially run. 

 
3.  Open the report and the following screen will display: 

 
 
 

4. Choose the ODBC Driver from the Machine Data Source tab. 
 
5. A the Oracle8 ODBC Driver Connect, type in the connection 

information: 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 29 -  

 
 
 
6. At Select Data Source, go to the Machine Data Source tab and 

Choose the correct ODBC driver again.  This will open the 
report without any data in it. 

 
7. Choose Database>Set Location and type in the correct user 

information in the Table Text box in the Location section.  Then 
click the Done button. 

 
 
 

8. You will then have to select the data source again from the 
Machine Data Source tab and fill in the connection information. 
(this should be the user ID for which you’re trying to open the 
report (e.g. biotics_user_ny). 
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9. Click Yes in the Propagate Set Location window. 
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4. MIGRATING/RESTORING BIOTICS 

4.1. Migrating Biotics 4.x to a new Server or Restoring it from 
a backup 

Assumptions 

1. Biotics 4 database already exists and is populated with data from the 
Biotics 4 Oracle database.   

2. The Biotics 4 database is in the same Oracle instance  
 

 
To migrate the data you will need to take the export files (they have the 
*.dmp extension) from your nightly backup on the production server and 
import them into the new database. 
 
To create the database users and tablespaces automatically, run the script 
entitled "bio4tablespace9i.sql".  This script, which can be downloaded 
from Knowledge Base article 471, functions for Oracle 9i or 10g 
databases. Run the script in SQLPlus while logged in as the SYSTEM 
user. The Oracle 10g installation document refers to this script on page 
66 - using this script to create the tablespaces and users will save you a 
LOT of work. 
 
When importing biotics_user and biotics_del schemas the biotics_del 
schema must be imported first as the biotics_user schema needs to grant 
privileges to the bioics_del tables. Objects will have to be recompiled in 
the biotics_user schema database. The check_invalid script and 
directions for recompiling the biotics_user schema database can be 
found in Knowledge Base article 263. 
 
The command for doing an import is similar to the command for doing 
the nightly export. An example of import commands follows, although 
you will need to replace a number of the variables in the command 
below as appropriate.  From the dos prompt type the following 
commands – please note that each ‘imp’ command is on ONE single 
line, despite how it appears here: 
 
imp biotics_del/password@oracle_server 
file=c:\your_dir\your_biotics_del_exp_file.dmp 
log=c:\your_dir\log_file_name.log fromuser=biotics_del 
touser=biotics_del 
 
imp biotics_user/password@oracle_server 
file=c:\your_dir\your_biotics_user_exp_file.dmp 
log=c:\your_dir\log_file_name.log fromuser=biotics_user 
touser=biotics_user 

Migrating the 
Oracle database 
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You will get errors compiling the views when you import the 
biotics_user data, this is ok as long as all the data loads. All objects 
should be compiled after the load using the check_invalid script, 
according to the attached check_invalid.readme directions regarding the 
script, if they do not compile you have a problem. 
1. Map drives on the server as was done previously, using the same 

ODBC_DSN. 
 
2. Move the entire BIOTICS directory to the new location on the 

server. 
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5. INSTALLING TRACKER 

5.1. Tracker Server Installation 
 
Before installation of the Tracker Server software, the Windows MTS 
application server must be configured according to the document Oracle 

and MTS Installation and Configuration Guide for Biotics 4.0. 

Existing Tracker Installations: Installing Tracker without first 
uninstalling a previous version of Tracker is not supported.  Please be 
sure to uninstall an existing Tracker installation before installing again. 

Registry Entries: Please take care to preserve the case of the keys when 
modifying and adding keys. Server_name is not the same as 
server_name. 

 
1. Windows NT 4 

a. Download and install Service Pack 6a 
http://www.microsoft.com/ntserver/nts/downloads/recommend
ed/sp6/allsp6.asp  

b. Download and Install the NT Option Pack (this includes 
IIS and MTS) 

c. http://www.microsoft.com/ntserver/nts/downloads/recommend
ed/NT4OptPk/default.asp 

2. Windows 2000 

a. Download and install Service Pack 3 
http://www.microsoft.com/windows2000/downloads/servicepa
cks/sp3/default.asp    

3. Windows 2003 – follow instructions in section 2.2 Configuring 
Windows 2003 for Biotics 

4. Procedures for steps 5, 6, 7 and 8 are detailed in the document 
Oracle and MTS Installation and Configuration Guide for 

Biotics 4.0. 

5. If the server installation of Oracle is on a separate server than 
you are installing the Tracker and Mapper server applications, 
then you will need to complete the following steps: 

a. Install the Oracle Client if Oracle is not running on the 
server. 

b. Create a Net Service Name for the Oracle Client. 

c. Set up the Transaction Server for use with Oracle.  

d.  (Optional) Use the TestOracleXaConfig.exe tool, which 
is included with MTS to verify that Oracle Services for 
MTS is configured properly. 

Pre-Installation  
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6. In (Start, Settings) Control Panel, Regional Options, on the Date 
tab, change the Short Date to 'YYYY-MM-DD' and ensure that 
the separator is the dash (-). 

 

 

 

1. Run the Tracker Setup program and choose the Server 
component (Client should be installed as well but is not 
required on the server) 

 

 

2. Note: (It is recommended to install the Tracker client as well as 
the Tracker server on the application server for testing purposes) 

However, If you do select the Server install but choose not to 

Install server software 
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install the client there are a few additional steps to get the 
Tracker server working properly: 

a. After the installation is finished navigate to the tracker 
application directory using the Windows Explorer. 

b. Use the RegSvr32.exe tool (usually located in the 
WINDOWS\System32 or WINNT\System32 directory) 
to register each DLL in the Components and Xceed 
directories.  To register one, or more, DLL's in a 
directory: 

i. Highlight DLL's to be registered. 

ii. Right-click on selection and select "Open 
With…" from the context menu. 

iii. When the "Open With" dialog appears click the 
"Other" button. 

iv. Using the second "Open With" dialog that pops 
up, browse to the Windows system directory 
(normally C:\Windows\System32 or 
C:\WinNT\System32) and select the file 
regsvr32.exe. 

v. Click Ok 

vi. Now there will be an entry in the "Open With" 
dialog labelled "regsvr32".  It should be selected 
also, but make sure that it is by clicking on it.  
(It is recommended that you uncheck the option 
at the bottom of the dialog that reads "Always 
use this program to open file”). 

 

 

3. (Optional but recommended) Change the account that the 
MTS/COM+ Package Runs Under: By default the HDMS 
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package is installed so that it executes under the Windows user 
that is currently logged in.  This means that the current user must 
stay logged in to the server all of the time (locking the console 
when not in use).  If the current user logs out, the package will 
be shutdown, and no one will be able to run Tracker.  If desired, 
you can change the settings of the packages to run under a 
specified Windows user, eliminating the requirement for a user 
to be logged into the server at all times.  To do this: 

 
4. Open the MTS/COM+ console by choosing Settings � Control 

Panel from the Windows Start menu.  Choose the Administrative 
Tools icon on the control panel, then choose Component 
Services.  In the Component Services window, navigate to the 
Tracker application found in the list of COM+ Applications as 
shown below. 

 

5. Select the “HDMS” package in the MTS/COM+ Console 

6. Choose Properties from the Actions menu 

7. Click on the Identity Tab 

8. Select the ‘This User’ radio button, and enter the User and 
Password information.  You can choose any user account that 
has privileges to run the application.  On a Windows Domain, 
we recommend choosing a domain user account that has “power 
user” privileges.  You can specify the domain user using the 
following format DOMAIN\user.  (Example: NSNT\jw).  You 
may want to create a user account specifically for this purpose.  
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For Windows 2003: 

 

• Select the “Network Service” account and hit Okay to 
close the window. 
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For Windows 2000: 

 

• Select “This user:” radio button and enter the User and 
Password information.  You can choose any user account 
that has privileges to run the application.  On a Windows 
Domain, we recommend choosing a domain user account 
that has “power user” privileges and whose password WILL 
NOT change.  You may want to create a user account 
specifically for this purpose if not already done.  You can 
specify the domain user using the following format 
DOMAIN\user (Example: NATURE\biotics) or by browsing 
to the user. 

9. Click OK. 

10. (Optional but recommended) Increase the amount of time that 
components remain running when idle.  By default the HDMS 
package is installed so that components shutdown after 3 
minutes of being idle – which means the next time a user does 
something that requires the component, the user will experience 
a significant delay while the component is started.  Increasing 
the time limit will therefore improve application performance.  
Make sure you set the time limit to a reasonable number (e.g. 15 
minutes), rather than an artificially high number (e.g. 500 
minutes) to ensure that resources on the server are not used 
unnecessarily when no one is using Biotics.  To increase the 
time limit: 
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a. Select the “HDMS” package in the 
MTS/COM+ Console 

b. Choose Properties from the Actions 
menu 

c. Click on the Advanced Tab 

d. Increase the value for “Minutes until 
idle shutdown” 

 

e. Click OK 

11. Modify the registry key 
HKEY_LOCAL_MACHINE\Software\Linnet\F

ramework\Database Connection_string 

12. This is the connection string the Tracker server 
users to connect to the Oracle data source. This 
string must use the Oracle OLEDB provider for 
Oracle and NOT the Microsoft OLEDB 
provider for Oracle because the Microsoft 
provider does not support CLOB fields.  

a. String should be as follows 
PROVIDER=OraOLEDB.Oracle.1;DATA 
SOURCE=ORACLE_SERVER;USER 
ID=biotics_user;PASSWORD=your_password 
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13. (Optional) A program may modify the location 
of the accounts.com file in order to map only 
one drive letter when running Biotics Mapper on 
the client machine. 

a. Modify the key 
HKEY_LOCAL_MACHINE\Software\Linn

et\HDMS\Logon AuthorizationFile to 
point to a new location in a directory 
underneath the Biotics mapper server 
installation. 

b. Create a new directory for the 
accounts.com file in a subdirectory of 
the Biotics Mapper server installation.  

c. Note: Do not delete the C:\Program 
Files\Tracker\Authorization directory, 
the application checks for this directory.  

d. Move the accounts.com file to the new 
directory. 

 

14. Go into the Biotics 4.0 Administrator program: 

a. Choose Set Database and change the 
password to match that set in the 
database 

b. Choose Users and define an “mgr” user 
for Biotics. 

c. Choose Configure System Options and 
set the MA/Site prefix, Set Biotics to 
Yes and set the OrgUnit. 

 

5.2. Configure Clients & Users to Run Biotics Tracker 
 

1. Run the Tracker setup.exe program on the client machine. 

2. Select only the client part of the installation, the administrator 
component is optional.   
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3. After the installation has completed successfully, run the 
Client Configuration application located in C:\Program 
Files\Tracker\HDMS_ClientConfig.exe to set the MTS 
Server name (the server with the Tracker server software) 
and Server Communication method (RDS/COM), COM is 
faster. 
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4. If the HDMS_ClientConfig.exe does not accept the MTS server 
name it may have to be changed manually in the registry key 
\HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\HDMS\serve
r_name 

5. Click the test connection button to make sure you are 
connecting to the MTS application server 

6. If the test is not successful go to the troubleshooting section of 
this guide. 

7. Please see Section 23 for information on all registry keys in 
Tracker. 
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6. BIOTICS ADMINISTRATOR 

6.1. Introduction 
The Biotics application was designed with features that would be 
configurable from installation to installation. Most of these changes can 
be done directly in the database but that is very cumbersome. To ease the 
Biotics application configuration process, the Administrator application 
was developed to automate many of these tasks. In most cases it uses the 
same iBCF framework and High-Speed Recordset objects that the 
Biotics application uses. 

6.2. Users Area 
The Users area is used to add and maintain user logons in Biotics.  For 
more information see Section 7 of this document “Biotics Security” 

6.3. User Groups Area 
The User Groups area is used to add and maintain user groups in Biotics.  
For more information see Section 7 of this document “Biotics Security” 

6.4. Applications Area 
The Applications Area is used to maintain the registered applications.  
This area can be used to plug in new, related applications so that their 
security can be maintained using Administrator.  For more information 
see Section 7 of this document “Biotics Security” 

6.5. Categories Area 

The Categories Area is used to maintain Categories.  These categories 
are then used within the Functions Area to organize Functions into 
logical units to make the functions easier to work with on screen.  For 
more information see Section 7 of this document “Biotics Security” 

6.6. Functions Area 
The Functions area is used to maintain security functions.  Functions 
within Biotics are simply a grouping of controls to which the System 
Administrator can use to assign security settings.  For more information 
see Section 7 of this document “Biotics Security” 
 

6.7. Security Area 
The Security Area is used to maintain security for all registered 
applications.  For more information see Section 7 of this document 
“Biotics Security” 

6.8. Database Area 

The Database Area can be used to change the Oracle database User ID 
and Password that Biotics should use when connecting to the database.  
The connection string that Biotics uses to connect to the Oracle data 
source is located in the MTS/COM+ Server's registry at: 
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HKEY_LOCAL_MACHINE/Software/Linnet/Framework/Database
/ConnectionString 

An example ConnectionString (without the line breaks) is:  

PROVIDER=OraOLEDB.Oracle.1;  
DATA SOURCE=ORACLE_SERVER;  
USER ID=Biotics_lgi_test; 
PASSWORD=Biotics_lgi_test 

This window uses a server-side object to make all changes.  In addition 
to updating the registry it also rewrites the Authorization File.  Each user 
in the Authorization File is updated with the new Oracle user and 
password.  The Biotics 4 application does not use the Oracle user and 
password from the Authorization File, but Biotics Mapper does so 
Administrator updates the Authorization File so that everything is kept 
in sync. 

Note that this area does not change any values in the database. 

 

 

Figure 6-1 - Database Area 

6.9. Function Groupings Area 

The Function Groupings area is used to define Function Groupings.  
These Groupings are displayed on the “Subject Area” dropdown of the 
Functions Area window. As noted in the description of the Functions 
Area in Section 7.4, these Groupings are used to control the behavior of 
Subject Areas within the Biotics application Main Window. The Main 
Window working list can display many different views (Element, 
Contact, Element Occurrence, etc.) and requires separate security 
settings for each view.  The Function Groupings enable this. 

Important Note: These Groupings MUST match to the items available 
under the View menu in the Biotics main window that occur above the 
first separator line.  (meaning Element, Element Group, Source Feature, 
etc.)  The case of the Function Groupings should be all capitals.  
Because these items are controlled by the application code, rather than 

the user, it should never be necessary for an installation to use this 
function.  This section is provided for general information only. 
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Figure 6-2 - Groupings Area 

 

 

Figure 6-3 - Function Grouping Editor 

6.10. Dynamic Tabs Area 
The Dynamic Tabs area is used to define additional tabs for the core 
detail windows in Biotics.  For more information see the Section 8 of 

this document "Creating Extensibility " 

 
6.11. Domains Area 

Biotics is driven by dozens of domain tables.  Domain tables are used for 
a variety of functions, ranging from populating drop-down lists, to 
providing sophisticated instructions that control the program's behaviour.  
In terms of customization, some domain tables can be easily modified, 
either through the Administrator Domains Area tool or, in some cases, 
through the Tracker user interface.  The degree to which these domain 
tables can be customized varies – some can be edited to add or remove 
values, others can only be edited to modify the display values or the 
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order in which the display values appear in the drop-down menu.  See 
Table 5-1 at the end of this section for a list of the domain tables that can 
be edited (including adding/removing values) through the Domain 
Administrator or through the Tracker user interface.  There is also a 
subset of domain tables that are restricted from being changed in order to 
maintain a controlled set of values because of methodological or other 

reasons.  See Table 5-2 for a list of the domain tables that should not be 
edited. 

The naming standard used by the Biotics data model is generally to 
precede domain tables with a D_ (D and an underscore).  This is 
followed almost all of the time.  There are a few exceptions, most 
notable the NATION and STATE tables. 

All domain tables which are managed by the Domains Area are listed in 

the SYSTEM_DOMAIN table.   

 

Figure 6-4- Domain Area 

The Domain Manager window allows users to edit the 
DISPLAY_VALUE column in domains that contain this column.  The 
DISPLAY_VALUE column is a special case that the Domain manager 
explicitly checks for.  The DISPLAY_VALUE column is the column 
that is used in the drop down boxes in the application.  Not all domain 
tables have this value.  Generally, domains that contain code (“_cd”) 
attributes will also contain a display value that combines the code and 
the description (‘_desc”) values into one field for display. 
 
The Domain Manager also provides users with the ability to change the 
order of the items in the domain.  This can be done using the following 
steps: 

• Select a domain table and hitting the edit button.  You will then 

see the Domain Manager window in Figure 6-5. 

• Hit the “Custom” radio button.  You will then see a set of up and 
down arrows on the right hand side. 

Maintaining 
Domain Tables 
using the Domain 
Administrator 
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• Highlight the specific value you wish to change, and use the up 
and down buttons to change its position 

• When finished, hit OK to save and close the window. 
 
As mentioned earlier, some tables will allow you to add and delete rows 
through the Domain Manager.  Examples of these are the NATION, 
D_COUNTY, AND D_WATERSHED tables.  For a complete list of 
tables you can edit through the Domain Manager, refer to Table 5-1 at 
the end of this section. 
 
If the SYSTEM_DOMAIN.CAN_ADD_ROWS field is "Y" for the 
domain, rows can be added, edited, and deleted using this window as 
well.  To do this, you would open the Domain Manager window for the 
table and use the X key to delete rows.  To add a row, scroll to the 
bottom and place your cursor in the blank line.  You will then be able to 
edit the line.  You can then change its position using the “Custom” sort 
order button. 

 

 

Figure 6-5 - Domain Manager 
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Editable through 
Domain Administrator 

Also Editable through  
Tracker Interface 

D_CA_KEYWORD D_CA_KEYWORD 

D_CONTACT_KEYWORD D_CONTACT_KEYWORD 

D_COUNTY  

D_EO_KEYWORD D_EO_KEYWORD 

D_LANDFORM D_LANDFORM 

D_LOCAL_JURISDICTION  

D_MANAGED_AREA_KEYWORD D_MANAGED_AREA_KEYWORD 

D_MAPSHEET  

D_MGMT_KEYWORD D_MGMT_KEYWORD 

D_NATIONAL_ECOREGION  

D_PHYS_PROVINCE  

D_REFERENCE_KEYWORD D_REFERENCE_KEYWORD 

D_SITE_KEYWORD D_SITE_KEYWORD 

D_STATE  

D_SUBNATIONAL_ECOREGION  

D_WATERSHED  

D_WORKING_LIST_GROUP  

SUBNATION  

NATION  

Table 6-1 – Editable Domain Tables 

 
Should NOT be Edited Reason 

D_AREA_OF_OCCUPANCY ranking methodology 
D_CIRCUMSCRIP_CONFIDENCE global field 
D_CITES values set by external source 
D_CLASSIF_MAINT_RESP global field 
D_CLASSIFICATION_FRAMEWORK dependencies in data model 
D_CLASSIFICATION_LEVEL global field 
D_CLASSIFICATION_STATUS global field 
D_COMB_RULE_MATRIX global field 
D_CONC_FEAT_LOC_UNCERT EO methodology 
D_CONC_FEATURE_TYPE EO methodology 
D_COSEWIC values set by external source 
D_CURR_PRESENCE_ABSENCE distribution methodology 
D_DIST_CONFIDENCE distribution methodology 
D_ELEMENT_REL_TYPE global field 
D_ELEMENT_REL_CONFIDENCE global field 
D_ENVIRO_SPECIFICITY ranking methodology 
D_FAMILY_SIZE global field 
D_FWS_REGION values set by external source 
D_GENUS_SIZE global field 
D_GEOG_AREA_TYPE dependencies in data model 
D_HYBRID global field 
D_INTRIN_VULNERABILITY ranking methodology 
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D_IUCN values set by external source 
D_IUCN_CATEGORY values set by external source 
D_JURIS_ENDEM global field 
D_LEVEL_CHANGE_POTENTIAL global field 
D_LIN_DIST_OF_OCCUPANCY ranking methodology 
D_LOC_UNCERT_DIST_CLASS EO methodology 
D_LOC_UNCERTAINTY_TYPE EO methodology 
D_LOCATION_USE_CLASS EO methodology 
D_LONG_TERM_TREND ranking methodology 
D_LUMP_SPLIT_POTENTIAL global field 
D_MAINTAINED_BY_STATUS global field 
D_MGMT_STRATEGY global field 
D_NAME_CATEGORY dependencies in data model 
D_NUMBER_EOS ranking methodology 
D_NUMBER_GOOD_EOS ranking methodology 
D_NUMBER_PROT_EOS ranking methodology 
D_NWI_REGION values set by external source 
D_ORIGIN distribution methodology 
D_POPULATION distribution methodology 
D_POP_SIZE ranking methodology 
D_RANGE_EXTENT ranking methodology 
D_RAUNKIAER_FORM values set by external source 
D_REGULARITY distribution methodology 
D_SHORT_TERM_TREND ranking methodology 
D_STAKEHOLDER_COMM global field 
D_STAKEHOLDER_SPECIES global field 
D_THREAT ranking methodology 
D_THREAT_IMMEDIACY ranking methodology 
D_THREAT_MATRIX ranking methodology 
D_THREAT_SCOPE ranking methodology 
D_THREAT_SEVERITY ranking methodology 
D_TNC_ECOREGION values set by external source 
D_USESA global field 
D_USFS_ECOREGION_LEVEL values set by external source 
ORG_UNIT dependencies in data model 
USFS_ECOREGION values set by external source 

Table 6-2 – Domain Tables Restricted from Editing 

 

6.12. Rich Text Area 
The Rich Text Manager provides an interface that allows the 
Administrator to enable and disable rich text support for all 
LinnetRichTextbox controls in Biotics.  All controls on the right side 
have Rich Text support enabled.  The left list box contains ALL 
LinnetRichTextbox controls in Biotics.   
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Figure 6-6 - Rich Text Manager 

6.13. System Options Area 
The System Options area provides an interface for the Administrator to 
adjust miscellaneous Biotics system options. 
 

 

Figure 6-7 - System Options 

System options are as follows 

Org Unit 

(Biotics_EOCODE_SUFFIX) 

The code that is appended to the 
ELCODE and the EONUM to form the 
EOCODE.  Typically this is the 
abbreviation for the province/state and 

BC 
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can be found in the drop down list. 

There is no default for this setting. 

MACODE Prefix 

(Biotics_MACODE_PREFIX) 

The code that is prefixed to the 
MA_COUNTER to form the MACODE.  
Typically, this is a combination of nation, 
province/state, and installation code. 

There is no default for this setting. 

M.CABCCDC 

 

SITECODE Prefix 

(Biotics_SITECODE_PREFIX) 

The code that is prefixed to the 
SITE_COUNTER to form the 
SITECODE.  Typically, this is a 
combination of nation, province/state, and 
installation code. 

There is no default for this setting. 

S.CABCCDC 

 

Biotics Installed Indicator as to whether Mapper is 
installed.    
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7. BIOTICS SECURITY  

7.1.   Introduction 
This section provides an overview of the security components used in 
the Biotics application, information regarding the standard security 
configuration provided with each installation, and instructions on how to 
customize and maintain that configuration using the Administrator 
application. 

Biotics provides two levels of security/access control: 

• Database Level Security - used to control access and 
permissions to the physical data in the DBMS (i.e. Oracle).  This 
security is applicable both inside and outside the application.  In 
other words, if the user accesses the data using other software 
(e.g. Microsoft Access), the security will still apply. 

• Application Level Security - used primarily to control access to 
the Biotics program (i.e. ensures that a valid user ID and 
password is entered before the program will start), and to a 
lesser extent to control which functions are available to 
particular users (currently the only functions that can be 
restricted are the Admin functions).  This security is applicable 
only when the application software (i.e. Biotics) is used. 

Note: To provide read-only access to Mapper data, it is 
recommended that data be replicated to a separate 
warehouse area, and/or Oracle views be created.  There is no 
way to restrict users from modifying data within Mapper 
(since Mapper is largely a data entry/maintenance 
application). 

The Security Database controls the Application Level security, and 
associates each application user with an Oracle user (i.e. integrates the 
Database Level Security).  The Security Database consists of a number 
of Oracle tables and an encrypted file. 

The Administrator application tools allow you to populate a security 
database with information, including: 

• Applications 

• Windows 

• Window controls 
 

You then create a matrix of users and groups, controlling access to these 
items.   At execution time, Biotics selectively enables, disables, or hides 
secured items, as specified in the security database. 
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7.2. Security Concept and Components 
Security on the Biotics application is based on granting functionality to a 
User or Group.  This is done through the Administrator application 
where you are able to create and setup all the components of the security 
concept. 

Security by inclusion: 

The security capability provides security by inclusion. By default, the 
security system uses the database current entries. This means that it 
modifies settings specified explicitly in the security database and if a 
setting does not exist (i.e. a control entry) then it disables the control by 
default. 

Components of Security are: 

• Users – a person (e.g. jsmith) 

• User Groups – consist of one or more Users that are 
logically grouped together (typically because the users have 
similar job functions and therefore similar security access 
rights).  Examples could include “Botany”, “Ecology”, 
“Zoology”, “Read-Only”, “Data Manager”, “Mapper User”, 
etc. 

 

Figure 7-1 – Users and User Groups 

 

• Applications – an executable program (Biotics,  
Administrator, etc). 

• Controls – a Control on the User Interface (menu item, tool, 
button, radio button, checkbox, dropdown list, textbox, grid, 
etc).  Forms themselves are also controls.  Each Control 
belongs to one or more Functions. 

• Functions – a group of Controls that are logically related.  
Typically Functions relate to windows (Element Tracking, 
Scientific Name, Managed Area, etc.).  It is functions that 
users and/or user groups are granted access to.  Each 
function belongs to a Category and can be set to a Grouping 

(see later in this section). 
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Figure 7-2 – Controls and Functions 

 

• Function Groups – a group definition that can be applied on 
Functions to allow the application of security on the same 
controls, but in different functions. 

 

Figure 7-3 – Functions and Function Groups 

 

• Categories – a group of Functions that are logically related.  
Typically Categories relate to the different types of Views in 
Biotics (Elements, Contacts, References, etc.).  The main 
purpose of Categories is to make it easier to work with the 
functions in the Administrator program (it allows the user to 
filter the long list of functions to make it easier to find the 
functions of interest).  Each category belongs to an 
Application. 
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Figure 7-4 – Function Groups and Categories 

 

In summary there are two hierarchies: 

 

 

 

Access is most commonly granted to User Groups for Functions.  
However access can also be granted to individual Users if necessary.  
Since Functions can consist of a single Control, this gives total 
flexibility over the granularity of the grants.  That is, access for a 
specific Control can be granted to a specific User if desired (but keep in 
mind the access is not granted directly to the Control – it is granted to 
the Function that the Control belongs to). 

Access Levels 
 
There are three levels of access that can be granted: 

• Hidden – the user does not have any access to the 
Function (i.e. cannot even see the GUI for that 
Function).  This can be used to hide buttons and entire 
windows. 

• Read – the user has read-only access to the Function. 
The user will be able to see the Function, but Controls 
within the Function will be disabled (greyed out) on the 
window. 

• Full – the user has full access to the Function.  The user 
will be able to see the function, and all Controls within 
the Function will be enabled. 

When a User is first created, that User has access to nothing (cannot 
even run the application) until the User is made a member of a Group (or 
grants are made specifically for that user). 
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It is not uncommon for a User to belong to more than one User Group.  
Grants in Biotics are made on a “Permissive Subtractive” model, which 
means that if at least one Group the User belongs to has access, then 
access is granted. 

The following diagram shows the tables and table-relationships that 
control security in Biotics. 

 

Figure 7-5 – Section of Data Model showing Security Tables 
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At the database level, users and user groups are handled as records 

within a single table named security_users.   Individual users are 

assigned the user_type “U”. Meanwhile, user groups are assigned the 

user_type “G”.   Group memberships are recorded in the 

security_groupings table by adding a new row into this table, every 
time a user is assigned to a group. 
 
When the Administrator’s User Manager window is launched the 

system displays only those users with user_type “U”. Likewise, when the 

Administrator’s User Group Manager window is launched, the system 

displays only users of type “G”. 
 

 
7.3. Biotics Standard Security Configuration 

 
Each Biotics installation will have varying security requirements, and 
will therefore need to tailor the security configuration to suit their needs.  
However, to save installations the effort of having to create an entire 
security configuration from scratch, Biotics will deploy with a 
“standard” configuration that can be used to get an installation up and 
running.  This configuration can then be customized as necessary to 
meet the installation’s needs.  The standard deployment will consist of 
User Groups, Applications, Categories, Functions, and Controls.  The 
standard security configuration uses the design depicted below: 

 

Figure 7-6 – Biotics Standard Security Configuration 

Each subject area in Biotics has a security function that allows users to 
access it.  This is the View function.  If a user (or user group) does not 
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have full access to this function, they will not be able to view anything 
in that subject area.  Having view access means that you can look at 
records, but not make any changes.  All controls in this window will be 
grayed out.  Only minimal actions, such as Close, Help, Open 
Record/Attribute Maintenance, and the Text Editor will be enabled.  The 
View function is the starting point for each subject area.  In order to do 
anything else in a subject area, the user must have View capability. 
 
The next level of access is Edit capability.  Each subject area has at least 
one Edit function.  Most of the controls on a window are in the basic 
Edit function.  Fields that require special control, such as Mapper fields, 
have been placed in separate functions.  Having Edit capability allows 
the user to modify fields (except those placed in separate functions), cut, 
copy, paste, spell check and save.  The basic Edit function is the starting 
point for all editing done in a subject area.  In order to do any other 
editing, such as creating or deleting records, the user must have Edit 
capability. 
 
Each subject area has a Delete function to delete records from the 
database.  This function contains the controls for the Delete option and 
icon on the window. 
 
Most of the subject areas have a separate Create/Copy Record function.  
This function contains the New option and icon on the working list as 
well as the detail window.  It also contains the ‘Copy Data from’ option 
in the detail window.  However, the windows for Element 
Characterization Abstract, Element Rank, Element Management, EO 
Specs, and EO Rank Specs do not have this function.  New records of 
these types are created when retrieving a record that doesn’t already 
exist.  For this reason, it is not possible to separate edit capability from 
create capability for these records.  These areas do have a separate Copy 
function, however. 
 
Certain Mapper fields have been placed in separate security functions.  
These are found in the Mapper category.  Create functions for Source 
Features and EOs are also in this category.  Programs that use Mapper 
should have read-only access to these functions since these fields should 
be edited in Mapper, instead of Tracker.  Non-Mapper programs would 
have full access to these functions.  Users that have only view access to 
EO, Managed Area, Sites, and Source Feature subject areas would not 
need to have any access to Mapper functions, since they will only have 
view access to all fields anyway.  To control access to these fields, two 
user groups have been defined, Mappers and Non-Mappers.  
 
Several other fields have been identified as needing special control.  
These include the legacy BCD fields and the Inactive checkboxes for 
Elements and Alliances.  During the prototype review phase, the users 
indicated that only specially designated users should edit these fields, 
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not everyone with edit capability. The fields having special security 
functions are as follows: 
 

• Element Tracking:  Inactive checkbox, Elcode, Taxon Stat BCD, 
Intcode 

• Alliance: Inactive checkbox, Alliance Key 

• Higher Class Units (including Alliance): Name, Higher 
Taxonomy Code, Sequence Number 

• Contacts: Concode BCD 

• EO Rank Specs: A Rank Specs BCD, B Rank Specs BCD, C 
Rank Specs BCD, D Rank Specs BCD 

• EO Specs: EO Specs BCD 

• Element Characterization Abstract: Sbreed_BCD, 
Sirregapp_BCD, Smigtrans_BCD, Swinter_BCD 

• EOs: Eotype_BCD, CDREV_BCD, Precision_BCD, 
OwnerInfo_BCD 

• Element Rank: Threat_BCD 

• Managed Areas: MACode_BCD 

• Sites: Old Sitecode_BCD, Sitecode_BCD 
 

In addition, several actions have been identified as needing special 
control.  The menu options and icons for these actions have been placed 
in separate security functions.  They are as follows: 
 

• Classification: Change Higher Class Unit/Taxonomy Code 

• Element Occurrence: Change Associated Element 

Standard User Groups 

The standard configuration contains several user groups that you 
can use in your installation.  These were designed to cover the most 
common types of users found in an installation.  These groups 
already have the appropriate security functions assigned to them.  
Like everything else in the standard configuration, these user 
groups can be customized as you feel necessary.  These groups and 
the kind of access they have are listed in the table below. 

User Group Access Type of 
Data 

Notes 

Administrators Everything in 
Mapper, 
Tracker, 
Administrator 
and DX tools 

Everything Every installation will need one user in 
this group, and probably one backup, to 
set up users and perform maintenance.  
This person should also be allowed to 
perform SQL on the Oracle database. 

Super Data 
Manager 

Everything in 
Tracker and DX 
tools; access to 
special fields 

Everything Can do everything in Tracker and DX 
tools 

Botany DM Everything in 
Tracker and DX 
tools; access to 
special fields  

Botany  Can create, delete, and inactivate 
records. 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 60 -  

User Group Access Type of 
Data 

Notes 

Ecology DM Everything in 
Tracker and DX 
tools; access to 
special fields 

Ecology  Can create, delete, and inactivate 
records. 

Zoology DM Everything in 
Tracker and DX 
tools; access to 
special fields 

Zoology Can create, delete, and inactivate 
records. 

Super User Basic fields in 
Tracker 

Everything Can edit basic fields, but not special 
fields.  Can’t create, delete, or inactivate 
records. 

Botany User Basic fields in 
Tracker 

Botany  Can edit basic fields, but not special 
fields.  Can’t create, delete, or inactivate 
records. 

Ecology User Basic fields in 
Tracker 

Ecology Can edit basic fields, but not special 
fields.  Can’t create, delete, or inactivate 
records. 

Zoology User Basic fields in 
Tracker 

Zoology Can edit basic fields, but not special 
fields.  Can’t create, delete, or inactivate 
records. 

Researcher View only 
access to all 
Tracker fields 

Everything Look but not touch.  View only access 

Guest Reader View only 
access to limited 
fields 

Everything Can’t use Query Builder to view any 
tables in QB_EXCLUSION table. 

Mappers Biotics Mapper 
module and 
disables selected 
fields within 
Tracker to 
prevent editing 
outside the GIS. 

Everything Mapper Users can add, delete, and edit 
any EO, MA, or Site in the Mapper 
system.  Does not give access to Tracker 
– that is granted by including the user in 
one of the other groups.  ALL users 
should be assigned to this group, 
whether they are actually a Mapper user 
or not, to ensure that selected GIS-
calculated fields are disabled in Tracker 
for all users to prevent manual editing of 
them. 

Non-Mappers Enables editing 
within Tracker 
for selected 
Mapper fields. 

Mapper 
fields 

Can edit Mapper fields in Tracker.  Use 
ONLY in conjunction with an 
installation that does not include 
Mapper. 

Data 
Exchangers 

Access DX 
tools 

 Can access DX tools.  Used in 
conjunction with other user groups. 

 

These user groups have been defined without regard to whether a 
program is using Mapper or not.  Access to Mapper fields and functions 
are granted separately, with the Mappers or Non-Mappers user groups.  
As an example, a user given full access to all Zoology data, including 
special fields, in a program that uses Mapper, would be assigned to the 

Zoology Data Manager group and the Mappers user group.  Another 
example would be a user given access to only basic botany data in a 
program that does not use Mapper.  They would be assigned to the 

Botany User group and the Non-Mappers user group.  View only users 

would be assigned to just the Researcher group, regardless of whether 
their program uses Mapper. 
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Another consideration is that assignment of users to either the Mappers 
or Non-Mappers user group is determined by whether the installation 

uses Mapper, not the individual user.  If an installation uses Mapper, but 
only a few of its users actually use that application, all users will need to 
be put in the Mappers user group (except for those in the Researcher and 
Guest Reader groups).  

 

7.4. Maintaining the Security Configuration 
 
The main window provides access to each area in Administrator.  Note 
that security is applied to the controls on this window.  Therefore, items 
may appear in this window but may be inaccessible because of security. 
 

 

Figure 7-7 - Administrator Main Menu 

Users Area 

This window is used to create and maintain the user logons for the 
Biotics application.  It is important to note that these are Biotics 
application users and not Oracle database users.  Users cannot be deleted 

using Administrator.  Instead they should be deactivated if they are no 
longer to be used.  The User window can display Active, Inactive, or All 

users by selecting the appropriate radio button.   

The User Manager window provides a standard data entry window 
where the User information can be maintained.  The Data Access 
checkboxes at the top-right corner of the User Manager window are for 
security to the different types of Element data (Plant, Animal, 
Community).  If a user does not have access to one of the checkboxes 
they will not be able to save data to any of that type of element, or data 
related to that element.  The same rules apply for groups that a user is a 
member of (see User Groups Area). 
 

The basic procedure to create a user is as follows 

 
Basic Procedure  
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1. Start the Administrator program. 

2. Double click on the ‘Users’ icon on the main window. 

3. Click on ‘New’ on the Users window 

 

Figure 7-8 – Users Window 

4. Complete the New User window as follows: 

 

Figure 7-9 – User Manager window 

 

� Enter the user ID in the ‘Name’ textbox.  User IDs should be 
lower case and no more than 15 characters. 

� Enter the user’s password in the ‘Password’ and ‘Verified 
Password’ textboxes.  Keep in mind that users cannot 
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change their own passwords, so you should either ask them 
in advance what they want their password to be, or else have 
them type in their password at this time. 

� Enter the user’s full name in the Description textbox. 

� Leave the e-mail textbox blank (this is not used in Biotics). 

� Assign the user to the appropriate user group(s) by selecting 
the group(s) in the ‘All groups’ list box, and then clicking 
the ‘Add ->’ button (see the User Groups Area section for 

User Group definitions).  

5.  Click OK. 

User Groups Area 

The User Group area is very similar to the Users area.  The User Group 
window contains a list of all User Groups within Biotics. Just as with the 
Users, a User Group can be deactivated, but not deleted using 
Administrator. Also a User Group has data access rights based on the 
type of Element (Plant, Animal, Community) just like the Users.   

 

Figure 7-10 - User Groups Area 

 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 64 -  

 

Figure 7-11 - User Group Editor 

Applications Area 

The Applications Area is used to maintain the registered applications.  
This area can be used to plug in new, related applications so that their 
security can be maintained using Administrator.  Note that all 
applications share the same Users and Groups. 

The Application Area maintains the SECURITY_APPLICATION table. 

 

 

Figure 7-12 - Application Area 
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Figure 7-13 - Application Editor 

Categories Area 

The Categories Area is used to maintain Categories.  These categories 
are then used within the Functions Area to organize Functions into 
logical units to make the functions easier to work with on screen.   

These categories are also used for security on the Main Window.  When 
creating a function, if the MainForm form is included it is required that 
you select the Category that the function is for.  The Categories coincide 
with the Subject Areas available in Biotics.  (The categories are matched 
to the subject area by the menu text.) 

The Categories Area maintains the SECURITY_CATEGORY 
table. 

 

 

Figure 7-14 - Categories Area 
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Figure 7-15 - Categories Editor 

Functions Area 

As mentioned above, Functions relate to windows. Functions within 
Biotics are simply a grouping of controls that the System Administrator 
can use to assign security settings to.  Instead of setting security for each 
control the System Administrator can group related controls into a 
function and apply security at the Function level.  See section 7.3 
“Biotics Standard Security Configuration” for details regarding how 
these functions have been designed. 

The Function Area main window has two dropdown lists: Application 
and Category.  After selecting the Application and Category the user is 
presented with a listing of Functions.  Now the user can create, edit, and 
delete any of the listed Functions. 

Each Function requires a Function Name. A subject area can be defined, 
if needed.  (Subject areas affect the behavior of Subject Areas within the 
Main Window of Biotics.  Because the Main Window can display 
various “Subject Areas”, it is necessary to define a separate function for 
each Subject Area you wish to control using security.) 

Once the function has been assigned a name the user can select any 
number of controls from the "Control List" grid (the top one).  Items can 
be added by double-clicking on them or by selecting them and then 
clicking on the down arrow.  

Similarly items can be removed from the "Selected Controls" grid by 
double-clicking them or selecting them and then clicking the up arrow. 

When creating a new function the Apply button will be visible on the 
Function Manager screen.  This button will save the current Function 
and reset the window to accept another new Function. 

The Function area maintains the SECURITY_FUNCTION and 

SECURITY_FUNCTION_CONTROL tables.  The 
SECURITY_FUNCTION table contains the list of Functions as well as 
each Function's Subject Area.  The 
SECURITY_FUNCTION_CONTROL table contains the mapping of 

controls (from SYSTEM_CONTROL) to Functions (from 
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SECURITY_FUNCTION).  See Figure 7-5 – Section of Data Model 
showing Security Tables. 

Creating Functions Example 
 

When creating functions there are a few things to consider. 

• Does the window have multiple mode settings (i.e. Contact 
View, Scientific Name view)?  Then it will require a grouping 

• Does the window have multiple functionalities for the users to 
access (New, Edit, Delete)?  Then it will require multiple 
functions. 

The following example will setup a user to have permission to edit 
contacts in the Contacts window.   

This will be accomplished by: 

• We will create a new function for this in the functions window.  

• We will click the New button to do this. This will open the 
Function Manager window. 
 

 
           

Figure 7-16 – Functions Window 
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• We will name the new function Edit Contracts.  
 

   

Figure 7-17 – Function Manager Window 

• We will then select both the Contact Details Window and the 

Contact Search Window and add them to our selected controls.  

• Since we only want to allow the function to have the ability to 
edit contacts, we will remove the New button (cmdNew) and the 
Delete button (cmdDelete) from our selected controls. 

• We will then click OK to save our new function.   

 

To create other functionality as New Category or Delete Category, we 
would do the same steps but remove the Command buttons (New, Edit, 
Delete) that we don’t want the function to have access to. 
 

Now that we have our Edit Contacts Function, let’s assign it to our 
user. 

We will now need to open the Security Manager Window to assign this 
function to a user.   

Security Area 

The Security Area is used to maintain security for all registered 
applications.  It is possible to assign security rights to a user or a group.   

Initially the Security Manager displays only Security Categories in the 
lower portion of the window.  These Categories can be expanded by 
clicking on the folder icon at the left edge of the window.  Within these 
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Categories are the security functions that are defined in the Functions 
Area.  Security can be set at one of three levels: Full, Read, or Hidden.  
Note that if none of these are checked the default security setting is 
Read. 

 
To assign security for accessing a given function to a user we will need 
to: 

• Select a user (e.g. “admin”). 

• Select the application. Once you select one, the Function List 
tree view should populate with the appropriate categories and 
functions. 

• Find the function under the appropriate category (e.g. 
“Contacts”) you will want to assign permissions for the user 
(e.g. “Edit Contact”). 

• You will then have three options.  You can assign full access, 
read-only or hide the controls in that function. 

• Once you have made your selections, click ok to save the 
settings. 

 

 
 Figure 7-18 – Security Manager 
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8. CREATING EXTENSIBILITY 

8.1. Introduction 
 
Extensibility provides the ability to dynamically add new attributes to 
Biotics Tracker.  New tabs and data entry controls may be added to most 
detail windows.  Implementation requires several steps including the 
creation of new Oracle tables and configuration using the Administrator 
application. 
 
This document describes the steps needed to implement extensibility.  
Worksheets and scripts referenced in this document can be found in the 
Documentation directory of your Biotics 4.0 installation CD. 
 

 
A worksheet (ExtensibilityWorksheet.xls) has been developed to 
document the information required to configure and convert the 
extensible data.   
 
To fill out the worksheet you will need to: 

• Document each extensible field 

• Relate each field to a window in Biotics Tracker 

• Determine the relationship that a field has to the subject area (1 
to 1; 1 to many) 

• Define the Oracle tables that will store the extensible data 

• Design the Biotics Tracker extensible tabs and user interface 
controls 

• Think through data conversion of existing data 
 

Read through the remainder of this section prior to starting the 
worksheet. 
 
Here are some general guidelines for thinking through extensibility: 
 

• Carefully review the detail windows to determine where your 
extensible data should be added.  For example, since the Element 
Tracking and Characterization detail windows are substantially 
different for communities versus taxa, it is possible to add an 
“optional” tab to a community Element Tracking window that will 
not appear on a species Element Tracking window, and vice versa.  
However, on other types of detail windows, a new tab will be visible 
on all records of that type.  For example, the addition of a field to 
Element Ranking that only applies to plants, the new tab containing 
that field will show up on animal and community Element Ranking 
records as well. 

Step 1: Document 
Requirements  
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• The Biotics Tracker data model contains new fields as compared to 
BCD.  See if your optional data can be mapped to these new fields in 
the core data model.  For example, there are now fields specific to 
community element occurrences. 

• Make sure that each field you are configuring is absolutely 
necessary.  Converting to a new data management system is a good 
time to review data management requirements.  Some questions to 
think about include:  Is the field being actively maintained?  Was the 
field put in place for a specific project that has been completed?  
Perhaps the data are best archived instead of carried over to Biotics. 

• The maximum text field length is 4,000 characters.  The Oracle 
CLOB data type is not supported. 

 

 
If you are already up and running with Biotics and have previously 
configured some extensible data, you may be able to alter existing tables 
you created.  Always, consider this possibility prior to creating new 
tables and configuration settings.  See section 8.8 for information on 
adding to or modifying existing tables. 
 
Extensible data will be stored in user defined Oracle tables that relate to 
the core Biotics data model.  An example script 
(ExampleOracleScript.sql) has been developed to guide the process and 
can be found in the Documentation directory of your Biotics 4.0 
installation CD.  Extensive documentation exists within the script. 
 

Tip:  If you plan to create extensible tables for converting associated 
multi-valued fields from BCD, include fields in your table for each of 
the associated fields, as well as a temporary field for initially importing 
the associated multi-valued fields as one concatenated string. 
 
An extensible table must link to a parent table within the core Biotics 
data model.  The following table shows the “granularity” at which 
optional fields can be configured and defines which tables should be 
used for which windows. 
 

 
Detail Window 

(Defines the granularity for which 
extensibility can be configured) 

Parent Table 
(Extensible table should link to this table) 

ELEMENT TRACKING – GLOBAL 
– SPECIES 

TAXON_GLOBAL 

ELEMENT TRACKING – GLOBAL 
- COMMUNITY 

COMMUNITY_GLOBAL 

ELEMENT TRACKING – 
NATIONAL – SPECIES 

TAXON_NATIONAL 

ELEMENT TRACKING – 
NATIONAL – COMMUNITY 

COMMUNITY_NATIONAL 

ELEMENT TRACKING – TAXON_SUBNATIONAL 

Step 2:  Create 
Oracle Script  
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SUBNATIONAL - SPECIES 

ELEMENT TRACKING – 
SUBNATIONAL - COMMUNITY 

COMMUNITY_SUBNATIONAL 

  

ELEMENT RANKING - GLOBAL ELEMENT_GLOBAL_RANK 

ELEMENT RANKING - NATIONAL ELEMENT_NATIONAL_RANK 

ELEMENT RANKING - 
SUBNATIONAL 

ELEMENT_SUBNATL_RANK 

  

ELEMENT CHAR – GLOBAL - 
SPECIES 

TAXON_GLOBAL* 

ELEMENT CHAR – GLOBAL – 
COMMUNITY 

COMM_CAG 

ELEMENT CHAR – NATIONAL – 
SPECIES 

TAXON_NATIONAL* 

ELEMENT CHAR – NATIONAL – 
COMMUNITY 

COMM_CAN 

ELEMENT CHAR – 
SUBNATIONAL – SPECIES 

TAXON_SUBNATIONAL* 

ELEMENT CHAR – 
SUBNATIONAL – COMMUNITY 

COMM_CAS 

ELEMENT CHAR – LOCAL – 
COMMUNITY 

COMM_CAL 

  

ELEMENT MANAGEMENT ELEMENT_MANAGEMENT 

  

EO SPECS  EO_SPECS 

  

EO RANK SPECS EO_RANK_SPECS 

  

ELEMENT SITE ELEMENT_SITE 

  

ELEMENT ECOREGION - GLOBAL EL_GLOBAL_ECOREGION 

ELEMENT ECOREGION - 
NATIONAL 

EL_NATL_ECOREGION 

ELEMENT ECOREGION - 
SUBNATIONAL 

EL_SUBNATL_ECOREGION 

  

EO ECOREGION EO_ECOREGION 

  

ALLIANCE ECOREGION ALLIANCE_ECOREGION 

  

ELEMENT GROUP ELEMENT_GROUP 

  

ELEMENT OCCURRENCE EO 

  

SOURCE FEATURE SOURCE_FEATURE 

  

MANAGED AREA MA 

  

SITE CONSERVATION_SITE 
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SCIENTIFIC NAME SCIENTIFIC_NAME 

  

REFERENCE REFERENCE 

  

CONTACT CONTACT 

 
* Due to the way the characterization windows were programmed, the 
species characterization extensible tables cannot be related to 
ANIMAL_CAx or PLANT_CAx.  Instead, they must be related to the 
TAXON_x table.  This means that if a cascading delete is set up in the 
database, the characterization record delete will not result in the 
extensible characterization information being deleted.  If a new 
characterization record is created after a delete, it will pick up the old 
extensible information if it exists in the database.  This can be avoided if 
the BIOTICS_TABLE_ACTIONS table (stores deletion rules used by 
Biotics) is used for deletion instead of cascading delete constraints. 

 
 
 
This step is optional.  It is only necessary when you are migrating 
existing data into the extensible tables.  There are two methods to load 
the extensible tables with data.  You may either use the Biotics Data 
Conversion Application or use Microsoft Access (or other database). 

 

8.2.   Using the Biotics Data Conversion Application 
 
Note:   it is anticipated that only NatureServe staff will need to run 

the Biotics Data Conversion Application.  

Prepare Symbolics for Associated Multi-Valued Fields 

Associated Multi-Valued fields in BCD are best converted by exporting 
a symbolic which concatenates all the associated fields, using a “$” as a 
separator character (or any other character that is unlikely to occur in the 
actual text of the field) as follows.  This is preferable to exporting each 
field separately, as this is the best way to ensure that the associated 
values stay together. 
 
Field1$Field2$Field3 
 

Export the optional data from BCD to XML 

There are two files contained in the BCD XML program that you will 
have to adjust: HDMS_OPT.INI and the EXPORT.BCD. 

 
Create a HDMS_OPT.INI file with the following section: 

[EOR.OPT] 
;* Michigan Element Occurrence Optional Fields 

dosfile=XEOOPT.XML 

Step 3:  Data Conversion 

Step 1:  Create 
HDMS_OPT.ini file 
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path=HDMS\OUTPUT\ 
xmlpath=HDMS\OUTPUT\ 
dtdpath=HDMS\OUTPUT\ 
REVFILES=EOR.OPT 
ORA_TABLE=MI_EO_OPT 
;PARENT_TABLE= 
BCD_FIELDS=EOCODE,NESTNUM,UPDATA,PLANTLIST 
;GETLIST= 
WITH_CLAUSE=WITH VALID_KEY AND (WITH NESTNUM OR 
WITH UPDATA OR WITH PLANTLIST) 

 
 
 
Create a batch file under hdms\java called TO_CONV.BAT with the 
following four lines (without the line numbers): 
  
1 set CLASSPATH=hdmsconv.zip;hdmsExchange.jar 
2 cd hdms\java 
3 java org.abi.util.FileEncodingUtil -iCP437 -oISO-8859-1 

../output/X%1.xml ../output/conv/%1.xml 
4 exit 

 
Add the following two lines to the EXPORT.BCD file (without the line 
numbers): 
  
1 BIOTICS NS_EXPORT 

PROPERTIES=HDMS\INI\HDMS_OPT.INI,EOR.OPT 
2 UNPROTECTED.PC EXIT CMD /C START 

HDMS\JAVA\TO_CONV.BAT EOOPT 
  
Note the following: 

1. If you are dumping from the ET or ESR files, you must include 
the ESTCODE for lookup of the 
ELEMENT_SUBNATIONAL_ID in the ESTCODE_BCD table. 

2. You do not have to dump the optional data from the *.opt 
revfile. You may find it more convenient to dump it from the 
main file as all the optional fields can be seen in the main file. 
For example you can see all EOR.OPT fields from the EOR file 
but you cannot see all EOR fields in the EOR.OPT file. 

 
The data conversion application requires a conversion spreadsheet for 
each file that gets converted from BCD.  Standard spreadsheets are 
available from NatureServe, however, you must create spreadsheets for 
each optional file from which you want to convert data.  Optional 
spreadsheets should be set up as follows: 
 

Primary Key Lookup 

Step 2:  Create Batch file 
for Conversion 

Step 3:  Edit the 
EXPORT.BCD  file 

Step 4: Setup of 
Conversion 
Spreadsheets 
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The first row of the spreadsheet must contain the Foreign Key from your 
optional table in the Biotics column (I) and the parent table from the 
Biotics 4 data model in the Notes column (K).  The best place to check 
for primary key lookup is in the parent spreadsheet.  Since you are 
bringing the primary key from the BCD table the extended table will 
have the same primary key as the table you are linking to. Remember to 
put the word ‘parent’ in column O.  See the spreadsheet 
(ExtensibleSpreadsheet_PKs.xls) in the Documentation directory of your 
Biotics 4.0 installation CD for sample entries for this row for each BCD 
file with optional fields. 

Domain Table Lookup 

1. Add a row with the new domain table name to the 
DomainTables.xls spreadsheet and use the dropdown to choose 
the conversion type as follows: 

a. Conversion Type 1:  Perform a lookup during 
conversion.  If the value does not exist in the domain 
table, insert it as a new value in the table. 

b. Conversion Type 2: ID column in domain table is a non-
nullable column.  Perform a lookup during conversion.  
Reject all records whose values are not already in the 
domain table 

c. Conversion Type 3: ID column in domain table is a 
nullable column.  Records whose values are not in the 
table are not rejected, but the new value is not inserted 
into the table. 

2. Save the DomainTables.xls as a text file. 
3. In the notes column (column K) of the optional spreadsheet, add 

the domain table name and the code value field in the following 
format: DOMAIN_TABLE_NAME.code_field. 

4. Make sure the domain table has an entry in the hdms_table. 
5. Make sure the domain table has an entry in the next_seq table. 

 

Direct Migration 

The following rows in the spreadsheet should be filled in with each field 
to be converted.  Only columns D, E, H, I, J, K, M and O are relevant for 
conversion.  However, the data conversion program looks for certain 
data in specific columns, so they must always contain the right type of 
data (e.g., BCD File name always has to be in column D).  The rest of 
the columns are not used in the conversion process and are just used as 
place holders, so their contents do not matter.  The relevant columns are 
defined below: 
 

D (BCD File) – Name of BCD file 
 

E (BCD Field) – All the fields in that file, including hidden fields, but 
not including symbolic fields that appear in the windows. It does include 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 76 -  

the names of symbolics written for conversion. Often, these have the 
same name as the Biotics field they map to.  The XML files have a value 
ora_column which substitutes periods for underscores. Do not use this 
column, use the BCD names. 
 
Note that the conversion will fail if: 

1. The BCD fields are not spelled correctly in the spreadsheet. 
2. A BCD field is listed in the spreadsheet but is not in the XML 

file 
 

H (Biotics table) – The name of the Oracle table to which the attribute 
maps 
 

I (Biotics column) – The column name in that table 
 

J (Conversion type) – There is a dropdown list of choices to indicate 
how the conversion is going to happen.  The values are: 

1. Direct migration - no modification of Data are needed to get it 
into Biotics. 

2. Convert to date - date in BCD text field will be transformed into 
Oracle date datatype. 

3. Convert to number - number in BCD text field will be 
transformed into Oracle number datatype. If the BCD field 
contains non-numeric data, it will fail conversion and an error 
message will be generated. 

4. Convert using domain table - BCD value will have to be 
matched up with a value in a Biotics domain table. How to 
match them is indicated in column K.  Non-matching values will 
generate error messages during data conversion. 

5. Convert using business rules - some conversion logic needs to be 
applied. Details are usually recorded in a separate document, but 
if the rules are simple, they may also be in column K. 

6. Not being migrated - there should be nothing filled in for Biotics 
table or column 

7. New attribute - In some cases, data from BCD will be used to 
populate a new Biotics field through some sort of conversion 
logic. In other cases, a new attribute is entered on the 
spreadsheet, but no data will be put into it from BCD, so the 
BCD File and field columns are blank. The later type of new 
Biotics attributes didn't need to be on the spreadsheet, but were 
often included for "bookkeeping" to make sure everything was 
accounted for.  They have no impact on conversion. 

8. Other-see notes - Usually refers to an ID lookup or special 
conversion shown in Column K or M. 

 

K (Notes) – For domain conversions and foreign key lookups, the data 
entered here must be in a certain format.  For other types of conversions 
the notes can be free-form.   
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M (Action) – Directives read by the data conversion program to perform 
some transformation of the data.  Syntax must be exact, and some 
directives are very similar. 
 

O (Table type) – Must be set to “parent” to load optional table, 
otherwise the program will think it is a child table and not load it. 
 

Other things to note: 

The lines that are gray and contain "- in column H were 
"commented out" because they were replaced by symbolics. (We 
decided not to delete any rows from the spreadsheet.) 
 
A single BCD field may map to more than one Biotics field – for 
example, one by direct migration and another by some conversion 
logic.  In that case, the BCD file and field names are repeated on 
multiple lines. 
  
 
The subnational_configuration.xls spreadsheet in the conversion 
spreadsheets directory is where you will add a row for each additional 
spreadsheet you have created.  Columns are defined below.  
 

Column A – The XML file the Data are coming from. 

Column B – The name of the spreadsheet you have created (No spaces 
in name) 

Column C – The name of the area. Example:  “BC SBR Optional” 

Column D – Should not be needed 

Column E – Should not be needed 
 
Note:  If you change this spreadsheet you will need to restart the data 
conversion program. 

BUG : Do not use the word “Species” or “Community” in Column B or 
Column C.  
 
 
 
 
 
See procedures in Section 3.2 for running the data conversion program. 
 

 
If you imported associated multi-valued fields as concatenated strings 
(i.e. “2001-12-01$Eric Smith$Prescribed burn, exotics control”) you 
now need to split the string into its original fields.  In the following 
example, the first string is converted to a date field. 

 

Step 5:  Setup of 
Subnational Conversion 
Spreadsheet  

Step 6. Running the Data 
Conversion Program 

Step 7.  Splitting out 
Concatenated Fields  
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Update First String (As Date) 

select to_date(substr(surveydata,1,10), 'yyyy-mm-dd') from site_ilext2 
where rownum < 2; 
 
select surveydata from site_ilext2 where instr(surveydata, '$') = 11; 
 
select to_date(substr(surveydata,1,10), 'yyyy-mm-dd') from site_ilext2 
where instr(surveydata, '$') = 11; 
 
update site_ilext2 set survey_date =  
to_date(substr(surveydata,1,10), 'yyyy-mm-dd') where instr(surveydata, 
'$') = 11; 

 

Update Middle String (between $..$) 

select substr(surveydata, (instr(surveydata, '$')+1), ((instr(surveydata, 
'$',1,2)-(instr(surveydata, '$')+1)))) 
from site_ilext2 where rownum < 10; 
 
update eo_ilext2 
set observation_data = substr(obseodata, (instr(obseodata, '$')+1), 
((instr(obseodata, '$',1,2)-(instr(obseodata, '$')+1)))); 
 

Update Last String (from $ to end) 

select substr(surveydata, (instr(surveydata, '$',1,2)+1)) from site_ilext2 
where rownum < 20; 
 
update site_ilext2 set actions = 
substr(surveydata, (instr(surveydata, '$',1,2)+1)); 
 
update eo_ilext2 set observation_source =  
substr(obseodata, (instr(obseodata, '$',1,2)+1)); 
 
 

 

8.3.   Using Microsoft Access 
 
NatureServe used Microsoft Access to manipulate the data into the 
correct format to populate their extensible data from central BCD.  Any 
method will work.  It’s the end result that matters.  If you go this route, 
make sure the NEXT_SEQ table is updated with the correct values for 
your tables. There is information on creating a ODBC/JDBC bridge to 
export data from Access into XML for use with the conversion program. 
For more information see the Biotics Knowledge Base item “Connecting 
to Oracle from MS Access via ODBC” 
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8.4. Configure Dynamic Tabs 
 
The Administrator -> Dynamic Tabs interface allows the user to link the 
Oracle objects and data to the Biotics Tracker application. 
Double-click on the Dynamic Tabs icon to bring up the Dynamic Tabs 
window. 

 
 
The Dynamic Tabs main window allows you to create a new tab, edit an 
existing tab, or delete an existing tab. 

 
 
Click the New button will to create a new tab. 
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Name and Description will appear on the Dynamic Tabs main window.  

Select the Table Name that you created in Oracle to store your 

extensible data.  Select the Window to Extend that corresponds to the 
selected table.  A list of the detail windows for which extensibility is 

supported appeared earlier in Section 8.1.  Enter a Tab Caption that will 
appear as the tab label in the extended Biotics Tracker window.  If the 
selected table has a 1 to many relationship with the subject area you are 

extending then check the Is Grid Layout box. 
 
You must associate a user interface control to each column.  You may 
also choose whether or not to display the data in Biotics Tracker by 

checking or unchecking the Visible check box.  You will probably not 
want to display the primary key (EO_EXT_1_ID in the example) or the 
foreign key from the extensible table area (EO_ID in the example).  Note 

that one column must be checked as the Primary Key (EO_EXT_1_ID 

in the example) and one column must be checked as the Foreign Key 

from Extensible Table (EO_ID in the example). 

 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 81 -  

 
 
Control Type – Control types are defaulted to TextBox. The available 
control types are: 
 

• TextBox – A standard textbox control.  

 

  
 
• CheckBox – a standard checkbox control. Values in the database are 

stored as 1 for true, 0 for false. 

 

 
 

• ComboBox – a standard combobox control.  A Domain table must 
be selected along with its selected Data Column (the data that will 
be stored in the database) and Display Column (the data to show in 
the ComboBox).  Values in the domain table will appear in the 
natural order of the data (i.e. what you’ll get if you just select * from 
the domain table with no order clause) – therefore make sure values 
are inserted into the domain table in the order you want them to 
display. 
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• DateControl – a custom date control.  Default value must be of date 

format.  This type of control cannot be used in a dynamic tab in a 
grid layout. 

 

 
 
• Multi-List  – a custom Listbox control.  A Domain table must be 

selected along with its selected Data Column (the data that will be 
stored in the database) and Display Column (the data to show in the 
Multi-List).  This type of control will allow you to select multiple 
values for a given field, however, the values will be stored in the 
database as a single semi-colon-delimited record (i.e. “value 1; value 
2; value 3”).  This type of control can be stored in a field in a table 
with SINGLE-valued fields. This type of control cannot be used in a 
dynamic tab in a grid layout.   

 

 
 

• RichText Control – a custom textbox control that will allow rich edit 
format for the text.  This rich text mode will only occur for this 
control if it is set in the administrator application under Rich Text 
option, otherwise the default behavior is a plain textbox control.  
This type of control cannot be used in a dynamic tab in a grid layout. 

 

 
The Oracle data type for the selected column will limit the control 
types. 
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There are two ways to rearrange the order of how the controls are 
created and tabbed on the new tab.  The first is to select a column 

(row) from the Table Column Information grid and then use the 
right-sided arrow buttons to move a column up or down.  The second 
is to select a column (row) from the Table Column Information grid 
and then use the mouse to drag the selected column up and down.  

The sequence order in the grid is the order that the controls will be 
created. 
 

Within a grid (1 to many relationship), display columns are 
created from left to right starting with the smallest sequence 
number going in ascending order. Controls on a freeform (1 to 
1 relationship) are created using the smallest sequence number 
going in ascending order as well, but are drawn as the 
following graphic depicts: 
 
If there are more controls to be created than there is space on 
the tab display, you will have to physically subdivide your table 
into two or more tables, and create more than one dynamic tab 
for the detail window. 

 
 
 

Column Type  Available Control Types 
DATE   DateControl 
NUMBER  TextBox, ComboBox 
CHAR   TextBox, CheckBox 
VARCHAR2  All Types 
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The following screen captures complete the example configuration. 
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8.5. Security for Dynamic Tabs 
 
Upon completing the Dynamic Tabs configuration, the new tabs and 
fields will be visible in Biotics Tracker but they will be disabled.  You 
must add them to the security configuration in order for them to be 
editable.   
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When you define a Dynamic Tab in the Administrator application, it 
inserts new records into the SYSTEM_CONTROL table.  You must use 
the Function Manager in the Administrator application to add these new 
controls to a new or existing security function.  In Function Manager, the 
new controls will appear under the detail form to which they were 
added.  The following table relates each window to its Function Manager 
detail form. 
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Detail Window 
(Defines the granularity for which extensibility 

can be configured) 

Function  
Manager 

Detail Form 

ELEMENT TRACKING – GLOBAL – SPECIES ctlETDetailsTabs 

ELEMENT TRACKING – GLOBAL - 
COMMUNITY 

ctlETCommunityTabs 

ELEMENT TRACKING – NATIONAL – 
SPECIES 

ctlETDetailsTabs 

ELEMENT TRACKING – NATIONAL – 
COMMUNITY 

CtlELCommunityTabs 

ELEMENT TRACKING – SUBNATIONAL - 
SPECIES 

ctlETDetailsTabs 

ELEMENT TRACKING – SUBNATIONAL - 
COMMUNITY 

CtlELCommunityTabs 

  

ELEMENT RANKING - GLOBAL RankDetails 

ELEMENT RANKING - NATIONAL RankDetails 

ELEMENT RANKING - SUBNATIONAL RankDetails 

  

ELEMENT CHAR – GLOBAL - SPECIES ctrTaxonomy 

ELEMENT CHAR – GLOBAL – COMMUNITY ctrCommunity 

ELEMENT CHAR – NATIONAL – SPECIES ctrTaxonomy 

ELEMENT CHAR – NATIONAL – 
COMMUNITY 

ctrCommunity 

ELEMENT CHAR – SUBNATIONAL – 
SPECIES 

ctrTaxonomy 

ELEMENT CHAR – SUBNATIONAL – 
COMMUNITY 

ctrCommunity 

ELEMENT CHAR – LOCAL – COMMUNITY ctrCommunity 

  

ELEMENT MANAGEMENT ELMgmtDetails 

  

EO SPECS  EOSpecsDetail 

  

EO RANK SPECS EORankSpecDetails 

  

ELEMENT SITE ElementSiteDetails 

  

ELEMENT ECOREGION - GLOBAL EcoRegionELDetails 

ELEMENT ECOREGION - NATIONAL EcoRegionELDetails 

ELEMENT ECOREGION - SUBNATIONAL EcoRegionELDetails 

  

EO ECOREGION EcoRegionEODetails 

  

ALLIANCE ECOREGION EcoRegionALDetails 

  

ELEMENT GROUP ELGroupDetails 

  

ELEMENT OCCURRENCE EODetails 

  

SOURCE FEATURE SrcFeatDetails 
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Detail Window 
(Defines the granularity for which extensibility 

can be configured) 

Function  
Manager 

Detail Form 

MANAGED AREA ManagedAreaDetails 

  

SITE SiteDetails 

  

SCIENTIFIC NAME ScientificDetails 

  

REFERENCE ReferenceDetails 

  

CONTACT ContactDetails 

 
Biotics comes pre-configured with a standard security configuration.  
The most common scenario for extensibility is that it will be added to 
the edit function for a given window.  By doing this, users who have edit 
access to the core fields will also have edit access to the extensible 
fields.  The other option is to create a new category so that security 
access could be granted to that category independently.  The rest of this 
section will complete the example by adding the extensible fields to the 
Edit EO Function within the Element Occurrence Category. 

 

 
 
Edit the “Edit EO” Function and use the down arrow to move from the 
Control List to the Selected Controls. 
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From the Control List, select the extensible controls.  The names will be 
based on the extensible table and column name.  Visual Basic has a 
limitation of 39 characters for control names so some combinations of 
extensible table and column name will exceed this.  To work around this 
limitation, all extensible control names are truncated to 36 characters 
and then concatenated with a 4-digit number.  This number is generated 
sequentially as the controls are being created in Administrator. 
 
Each tab will have three sets of controls:   
 
Control Type from Dynamic Tabs Manager: 

 
 
Labels: 

 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 90 -  

 
PictureBox: 

 
 
A dynamic tab with a grid will only have three entries:  one for the grid, 
one for the grid label, and one for the picture box. 
 
After saving you are ready to use your extensible fields.  If you created a 
new category you will first have to use the Administrator -> Security 
manager to assign the proper access rights to users and/or groups.  If you 
are in Biotics Tracker, you must exit and log back in prior to the security 
taking effect. 
 

 

8.6.  General Notes 
 
• Extensibility may decrease performance for two reasons.  More 

visual basic controls are added to the window and data for dynamic 
tabs is loaded when the record is loaded (i.e. not on-demand when 
the user clicks on the tab). 

• Records are inserted into the extensible tables only when the user 
modifies a field on the extensible tab.  This means that there will 
only be records in the extensible table for records where the user has 
actually added/modified data. 

• There is a limit to the number of extensible controls that can be 
added to a detail window.  Visual Basic does not allow more than 
255 controls on a window.  It is not possible to give a specific 
number of extensible controls that can be added, as it depends on the 
number of controls already on the detail window. 

 
 

8.7. Read Only User 
 
After extensible tables have been created, the BIOTICS_REPORT user 
in the Oracle database requires select access on all tables and views in 
the database, primarily for running Crystal Reports. To grant 
BIOTICS_REPORT select access on all the tables, run the script 
report_grant.sql, available on the installation CD. Additional tables or 
views created after this script is run will require the script to be run 
again  
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8.8. Modifying Existing Extensible Tables 
 
If you want to add additional extensible fields to your database and have 
determined that there is an existing table to which they can be added, 
you will need to modify the existing table(s) to accommodate the new 
field.  You should always, consider this possibility of modifying an 
existing table prior to creating new tables and configuration settings.  
 

Note:  you may make modifications to the structure of your extensible 
tables, however, you should NEVER modify the structure of standard 
database tables. 

 
 
You must use SQL*Plus or SQL*Plus worksheet to add the new column 
to the existing table.  For example, below is a SQL command that adds a 
column called “my_data” to the EXT1 table: 

 

 alter table EXT1 add (MY_DATA varchar2(100)); 

 
Below is a command that increases the width of the “my_data” column 
to 200 characters: 

 

alter table EXT1 modify (MY_DATA varchar2(200)); 

 
Once you make the change to the table in SQL*Plus, it is a good idea to 
make the change in the oracle script that was originally used to create 
the extensible table.  This ensures that if the table is ever dropped and 
recreated for any reason, your edits will be preserved.  Use a text editor 
to make the change to the script and be sure to add detailed comments 
indicating what you changed in the header for the table, and in the 
header of the script for later reference.  If this table was created for you 
at installation, the original script should have been provided to you by 
your installer at installation.   

 
 
If you want to remove an extensible field from one of your extensible 
tables you must manually remove the target column from the target 
table.  You must use SQL*Plus or SQL*Plus Worksheet to remove the 
column.   For example, below is a SQL command that removes a column 
called “my_data” from the EXT1 table: 
 

 alter table EXT1 drop column MY_DATA; 

 
However, keep the following in mind: 

Adding an Attribute 

Deleting an Attribute 
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Only one column can be dropped at a time. 

 

The table must have at least one column remaining in it after it is altered. 

 

Once a column is dropped, in cannot be recovered. 

 

In some cases it may be useful to restrict an extensible field to a specific 
format beyond the restriction imposed by its data type.  This is done in 
SQL*Plus or SQL*Plus Worksheet by adding a constraint to your 
extensible table.  In the example below, a constraint is added to a column 
that forces the length of the data to be 6.   

 alter table EXT1 

     add constraint NAME_OF_CONSTRAINT 

     check  

     (length(NAME_OF_FIELD) = 6); 

Tracker will refuse to save the record if the constraint is violated, and an 
Ora-02290 Error will be displayed.  The name of the constraint will 
appear in this error message, so you should choose a name that will alert 
the user to his or her error.  Also keep in mind that constraints do not 
apply to null values, so in the previous example you could still save the 
record even if the “NAME_OF_FIELD” field is empty.   

Any condition may be checked in your constraint.  In this second 
example, the constraint checks that the data entered are capitalized.   

alter table EXT1 

     add constraint MUST_BE_UPPERCASE 

     check  

     (upper(NAME_OF_FIELD) = NAME_OF_FIELD); 

 

Once you make the change to the table in SQL*Plus, it is a good idea to 
make the change in the oracle script that was originally used to create 
the extensible table.  This ensures that if the table is ever dropped and 
recreated for any reason, your edits will be preserved.  Use a text editor 
to make the change to the script and be sure to add detailed comments 
indicating what you changed in the header for the table, and in the 
header of the script for later reference.  If this table was created for you 
at installation, the original script should have been provided to you by 
your installer at installation.   

 

After you have renamed the table or column, you may also have to 
modify any Oracle views that reference the field. 

 

Adding a Constraint 
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Note: Another way to remove a column is to drop and re-create the 
table entirely.  However this is considerably more complicated.  See the 
‘Dropping a Table’ section below for details on how to do this. 

A third option is to just to null out all existing values in the column and 
leave it there.  For example, in SQL type: 

update EXT1 set my_data = null; 

 

To rename an Oracle table, you must drop and recreate the table – see 
the ‘Dropping a Table’ section below for details.  You must also update 
the corresponding keyword in the HDMS_TABLE and the NEXT_SEQ 
table using SQL*Plus. 

Unfortunately columns cannot be renamed in Oracle format – you must 
drop and re-create the column.  See the ‘Deleting an Attribute’ and 
‘Adding an Attribute’ sections above for more information on how to do 

this.  Note:  Once you drop a column, you have also dropped all the data 
that are in it. 

Once you make the change to the table in SQL*Plus, it is a good idea to 
make the change in the oracle script that was originally used to create 
the extensible table.  This ensures that if the table is ever dropped and 
recreated for any reason, your edits will be preserved.  Use a text editor 
to make the change to the script and be sure to add detailed comments 
indicating what you changed in the header for the table, and in the 
header of the script for later reference.  If this table was created for you 
at installation, the original script should have been provided to you by 
your installer at installation.   
 
After you have renamed the table or column, you may also have to 
modify the Oracle views if they reference the table or column. 

 

It should be rare that you need to drop an extensible table.  However, 
should this become necessary, the procedure is as follows: 

Use the SQL ‘drop’ command.  You should be connected to the database 
as the Oracle user that owns all the tables (usually "biotics_user") when 
you drop the table.  For example: 

 drop table my_table; 

 

Note: Some of your extensible tables may have constraints that make 
dropping them difficult (the constraints must be disabled). 

 

If necessary, modify any Oracle views that reference fields from the 
dropped table 

 

Renaming a Table or 
Attribute 

Dropping a Table 
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Once you have made modifications to an existing table by: 

• adding a column 

• changing the table name 

• changing a field name 

you must drop and recreate the dynamic tab in order to view the 
modifications on the dynamic tab.  However, if you have simply: 

• deleted an attribute 

• altered the width of an existing attribute 

you may edit the existing tab to reflect your edits. 

 

You must also re- run the report_grant.sql script (see section 8.7) in 
order to grant access to the new/modified table to the 
BIOTICS_REPORT read-only user. 

 

Finally, you must add the new/modified field to the tab’s security in 
order to make the new fields editable (see section 8.5). 

 

Viewing Extensible 
Table Modifications 
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9. COMPLETE DATABASE 

CONFIGURATION 

9.1. Create Triggers and Deleted Schema 
 
Prior to running the scripts it is assumed that the sequences for the audit 
tables have been created and that the table HDMS_TABLE has been 
populated.  Each of these items should take place during the Biotics 
database creation process described in prior steps. 
 
 
 
Creating the tables for the deleted data and compiling the triggers have 
been split into 2 steps.  Retrieve the following from version control: 
 
..\hdms\sql\ddl\db_objects\triggers\create_del_objects.sql 
..\hdms\sql\ddl\db_objects\triggers\CompileTriggers.sql 
..\hdms\sql\ddl\db_objects\triggers\WORKING_LIST_trigger.sql 
..\hdms\sql\ddl\db_objects\triggers\TriggerScripts-8-8-2202.zip (or the 
zip file containing the latest triggers) 
 
1. Unzip the TriggerScripts…zip file. This will unzip into a directory 

called TriggerScripts.  It is recommend that it be put somewhere 
with a short path (i.e. directly at the root of the C drive). 

 
2. Then place the remaining three scripts (listed above) into the 

TriggerScripts directory. 
 
 
Data deleted in Biotics are moved to a mirrored set of tables that have a 
naming convention [table name]_DEL.  When you configure the Biotics 
Oracle environment, you may choose to create these tables under a 
separate Oracle user (this is the recommended configuration).  The script 
that creates these tables is driven by the data contained in 
HDMS_TABLE. 
 
1. Login to SQL Plus (not worksheet) as the Biotics 4.0 user and run 

the create_del_objects.sql script: 

a. Choose Spool / Spool File… from the File menu 
b. Navigate to the local directory where the script is located 
c. Create a file in that directory with any name (e.g. x.lst) – the 

purpose of this is to set the current directory  

d. Choose Spool / Spool Off from the File menu 

e. Type @create_del_objects.sql at the “SQL>” prompt and 

press <enter> 

Retrieve Scripts 

Create Objects for the 
Deleted Data 
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2. The script will prompt you for the name and password of the deleted 

schema user and the name and password of the source schema user 
as well as the service name you are using to connect to the database. 

 
3. Log files will be created in the TriggerScripts directory.  Check the 

log files for errors before proceeding. 
 
 
The triggers in the Biotics 4.0 database were created programmatically.  
The trigger program is driven by the data contained in HDMS_TABLE.  
A trigger is created for every value in the TABLE_NAME field with a 
TABLE_TYPE = 'B'.   
 

Note:  There are no triggers for extensible tables since these are 
installation specific.  If you want these tables to be audited then you will 
have to create triggers by copying the logic in the existing triggers. 
 
1. Make sure your TriggerScripts directory contains the trigger files 

from the zip file, WORKING_LIST_trigger.sql, and 
CompileTriggers.sql 

 
2. Still in SQL Plus, run the script CompileTriggers.sql: 

a. Type @CompileTriggers.sql at the “SQL>” prompt and 

press <enter> 
 

3. Log files will be created in the TriggerScripts directory.  Check the 
log files for errors before proceeding. 

 

 
The following statement will create a series of statements to 
compile the invalid objects in your database.  This should be run 
after compiling the triggers for a new installation, and any time the 
database is re-imported for any reason (i.e. move to a new server) 
 
1. Log into SQL Plus or SQL Plus worksheet and run the 

following statements: 

a. Spool <path>\compile_objects.sql; 
b. select ' alter '||OBJECT_TYPE||' '||object_name||' 

compile;'  from user_objects where 
status='INVALID'; 

c. spool off; 
2. Edit the script created from the above statement to remove all 

but the statements. 
3. Run the compile_objects.sql script 
4. Repeat steps 1 – 3 until no more statements are created from 

the statement in step b. 

Compile the Triggers 

Analyze Schema 
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The following procedure will tune the database and should be run 
after the invalid objects are compiled as well as periodically: 
 

exec 
dbms_utility.analyze_schema('BIOTICS_USER','COMPUTE')
; 
 
 

9.2. Trim Domain Tables  
 
The following Biotics 4.0 Domain tables should be reduced or populated 
to contain only the desired values for subnational programs.   
 

• D_county (county name, BCD countycode, 5-digit FIPS code) 

• D_watershed (8-digit Huc code with leading 0 and Huc name) 

• D_mapsheet (BCD quadcode, USGS code and quad name) 

• D_localjuris  

• D_physprov 
 
For County, Watershed, and Mapsheet domain tables, the initial database 
used for converting subnational programs includes all values used by 
NatureServe central and should be trimmed to contain only the rows 
needed for calculating attributes in Designer.  This will increase 

performance by eliminating unnecessary values. Note: Check with the 
heritage program and find out if they want additional values (i.e. for 
neighboring jurisdictions) or use the spatial attribute themes to create a 
complete list of possible values that could be calculated.  For LocalJuris 
and PhysProv domain tables, the initial database used for converting 
subnational programs is empty and gets populated based on the values 
found during the BCD conversion.  For these tables, additional values 
may need to be inserted to ensure all possible values found in the spatial 
attribute themes are included in the domain tables. 
 
Either trimming or populating values for each of the above listed domain 
tables can be done using Access: 

 
1. Create tables in Oracle to hold heritage program values.   Refer 

to the scripts in ..\hdms\sql\Data Conversion\Trim Domains to 
Correct Values.txt for the SQL for creating these tables. 

 
2. Export all the values in the spatial attribute theme to a .dbf file 

(including the fields listed below) and import into access.  
a. Open the attribute table in ArcView and make sure 

nothing is selected. 
b. File > Export to dbf file and save with a name using 8 or 

fewer characters 
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c. Open a new Access database and File > Get External 
Data > Import to bring in the .dbf files created in the 
above step. 

 
3. Create duplicate tables in Access by copying and pasting each 

imported table.  When prompted, choose structure only and give 
the table a new name. 

 
4. Populate the new table with distinct values.   

a. Choose Create a Query in Design View. 
b. At Show table, choose the original table that contains 

the domain table values and close the Show table 
window. 

c. Choose Properties from the right-click menu from the 
Query window. 

d. Double click on Unique Values in the Query Properties 
window to change the Unique Values property to Yes. 

e. Choose Query > Append Query and choose the name of 
the new table created in the copy step in the Append 
window.  Use the Current Database default radio button 
and click OK. 

f. Execute the Query (Exclamation point button) and 
choose Yes to append the records to the new table. 

 
5. Delete null rows if they exist from duplicate tables. 
 
6. Insert distinct values from Access into Oracle.  Link to the 

oracle table (x_hp) from access: 
a. File > Get External data > Link Tables. 
b. In the Link window, choose ODBC Data Source. 
c. In the Select Data Source window, choose the Machine 

Data source tab and choose the connection to your 
oracle database from the list. 

d. Enter your connection information to the biotics_user in 
the Driver connect window 

e. Choose the x_hp table from the link Tables window.   
 
7. Create an append Query in Access (as above) to populate the 

x_hp table from the no duplicates table.  Note that the field 
names in your no duplicates table must exactly match those in 
the x_hp table in order for the append to work.  Resolve any 
required field issues first. 

 
8. Refer to the scripts in ..\hdms\sql\Data Conversion\Trim 

Domains to Correct Values.txt trim the values in the domain 
tables based on the values in the temporary x_hp tables. 

 
9. Once you have verified that the scripts worked, you may drop 

the x_hp tables from the oracle database 
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9.3. Reset Managed Area and Site Sequences 
 
The Managed Area and Site sequences must be set to the next available 
number based on the Managed Areas and Sites converted from BCD.    
 
1. Retrieve the ..\hdms\sql\dataconversion\site_ma_seq_update.sql 

script from version control and copy it to a local directory. This 
script will reset the counter for Managed Areas and Sites to the 
highest number 

 
a. Before running this script, make the edits indicated in the script 

to find the highest number for the Site and MA code the program 
uses for creating new features. 

b. Choose Spool / Spool File… from the File menu 
c. Navigate to the local directory where the script is located 
d. Create a file in that directory with any name (e.g. x.lst) – the 

purpose of this is to set the current directory  

e. Choose Spool / Spool Off from the File menu 

f. Type @site_ma_seq_update.sql at the “SQL>” prompt and 

press <enter>. 

 
 

9.4. Populate Spatial Attribute Table (NEW install ONLY) 
 
For a new Biotics 4 installation, the conversion to BCD will populate the 
business tables with spatial attributes from the EOR, MABR and SBR 
files, however, the spatial attribute table will remain empty.  The stored 
procedure which copies populates the business tables from the spatial 
attribute table during an update requires that the spatial attribute table be 
fully populated in order to function properly.  For upgrades from Biotics 
3.1, the spatial attribute table will be ported from the old database.  For 
new installations, you must run a script to populate this table. 
 
1. Retrieve the hdms/sql/DataConversion/populate_spatial_attribute.sql 

from version control and copy it to the local directory used above. 
 

2. Type @populate_spatial_attribute.sql at the “SQL>” prompt and 

press <enter>. 
 

9.5. Parse TRS Note configuration (Optional) 
 

a. Do not run this script unless you need to parse trs note data from 
the gis layer to the trs_note column in the TRS business tables. 
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b. Retrieve the 
hdms/sql/ddl/db_objects/stored_pro/populate_trs_note.sql from 
version control and copy it to the local directory used above. 

 

c. Type @ populate_trs_note.sql at the “SQL>” prompt and press 

<enter>. 
 
 

d. This script will add a record to the db_upgrade_history table to 
allow support personel to determine if a program is using this 
feature. 

 
e. This parse trs note procedure may be discontinued by running 

the hdms/sql/ddl/db_objects/stored_pro/biotics.sql script. 

 
 

9.6. Installing Mapper 
Mapper installation is done in two parts: 

• Installing Mapper software onto the server - executables, help 
files, and other various support files are installed onto the server 

• Configuring each client machine to run Mapper – shortcuts and 
registry settings are established on each client machine, for 
multiple users per machine if necessary. 

If errors occur during any step of the installation, contact technical 
support immediately.  Do not proceed to the next step until the 
problem has been corrected. 

 

9.7. Install Mapper on the Server 
 

Assumptions 

• Biotics 4 database already exists and is populated with data from 
the Biotics 4 Oracle database.   

 
1. Map drives on the server as was done previously, using the same 

ODBC_DSN. 
2. Move the entire BIOTICS directory to the new location on the 

server. 
 

Assumptions 

• This is a NEW Biotics 4 installation – Biotics has NEVER been 
used previously 

 

Migrating the 
Mapper 
Installation 

Creating a NEW 
Mapper 
Installation 
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*** IMPORTANT *** 
When installing Mapper on the server, be sure to install it to the same 
network drive letter that client machines will use to access the server.  
For example, if Mapper is being installed into D:\Software\Biotics on 
the server, but client machines will access it from O:\Biotics where O: is 
mapped to D:\Software, then be sure to map drive O to that same 
location before installing the software on the server. The full path to 
both the software and themes is stored in several places within the 
Mapper program. 

 
1. Insert the Biotics CD into your CD-ROM drive. 

2. Using “My Computer” or the “Windows Explorer”, run the 

MapperSetup.exe program on the CD. 

3. Choose Server Setup from the list of choices, and then follow the 
prompts. 

a. In the “Select Setup Option” window, choose “Server” 

b. In the “Destination Directory” window, choose the path 
to which Biotics should be installed.  Make sure this 

path is identical to the one used by the client machines 
to access the application. 

c. Click “Next” in the Themes directory window, and the 
ODBC setup window. 

d. Click “Install” to install the server portion. 

 
9.8. Configure Clients & Users to Run Mapper 

 

In this step, shortcuts and registry settings are established on each client 
machine.  In the case of a shared Mapper client, the installation must be 
run multiple times, once under each user’s system login. 

 

While installing the client software, you will be prompted to select the 
location of the user’s workspace (GIS_WKSP) directory. 

The workspace is a location on disk where personal and temporary files 
generated by Mapper will be placed.  This includes: 

• The user’s ArcView project file (biotics.apr) 

• Mapper shapefile clones 

• Log/Report files 

• Themes copied from CD-ROM 

Some of these files are deleted automatically (e.g. themes from CD-
ROM), while others are left there permanently (e.g. Mapper shapefiles). 

Workspace 
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Mapper works fastest when the workspace is located in a directory on 
the local machine.  However, if a user needs to be able to run Mapper 
from multiple machines, the user’s workspace must be placed in a 
location accessible from the network.  The location of the workspace 
does not have to be the same for all users. 

The workspace must be unique to each Mapper user.  There are two 
situations where setting up the workspaces can be tricky: 

• Multiple Mapper users sharing a client machine 

• “Floating Users” 

 

Shared Machine 

A shared machine is a Mapper client used by more than one person.  In 
this situation: 

• Each person must have their own Windows logon (unless 
multiple users logon to Mapper using the same user id). 

• Each Windows user must point to a separate workspace. 

For example, you might have three Windows users on the machine: 
SMITH, JONES, and BROWN.  SMITH’s workspace points to 
c:\users\smith, JONES’ workspace points to c:\users\jones, and 
BROWN’s workspace points to c:\users\brown. 

 

Floating User 

A floating user is a person who needs to be able to run Mapper from 
multiple client machines.  In this situation: 

• The workspace should be on a network drive, so that no matter 
which machine the user is sitting at, they are using the same 
workspace. 

For example, Windows user “GREEN” needs to be able to use more than 
one machine.  So GREEN’s workspace might be set to 
K:\Biotics\WKSP\GREEN where K: is a network drive. 

Recommendation: Create a workspace directory under the same parent 
directory of Biotics on the server; this will require only one mapped 
drive letter. 
  

 

Note: In order to install the Mapper client, the Mapper user’s Windows 
user profile must include the ability to write to the registry.  The Install 
program will not run correctly without this ability.  In some cases, this 
requires that the Windows User profile be bumped up to “Power User” 
or “Administrator” to perform the installation.  However, once the 

Setup Instructions 
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installation has been completed, the User can be returned to the previous 
security level, and Mapper should run normally. 

 

To configure a client machine to run Mapper: 

1. If necessary, grant PowerUser/Administrator privileges to the 
Windows user that will run Mapper (see note above).  

2. Log into the client machine as the Windows user that will run 
Mapper.  If multiple Windows users will run Mapper on the 
machine, then you need to repeat these steps for each Windows user. 

3. Map drives (as persistent) to the Biotics directory, the Authorization 

directory and the workspace directory (if necessary).  Note:  if all 
these directories are stored at the same level on the same server and 
the directory above is shared, they can all be accessed through the 
same drive letter. 

4. Insert the Biotics CD into your CD-ROM drive. 

5. Use “My Computer” or the “Windows Explorer” to navigate to and 

run the MapperSetup.exe program on the CD. 

6. In the “Select Setup Options” window, choose “User Setup.” 

7. In the “Select Biotics Directory” window, choose the location where 
the application is housed on the Server.  The /Biotics folder must be 
included in the path. 

8. In the “Select Authorization File” window, navigate to the 
Accounts.com file on the server.  For its location see Section 5.1 of 
this document, “Tracker Server Installation.” 

9. In the “Select Workspace Directory” window, choose the path to the 
user’s workspace directory (\GIS_WKSP).  If the user's workspace 
already exists, you will receive a warning.  Click Yes to install into 
that directory anyway. 

10. In the “Oracle Database Access Options” window, leave the Data 
Source Name as “Ora_Server.”  The Alias, by default 
“oracle_server,” is the Net Service Name with which you connect to 
Oracle.  If the service name is not oracle_server, enter the correct 
value here and click OK. 

11. In the “Program Group Options” window, choose the Program 
Group where Biotics should be installed.  By default it is included in 
a group called “Biotics.”  Here you may also choose to have a 
shortcut created on the User’s desktop (recommended). 

12. In the “Confirm Setup Options” window, review your choices, and if 
satisfied, click “Install” to begin the installation. 

13. If an “Oracle ODBC Driver Setup” window appears, verify it 
contains the correct Service Name, and click OK to continue. 
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14. If prompted to “Replace Existing Project File,” Click Yes to replace 
it, or No if you do not want to overwrite the existing project. 

15. When the installation is complete, you can review the actions 
performed on the machine by opening “install.log” (located in the 
user’s workspace) in a text editor. 

16. If security privileges were added to the Windows user, be sure to 
change them back. 

17. Repeat for additional Biotics users on the same machine. 

Please refer to Section 23.1, “Workstation Configuration” for details on 
what is installed during the Client setup. 

 

 
 
Additional Configuration Steps for Installation (upgrading from 
version 3.1 only) 
 
This step only needs to be done once – this step is generally done by 

NatureServe Staff only during configuration of your database. 

 
1. Set Index Map from Admin menu in Biotics so that preferences 

can be changed (the conversion script does not do this because 
the structure is too different). 

 
2. Go into the filters and delete any filter that references an 

attribute no longer in the views attached to that theme.  These 
filters could cause errors. 

 
3. Get the Biotics 4.0 legends from 

\\cypress\groups\projects\Biotics\NetworkRollout\Installation\Bi
otics4Legends.  Apply the new legends to the EO Representation 
and Source Feature Themes.   

 
4. MA Name/Site Name cannot be calculated in designer if there 

are apostrophes in the MA/Sitename field in Biotics 4.0.  Since 
MA Name/Sitename are optional attributes for spatial attribute 
calculation, an alternative should be used if apostrophes exist. 

 
 

Additional Upgrade 
Configuration 
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10. DEFINING THE COORDINATE 

SYSTEM 

The coordinate system specifies the map units and projection for all 
theme data.  For example, the coordinate system may specify that your 
theme Data are in UTM - ZONE 14 - NAD83, with map units of 
METERS. The most common coordinate systems are State Plane and 
Universal Transverse Mercator (UTM).  However, there are many 
others. Biotics supports all the coordinate systems that ArcView 
supports. 

All theme data must be in the same coordinate system. Biotics Mapper 
does not support multiple coordinate systems within an installation. 

Many times the Heritage Program/CDC (or the government they are 
affiliated with) will already have a standard coordinate system.  If so, 
using the standard coordinate system as the Biotics coordinate system 
will save data conversion headaches and make more reference data 
available to the Program.   

10.1. Zones 
If a Member Program (HP/CDC) spans two or more State Plane or UTM 
“zones”, only one of the zones can be selected as the coordinate system.  
Data in the other zone must be “forced” (projected) into the zone that is 
selected using ArcInfo. 

Forcing zones causes some distortion (and therefore map inaccuracy), 
and should only be done if the Heritage Program extends slightly into 
another zone. 

If the Heritage Program extends significantly into another zone (e.g. 
several hundred miles), or spans more than 2 zones, then a non-zonal 
coordinate system should be used. 

 

10.2. Datum 
Beware of different datums (NAD27 v. NAD83) in: 

� Reference theme data 

� Paper maps used in the Heritage Program 

� Coordinates for EOs typed into the BCD System 

If you are not sure what datum certain reference layers are in, compare 
them to something you are sure of (e.g. see if rivers and lakes line up).  
If map features seem shifted, you may have a datum problem. In Mapper, 
all reference layers must be in the same datum.  If you must perform 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 106 -  

some datum shifting, ArcInfo tools are generally considered more 
accurate than the ArcView projection utility. 

There can be confusion if the datum of the digital reference maps is 
different from that of the paper maps used in the Member Program. This 
may be particularly important if staff continue to read coordinates off the 
paper maps and use these to input shapes in Mapper.  Please be aware of 
the datum of your paper maps, as compared to your chosen Mapper 
projection. 

 

By default, Mapper will use the NAD83 datum to compute centroid 
UTM coordinates for the EO / MA / SITE shapes.  If a Program wants 
all mapping done in NAD27, a change must be made to the Powerpack: 
System Settings in Mapper. 

1. Start Biotics Mapper and login as a user with administrator 

privileges (e.g. “mgr”). 

2. From the Admin menu, choose Powerpack System Settings. 

A dialog box will display. 

3. Set ‘Datum of Calc. UTM Coord.’ To NAD27. 

4. Click OK. 

 

10.3. To define the coordinate system 
 
1. Start Biotics Mapper and login as a user with administrator 

privileges (e.g. “mgr”). 

2. Important:  If the default projection units are anything other than 
Meters, set the Map units in the View>Properties dialog. 

3. From the Admin menu, choose Define Coordinate System. 

A dialog box will display prompting you to specify the map units.  

4. Specify the map units and click OK. 

The Projection Properties dialog box displays. 

5. Define a projection (for more help, press <F1> when the dialog is 
open).  Any projection available in ArcView should be available 
here. 

6. Tip:  Make a screen capture of the projection definition window for 
your installation documentation before closing this window.  Once 
you close this window, you will not be able to view the projection 
information if you have defined custom parameters. 

7. Click OK. 

8. Confirm the coordinate system definition. 
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11. SYSTEM SETTINGS 

11.1. Biotics Mapper System Settings 
 
In addition to the Biotics system options that are set through the 
Administrator application, there are two system settings that control 
aspects of the updating of shape attributes in Mapper. You should review 
both settings to see if the setting is applicable for the current Member 
Program (HP/CDC). System settings are stored in the 
USER_PREFERENCES view in Oracle. 

These settings are set and maintained within the Biotics Mapper 
application using the "Biotics System Settings" option on the Admin 
menu. For example: 

 

Settings are as follows: 

Name (Biotics FIELD) Description Default 

Update Mapper on Modify 

(BIOTICS_UPDATE_MAPPER_ 
ON_MODIFY) 

If set to YES, SHAPE table attributes 
DIGITAL_MAPPING_BY and 
DIGITAL_MAPPING_DATE will be updated to 
contain the current user and current date, and 
MAP_QC_STATUS will be updated to 
“Incomplete,” whenever the shape of an EO Rep 
(Polygon), MA, or SITE changes, or when spatial 
attributes are manually recalculated.  

If set to NO, SHAPE table attributes 
DIGITAL_MAPPING_BY, 
DIGITAL_MAPPING_DATE, and 
MAP_QC_STATUS are set when EO Reps, MAs, 
or SITEs are first created, and are not modified after 
that. 

This setting is not applicable to source features. 

The default for this setting is NO. 

NO 

Update Parent EO During Recalc 

(UPDATE_PARENT_EO_DURING_ 
RECALC) 

If set to YES, the parent-sub EO relationship will 
automatically be updated and recorded during a 
spatial attribute recalculation. 

If set to NO, the parent-sub EO relationship will not 
be updated during a recalculation (but changes that 
are not made will display in a log window, so that 

YES 
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Name (Biotics FIELD) Description Default 

you know which EOs should be changed, and can 
manually implement the change if desired). 

If set to PROMPT, you will be asked if you wish to 
update the parent-sub EO relationship for all 
applicable EOs, one at a time, during the 
recalculation process. 

The default value for this setting is YES. 

 

11.2. Powerpack System Settings 
 

Many Powerpack system settings are generic and not applicable to 
Mapper.  Changing some of these values can cause Mapper to 
malfunction – refer to the table below for details.  For most installations, 
the default settings will be adequate.  However you may wish to refine 
the settings once you are familiar with the system.  Powerpack system 
settings are stored in the USER_PREFERENCES view in Oracle. 

These settings are set and maintained within the Biotics Mapper 
application using the "Powerpack System Settings" option on the Admin 
menu. For example: 
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The Powerpack System Settings are as follows: 

Name  

(Biotics FIELD) 

Description Default 

Delay before posting 

(EDIT_DELAY) 

The amount of time (in seconds) that the 
system will wait after successfully locking the 
master shapefile before proceeding to update 
the shapefile.  The time delay allows another 
process that just finished updating the 
shapefile to release all holds on the files. 

Reducing this time will speed up posting.  
However if there are ever corruptions, you 
should increase this time.  Never set this time 
less than 1 second. 

The default for this setting is 5 seconds. 

5 

 

Auto-Retry Time Limit 

(MU_RETRY_TIMEOUT) 

The amount of time (in seconds) that the 
system will keep trying to lock a shapefile 
when it is already locked.  If the shapefile 
becomes unlocked before the time is up, the 
system will proceed.  Otherwise the user will 
be asked if they wish to continue retrying. 

The default for this setting is 60 seconds. 

60 

Number of Master Shapefile 
Backups 

(MASTER_GENERATIONS) 

The number of backup copies that are kept for 
each master shapefile.  Backup copies are 
made whenever a post occurs. Each copy is 
named the same as the original file with a 
numeric suffix (1, 2, 3, etc.).  When the 
maximum number of copies has been reached, 
the system begins overwriting the oldest copy 
(i.e. starts back at 1). 

The default for this setting is 3. 

3 

Allow multiple features to be 
created at once 

(DESIGNER_MULTI_ADD) 

*** Must not be checked or Biotics will not 
function properly *** 

DISABLED 

Show selection window for Query 
and Delete 

(DESIGNER_SHOW_SELECT_ 
DIALOG) 

When checked, a dialog will display when 
more than one feature within a theme is 
queried using the ? tool, or deleted using the X 
tool.  Since Biotics has similar windows, this 
is normally not checked (otherwise two very 
similar dialogs will display).  However there 
are two advantages of the dialogs that display 
when this setting is checked: (1) the dialog has 
a flash shape function which the Biotics 
dialogs do not; (2) the dialogs will show all of 
the Oracle attributes currently joined to the 
theme’s attribute table (if any) compared to 
the Biotics dialogs which show preset 
attributes. 

F 
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Name  

(Biotics FIELD) 

Description Default 

Save Multiple Patterns in Survey 
Designer 

(SD_SAVE_MULTI_ 
PATTERNS) 

 

Not applicable to Biotics N/A 

Enable defer calculate spatial 
attributes functionality 

(DESIGNER_DEFER_ATTS_ 
ENABLED) 

When checked, the Defer Calculation of 
Spatial Attributes checkbox appears on the 
Edit/Finish/Cancel dialog when features are 
created and edited. 

This should always be checked in Biotics to 
ensure that relationships between features (e.g. 
parent/sub-EOs) are properly maintained. 

YES 

Datum of Calc. UTM Coord. 

(NAV_CALC_COORD_UTM_ 
NAD) 

Indicates which datum UTM coordinates for 
the EO/MA/SITE centroid should be 
calculated in.  These show up as 
UTM_EASTING and UTM_NORTHING in 
the Spatial Attribute tab. 

Change this setting only if all reference theme 
data (and the coordsys) is in NAD27. 

The default for this setting is NAD83. 

Also see section 10.2, “Datum”. 

NAD83 

New Theme Layer ID 

(NEW_THEME_LAYER) 

Not applicable to Biotics N/A 

Modeling Theme Location Not applicable to Biotics N/A 

Show Template Choice on 
Mapper Menu 

(MAPPER_TEMPLATE_ 
CHOICE) 

This option indicates if the Template choice 
should be visible on the Mapper menu.  
Uncheck this box if you do not want users to 
be able to modify map templates. 

ENABLED 
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12. INTEGRATING REFERENCE THEME 

DATA 

During the configuration process, as much reference theme data as 
possible should be integrated with Mapper (e.g. roads, rivers, towns, 
counties, etc.).  The more reference theme data there are, the more useful 
Mapper will be. 

 

Navigator supports almost every type of data supported by ArcView, 
with two exceptions: 

• SDE 

• Some of the extended (3rd party) image formats 

 

Here are some general guidelines that you should keep in mind as you 
integrate the reference theme data: 

• Themes that are the source of spatial attributes are most 
important, and should be done first. 

• Don’t ignore small scale datasets (e.g. 1:2,000,000) – they are 
ideal for producing simple province/state-wide maps. 

• Watch for datum differences. 

 

Integration of reference theme data can be broken down into the 
following steps: 

• Acquire data 

• Import data 

• Restructure data 

• Define data to Navigator 

• Define legends 

• Convert (digitize) data 

 

Supported data formats 

General guidelines 

Overview of steps to 
integrate reference 
theme data 
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12.1.  Acquire Data 
 

There is data available from government and private organizations.  
It just takes a little research to find it!  As you are digging for data, 
try to find out as much about each dataset as possible from the 
provider of the data.  Many datasets may not be worth the time or 
effort to integrate.  Questions you should ask are: 

• is there a fee for the data? 

• what is the geographic coverage of the dataset? 

• what is the source of the data? (e.g. 1:2,000,000 paper map, 
GPS, etc.) 

• how accurate are the data (e.g. +/- 250 meters) 

• how current are the data? 

• are the data being maintained (i.e. updated)? 

• are there any attributes for the data? 

• what format are the data available in? (e.g. DXF, E00, SIF, 
etc.) 

• what media can the data be provided on? (e.g. FTP, 4mm 
tape, etc.) 

• what coordinate system are the data in? (e.g. UTM, state 
plane, etc.) 

• how big is the dataset? (e.g. 1 MB, 10 GB, etc.) 

• are the data topologically structured? (e.g. centroids in 
polygons) 

 

Decisions will be based on the information gathered previously.  
Only those datasets that will be useful, and are affordable, should be 
acquired. 

 

Write letters, make phone calls, issue purchase orders, etc. to get the 
data.  In some cases, you might be able to get the data yourself over 
the Internet. 

 

Make sure that you can read the data from whatever media it was 
provided on.  It is not unusual to have difficulties reading tapes that 
were generated by a different operating system, in which case you 
will have to make another data request. 

 

Find out what Data 
are available 

Decide which datasets 
you are going to acquire 

Make requests for 
the data 

Load the data onto 
your system 
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12.2.  Import Data 
 

If necessary, import the data into a format readable by ArcView (for 
more information, search the ArcView help on “Supported Data 
Formats”).  ArcView is capable of reading several vector formats, 
including E00, MIF, DXF, DWG, and DGN.  In addition, many raster 
formats are supported (TIF, LAN, etc.). 

If the data come in a format that ArcView does not support, ArcInfo will 
be required.  In addition, if the Data are going to require restructuring, 
the data should be converted into ArcInfo format, since ArcInfo has 
more data manipulation tools than ArcView. 

Once you can view the data in ArcView or ArcInfo, assess its quality 
and content before proceeding any further– you may find the theme is 
less useful than you thought. 

 

12.3.  Restructure Data 
 

In many cases, it will be necessary to restructure the data so that they are 
useful in a GIS environment.  This may include: 

• Changing the projection/datum (e.g. converting lat/long to 
UTM). 

• Subdividing into more specific themes (e.g. splitting a 
“transportation” theme up into highways, roads, railways, etc.). 

• Merging map sheets together to form a “seamless” theme - 
surprisingly a massive non-tiled shapefile will outperform a tiled 
theme in every aspect.  Although it may take a lot of machine 
time to merge all the tiles together and create the shapefile, it 
may be worth it on the long run as long as the data are very 
static and never needs to be edited. 

• Attaching attribute data to the theme from external data files 
(e.g. Oracle). 

• Adding attributes to the theme (manually). 

• Building topology (e.g. polygons). 

• Reorganizing the data on the disk (often necessary for tiled 
themes which have to be structured in a particular way to work 
with Navigator). 

• Creating “world” (georeferencing) files for image themes. 

• Converting ArcInfo coverages to shapefiles – this can improve 
performance dramatically. 
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• Compressing image data into MrSID format – this can improve 
performance and save a ton of disk space.  For example, a 25 
MB TIF image compresses to 2.5 MB with no noticeable loss of 
quality. 

Most of the restructuring described above will require ArcInfo. 

Having said that, keep in mind that you should try to use as much data as 
possible “as is” – in its current location and current format.  Any 
restructuring that you do may have to be re-done whenever a new 
version of the dataset is received.  Further, once you make a copy of a 
dataset, you introduce the potential for someone to forget that there are 
now two copies of the same data on the network.  Sooner or later 
someone might make a change to one of the copies, and forget to make 
the change to the other copy, thus introducing data integrity problems. 

You must analyze each data set individually and make a judgement call 
whether the benefits that will be realized from restructuring the data 
outweigh the potential maintenance and integrity problems. 

 

12.4.  Define Data to Navigator 
 

To make the data easy to access, it must be defined to Navigator.  This is 
done using Navigator Admin (available on the Admin menu).  For 
complete details on how to use Navigator Admin, refer to the on-line 
help. 

Here are some general guidelines: 

• Whenever you make changes to the data warehouse using 
Navigator Admin, click on the “Update Users” button in 
Navigator Admin when you are finished to update every user’s 
“Working Data” list (their view of the Data Warehouse).  
Otherwise they may not see your changes. 

• Be sure to add each and every theme you define to the view 
(using Navigator or the View button in Navigator Admin), to 
ensure that you have defined it properly. 

• Organize themes by subject matter, rather than by the source of 
the data.  For example, rather than having a “1:24,000 topo data” 
library containing roads, rivers, contours, land cover, etc., create 
several libraries for transportation, hydrography, hypsography, 
etc. (see Figure 12-1 – Navigator Example).  Users tend to find 
this type of data organization more intuitive. 

• Use proper or title case to name libraries, datasets, layers, and 
themes rather than all upper case or all lower case.  This makes 
everything look better and easier to read. 
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Example of how theme data can be organized into libraries, datasets, 
layers, and themes in Navigator: 

Figure 12-1 – Navigator Example 

• The name that shows up in the Table of Contents is 
Layer.Theme, so: 

a) Make Layer Name singular 

b) Make Theme Name plural 

For example, “Park.Polygons” (Layer Name = “Park”, Theme 
Name = “Polygons”) instead of “Parks.Polygons” or 
“Parks.Polygon”. 
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• Theme name is usually the feature class (Points, Lines, 
Polygons, Text, or Image). 

• Make sure the Layer.Theme name is unique.  For example, 
consider the following: 

Hypsography 
 Contours 
  1:20,000 
   Lines 
Hydrography 
 Rivers/Streams 
  1:20,000 
   Lines 

Both themes will show up in the Table of Contents as 
“1:20,000.Lines”.  You can solve this problem by repeating the 
dataset name in the layer name: 
 “1:20,000 Contour” + “Lines” 
 “1:20,000 River/Stream” + “Lines” 

• If you define the themes while sitting at the server, be sure to 
define the themes from the drive mapped letters rather than the 
physical device letters.  For example, drive D: on the server may 
be accessed as drive N: from client machines, so make sure you 
define the themes using N: not D:. 

• In the unlikely event that all of your theme data reside on drive 
D: (and is accessed using drive D:), you need to reset the CD-
ROM drive letter preference before you define any themes (the 
default CD-ROM drive letter setting is D:).  This is normally 
done using the Preferences option on the File menu.  However, 
at this point in the configuration process, you cannot use the 
preferences option, because you have not yet defined an "index 
theme" (see section 13).  Therefore, you must set the CD-ROM 
drive letter setting using SQL*Plus or SQL*Plus Worksheet: 

update preferences 
set value = your CD-ROM drive letter [e.g. 'G']  
where key = 'CDROM_LETTER' ; 
commit ; 

Then you must exit and restart Biotics Mapper. 

12.4.1.  Themes Based on Mapper Shapefiles 

You can define a theme based on the Mapper shapefiles.  For example, 
you might define a theme based on the EO Reps (Polygons) with a 
special Oracle view joined to it, suitable for conversion to a shapefile for 
distribution to external parties.  However, you must be careful how you 
define the theme: 
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• The source for the theme should be the CLONE in the WKSP, 
not the master. 

• The “multi-user” property should not be checked for the theme. 

12.4.2.  Defining Core Spatial Attributes 

Core spatial attributes in Biotics include those displayed on the Locators 
tab of the Element Occurrence, Managed Area and Site detail windows 
in the Tracker application.  Core spatial attributes are stored in the 
spatial_attribute table as well as in the business tables for EOs, Managed 
Areas, and Sites.  Oracle stored procedures copy these values from the 
spatial_attribute table after calculation to the business tables for display 
in Tracker.  For example, the mapsheet spatial attributes are copied to 
the EO_MAPSHEET table for EOs.  There are three stored procedures: 
pop_eo_data, pop_ma_data, and pop_site_data.  In order for the stored 
procedures to work properly, these attributes must be defined with 
standard names in Designer Admin (see section 16) and joined to the 
proper domain table in Navigator. Core spatial attributes include:  

• County 

• Mapsheet 

• Watershed 

• Local_Jurisdiction 

• Town_Range_Section 

• Physiographic_Province 

• Managed_Area 

• Major_MA 

• Site 

• Min_Elev_Feet 

• Max_Elev_Feet 

• Min_Elev_Meters 

• Max_Elev_Meters 
 

Note:  the above listed values are the complete list of core spatial 
attributes.  However, it is not necessary for all of the above attributes to 
be used.   
 
Each of the core spatial attributes calculated in Mapper must contain an 
attribute that matches that found in the corresponding domain table in 
order to properly define the theme to Navigator.  The following table 
describes content and format of the field required (the name of the field 
is optional) for each attribute and the oracle view to which the theme 
must be joined in Navigator in order to obtain the domain values. 
 

Attribute Name Required Field Content Target Join Table 

County County Code  (e.g. NYXXXX) 
or State_County_Fips Code 

D_county_vw 

Prepare Spatial Attribute 
Themes 
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Attribute Name Required Field Content Target Join Table 

Mapsheet USGS Code (e.g. 42076-D3) D_mapsheet_vw 

Watershed Huc (e.g. 02040301) D_watershed_vw 

Local_Jurisdiction Local_Jurisdiction_Desc  D_local_jurisdiction_vw 

Town_Range_Section TownRange – Section – 
Meridian  (e.g. 001N001E – 12 
– 4P) 

N/A 

Physiographic_Province Phys Province Code (e.g. LV) D_phys_province_vw 

Managed_Area Managed Area ID Managed_area_vw 

Major_MA Managed Area ID Managed_area_vw 

Site Conservation Site ID Conservation_site_vw 

 
 
 
Once the core spatial attribute themes are defined in Navigator, an 
additional step must be taken to achieve the join to the domain 
table.  Once the join is configured, it will be performed each time 
the theme is added to the view from Navigator.  For this reason, it 
is critical that Navigator is used to add these themes to the view.  
You should never use the standard ArcView add theme button for 
any themes that are defined in Navigator.   
 
Configure the join in Navigator: 
 
1. Define the theme to Navigator and click the Add button on the 

data tab at the bottom of the window: 

 
 

2. The Add button will bring up the following window, which 
should be filled in as follows: 

a. Choose SQL from the Data Type dropdown. 
b. Click the Select Table button. 
c. Choose the appropriate domain table (from the Target 

Domain Table column of the above table).  Note that 
you will see both your Biotics data schema as well as 

Define Core 
Attribute themes in 
Navigator 



Biotics - Biodiversity Tracking and Conservation System 

Installation, Configuration, and Administration Guide 
 

 - 119 -  

your deleted schema in the window, so each table will 
be listed twice.  Make sure you choose the domain table 
that corresponds with your Biotics data schema.  This 
will correspond with the oracle user who owns the 
Biotics data.  For installations using NatureServe’s 
default user names, this user is biotics_user.  The view 
will be listed with the Biotics data user owner and the 
view name (i.e. BIOTICS_USER.D_COUNTY_VW). 

d. Choose the Join option from the Link/Join Options 
section. 

e. SQL Where Clause should be left blank. 
f. Choose the join fields from the Data and Theme 

columns.  In order for the join to work properly, the 
Theme column you choose must contain data in the 
correct format, as described in the table above to match 
up with the appropriate data from the Data column (data 
from the domain table). 

g. Click the OK button. 
 

 
 

12.4.3.  Defining Tiled Themes 

A tiled theme is one that is made up of multiple physical data files.  The 
data files normally do not overlap, and when viewed together, form a 
continuous map. 

Overview 
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Tiled themes are used for themes that have a very large number of 
features (e.g. more than 100,000 points, lines, or polygons), and also for 
very large image themes (e.g. aerial photos).  Creating a single physical 
data file can result in very poor performance, particularly for image 
themes.  Sub-dividing the data file up into multiple physical data files 
ensures that the features in the theme can be drawn on the screen very 
quickly.  In the case of feature themes, a massive non-tiled shapefile can 
display as quickly as a tiled theme; however editing the shapefile will be 
extremely slow.  If editing is not an issue, then consider using tiled 
themes only for image themes. 

In installations where ArcInfo is used, these themes can be managed 
using Map Libraries or ArcStorm Libraries.  Since ArcInfo takes care of 
the tiling, these are not considered tiled themes to Navigator.  Tiled 
themes are therefore only applicable for installations where ArcInfo 
libraries are not used. 

Multi-user shapefiles and SQL Event Themes cannot be tiled. 

 

Tiled themes must be physically organized on the disk in a specific way 
to make them usable in Navigator.  The way they are organized depends 
on the type of theme. 

 

Event Themes and Image Themes 

• All files must be located in the same directory. 

• The filename (without the extension) corresponds to the value 
entered into the TILENAME field in the index theme in step 2. 

• Example: a tiled “aerial photo” theme consisting of 4 images: 

N:\Data\Photos\sw.tif 
N:\Data\Photos\nw.tif 
N:\Data\Photos\ne.tif 
N:\Data\Photos\se.tif 

 

Coverages, shapefiles, and Grids 

• Each coverage, grid, or shapefile must exist in a sub-directory.  
The name of the sub-directory corresponds to the value entered 
into the TILENAME field in the index theme in step 2. 

• The name of the coverages, grids, or shapefiles within each 
subdirectory must all be the same. 

• Example: a “rivers” theme, tiled by watershed, made up of 
coverages:  

N:\Data\Hydrography\wshed1\rivers 
N:\Data\Hydrography\wshed2\rivers 

Step 1: Physically 
Organize Data on Disk 
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N:\Data\Hydrography\wshed3\rivers 
N:\Data\Hydrography\wshed4\rivers 
etc. 

Use Windows tools (e.g. Windows Explorer) and/or ArcInfo to 
physically reorganize the data on disk. 

 

Tiled themes are always accessed through an “index theme”.  The index 
theme is a polygon coverage or shapefile, where the boundary of each 
polygon represents the physical subdivision of the data on the disk.  The 
polygons can be any shape.  For example, if rivers were physically 
divided up into one data file per watershed, the watershed boundaries 
would become the index theme. 

The attribute table for the index theme must contain two columns: 

TILENAME 
(Char 8 or 
more) 

This contains either: 
- a directory name for coverages, shapefiles, and grids 
- a filename (no extension) for event themes and images 

PRESENT 
(Char 1) 

This contains either: 
- “Y” if the physical data file for the tile is available. 
-  “N” if the physical data file for the tile is not available 

Using ArcView or ArcInfo: 

1. Create the index theme coverage or shapefile. 

2. Add the TILENAME and PRESENT columns to the index 
theme’s attribute table. 

3. Populate the TILENAME column manually based on the 
information provided in step 1 above. 

 

Define the Index Theme to Navigator using Navigator Admin.  The 
theme is defined in the same way as any normal polygon theme: 

1. From the Admin Menu select ‘Navigator Admin’. 

2. Select the layer in the tree view that will contain the Index 
Theme. 

3. Click Add. 

4. Click Browse, navigate to the location of the index theme on the  
network, select it, and click OK. 

5. Give the theme a meaningful name (e.g. ‘IndexMap’). 

6. Click OK. 

Step 2: Create 
Index Theme 

Step 3: Define Index 
Theme to Navigator 
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For example, if your index theme was a shapefile called “INDEX.SHP”, 
the Add Theme window might look as follows: 

 

 

Define the Tiled Theme to Navigator using Navigator Admin: 

1. From the Admin Menu select ‘Navigator Admin’. 

2. Select the layer in the tree view that will contain the Tiled 
Theme. 

3. Click Add. 

4. Click Browse, navigate to the location of any one of the tiles (it 
does not matter which) on the network, select it, and click OK. 

5. Give the theme a meaningful name (e.g. ‘ForestCover’). 

6. Click the Tiled checkbox.  

7. Select the Index Theme created in step 3 from the Index Theme 
drop down list. 

8. Enter a number into the Max Tiles text box.  This number is 
used as a safety check, to warn the user when a request is made 
to open an exceedingly large number of tiles.  The number 
entered should reflect the number of features in each tile.  For 
example, for tiles that contain less than 1,000 polygons each, 
you might enter 15.  For tiles that contain 10,000 polygons each, 
you might enter 4. 

9. Click OK. 

Consider the following example: 

• Your tiled theme consisted of shapefiles called “FC.SHP” 

• Subdirectory names are 093A021, 093A042, 093A051, etc. 

The Add Theme window might look as follows: 

Step 4: Define Tiled 
Theme to Navigator 
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It is not unusual to have tiles defined in the index theme with no 
corresponding physical data file.  For this reason, the index theme 
contains a PRESENT column that defines whether the data file is 
physically on-line.  An admin function is provided to automatically 
update this column in the index theme.  To use this function: 

1. From the Admin menu select ‘Update Tiled Index Data…’. 

2. Select the Index Theme in the list that was created in Step 3 and 
click OK. 

The system will make a list of data files that are physically present, and 
then update the index theme accordingly.  Tiles that are physically 
present will be assigned a value of Y for the PRESENT column. 

12.4.4.  Entering Metadata 

The metadata used in the Data Warehouse cannot be entered using 
Navigator Admin.  You must manually insert records into the 
NAV_METADATA table using SQL. 

Note: At the current release, there are still some problems with the 
display of metadata in the Data Warehouse window.  You may 
want to experiment with attaching metadata to libraries, datasets, 
layers, and themes before you go to all the work of entering 
metadata for the entire Data Warehouse. 

The following table describes the NAV_METADATA table: 

Column Description 

ID 
(N 7,0) 

The ID of the library, dataset, layer, or theme that the 
metaData are for. 

Data_Type  
(C 20) 

Indicates which entity the ID is related to.  Must be one 
of the following: 

LIBRARY 

Step 5: Define Tiles that 
are Physically Present 
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Column Description 

DATASET 

LAYER 

THEME 

Dataset_Desc  
(C 250) 

A general description of the data. 

Revision_Date  
(C 60) 

The date of the most recent additions or alterations to 
the data. 

Base_Map  
(C 200) 

The name or type of base map used for initial data 
collection.  Base maps may be any surface 
representation used as a foundation for thematic data 
(e.g. topographic maps, planimetric maps, orthophoto 
maps, digital orthophotos, rectified photo-mosaics). 

Collection_Date  
(C 60) 

The specific time, day, month, year, etc. for data that 
was not collected over a span of time.  Ranges of dates 
should be identified by the earliest and most recent 
dates for data that was collected over a period of time. 

Methodology  
(C 300) 

The methodology that was used to collect the data (e.g. 
digitizing, vectorization, etc.). 

Data_Sources  
(C 300) 

The primary data source.  Data taken directly from 
measuring mechanisms (e.g. remote sensing Data are 
typically obtained from satellite-based observations, 
aerial photographs, airborne electromagnetic surveys, 
etc.).   This may be raw sensor data in digital form, 
enhanced sensor data in digital form, enhanced sensor 
data in combination with map data in digital form, 
interpretations of digital or hard copy images by either 
image analysis or human inspection, or both, to yield 
thematic data.  Conventional photography may be in 
black and white or colour, infrared, or other categories.  
Field measurements refer to data resulting from 
measurement of phenomena made by field surveys such 
as wildlife counts, survey measurements, gravity 
observations, timber cruising, weather station 
observations, topographic surveys, hydrographic 
measurements, etc. 

Secondary_Data_Sources (C 
300) 

Data obtained from second-hand sources, such as maps, 
reports, and other documents. 

Coverage_Desc  
(C 300) 

A general description of the geographic area covered by 
the data. 

Que_Scientific_Content (C 
300) 

The person to whom questions about the scientific 
content of the data should be addressed. 

Maintenance_Agency  
(C 300) 

The details of the agency that is responsible for 
maintaining the data. 

Scale  
(C 300) 

The scale or resolution at which the information was 
collected.  This information provides some indication 
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Column Description 

of the accuracy of the data and the degree of 
generalization. 

Data_Structure  
(C 300) 

The way in which data elements are arranged within the 
data (e.g. vector, raster, topological, etc.). 

Update_Frequency  
(C 300) 

Indicates whether updates are ongoing, carried out at 
regular intervals (e.g. once a year), or carried out 
irregularly. 

Absolute_Accuracy  
(C 300) 

The estimate of error in the location of features in the 
data with respect to published geodetic control survey 
station coordinates or elevations for a specific geodetic 
datum.  Expressed as a plus-or-minus error (standard 
deviation) of the feature location. 

Vertical_Accuracy  
(C 300) 

Same as Absolute_Accuracy, except with respect to 
elevation (Z) instead of planar (XY). 

Data_Quality  
(C 300) 

If quality studies have been carried out, or if there is 
regular evaluation of the data, reference is made to the 
relevant reports.  Comments about the quality will 
provide a guideline to the value of the data for future 
use. 

 

 

12.5.  Define Legends 
 

When themes are initially defined to Navigator, they have no legend.  
Each time they are added to the view, they will be assigned a random 
colored legend.  This tends to confuse new users, so legends should be 
defined for most, if not all, of the themes.  The intent is not to make the 
legends perfect, but rather to create a consistent environment that users 
can get familiar with.  Once the users get familiar with the system, they 
can adjust the legends to suit their own requirements and preferences. 

It is also important to define legends for themes that contain more than 
one type of feature.  For example, if you have a contour theme that 
contains various types of contour lines (index, intermediate, depression, 
etc.), you should assign a different color and/or line style to each type of 
contour line.  This will make it easier for the user to interpret the theme 
on the screen. 

 

To define a legend for a theme: 

1. Add the theme to the view using Navigator or Navigator Admin 

2. Use the standard ArcView Legend Editor to adjust the legend 

3. Use the Legend Manager to save the legend as the “default” legend 
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For more information, refer to the on-line help. 

 

12.6.  Data Conversion (Digitizing) 
 

Most often, a small data conversion effort will be required to complete 
the following themes: 

• Managed Areas - the Managed Areas recorded in the BCD 
System that do not have a matching polygon in the existing 
protected areas themes may be digitized. 

• Sites - Sites recorded in the BCD System that do not have a 
matching polygon in the existing Sites theme may be digitized. 

• EO Lines & Polygons - EOs that are represented more 
accurately by a line or polygon (instead of a point), have to be 
digitized.  Specialists may have to hand draw the EO line or 
polygon on the paper map before they can be digitized. 

• Others - themes that are considered essential, but are not 
available, may have to be digitized, depending on the complexity 
of the themes. 

The data conversion can be done in a number of ways, including: 

• Heads up digitizing within Biotics (optionally, you could scan 
and georeference the paper source maps, and trace over the lines 
on the screen, rather than just “free-handing” it). 

• Table digitizing within Biotics. 

• Digitizing using other software, such as "raw" ArcView, ArcInfo 
or AutoCAD.  If you choose this option, make sure you type in 
the MACODE, SITECODE, or EOCODE for each shape in the 
attribute table as you digitize it. 

Data conversion can be done during the installation/configuration phase, 
or after Biotics is completely operational.  It is strongly recommended 
that you do as much of the conversion work in advance (that is, during, 
or even before installation/configuration).  This makes everything, such 
as the Quality Assurance process, go much more smoothly. 

The data conversion can be done by the users.  However, if there is a 
significant amount of work involved, it is probably better to contract the 
work out, to ensure that it gets done as soon as possible. 
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13.  DEFINING INDEX THEMES 

Index themes are used to set the “work area” in Biotics Mapper.  The 
work area is used to access tiled themes.  When the user’s Index Style 
preference is 'Put index map in a separate index view' or 'Put index map 
in active view', the work area will be drawn from the assigned index 
theme.  When the user’s Index Style preference is ‘Use extents of active 
view’ (which is the default), the index theme does not apply.  However, 
one index theme must always be defined for users to access the 
Preferences window. 

To establish a work area, the index theme is added to the user's view (if 
their Index Style preference is ‘Active View’ or ‘Index View’). The user 
then uses the “Set Work Area” tool to select polygons in this theme. The 
selected polygons are used to select the appropriate tiles to open, based 
on the tiled theme's index theme. 

Note: Do not confuse this type of Index Theme with a "Tile Index 
Theme" - the two are different. 

• The index theme used to set the work area does not have any 
relationship with physical data files.  For example, a county 
boundary theme could be used as an index theme.  A user 
then selects certain polygons (in this case, counties), for 
which the system adds the appropriate layers. 

• On the other hand, Tile Index Themes contain polygons that 
represent the physical boundaries of individual data files.  
Typically this is a map sheet grid.  The tile index theme is 
consulted whenever a tiled theme is added to the view to 
determine which data files need to be opened.  See section 
12.4.3 for more information on Tile Index Themes. 

The index theme is used to select polygons in the Tile Index 
Themes.  For example, you might have topographic data, tiled 
by 1:24,000 map sheets.  A Tile Index Theme, containing the 
1:24,000 map sheet polygons is required to access the individual 
themes.  Your index theme might be counties.  When you set the 
work area, you are actually selecting counties.  When one of the 
topographic themes is added to the view, Navigator selects all 
the 1:24,000 map sheet polygons that intersect the counties that 
are currently selected. 

In Biotics, the index theme is typically set to a Quad or County theme. 

 

 

To define an index theme in Biotics Mapper: 

1. From the Admin menu, choose "Maintain Index Maps." 

Overview 

To define index themes 
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2. Click “New.” 

3. Select a theme (e.g. Quads or Counties) from the list and click 
OK. 

4. Select any column as the Key Column (it doesn’t really matter). 

5. Select any column as the Description Column (it doesn’t really 
matter). 

6. Click Close. 

The Index Themes that you define using the “Maintain Index Maps” 
function will display in the Theme list on the INDEX MAP tab in the 
Preferences window. 

 

 

If the users plan to use the 'Index View' index style, you should create a 
scene called "Index View" in a public catalog using Navigator (Save As 
Scene).  This scene will be loaded into the "Index View (Navigator)" 
view document when the user selects 'Navigator Index View' from the 
view menu.  Users can eventually create their own Index View scene, in 
a private catalog, if they want a different Index View scene than the one 
you create. 

 

Index View 
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14.  CONFIGURING ZOOM BY 

 

Navigation in Mapper can be made easier by configuring and using the 
Zoom By function.  This function allows the user to zoom to a particular 
geographic area simply by making a selection from a list, or typing in 
some search criteria. 

Themes to be used in Zoom By must have attribute information attached 
to the graphics.   

Examples of themes that can be made available to the zoom by function 
are: 

• a gazetteer layer (point locations) 

• a map sheet grid (e.g. 1:24,000 quads or 1:50,000 NTS maps) 

• a county map 

• a watershed map 

• an ecoregions map 

Generally, only themes that contain uniquely named features are used in 
the Zoom By function.  For example, if a streams layer with many 
segments is configured to Zoom By, there could be hundreds of 
matching segments for any one Stream name value that the user picks 
from the list. 

 

Themes can be set up in Zoom By to display a list of values from a given 
attribute; to search on a single attribute in a theme; to search on multiple 
attributes in a theme; or to search on an indexed attribute. 

 

 

To make a theme available in the Zoom By function: 

1. From the Admin menu, choose "Configure Zoom By…". 

2. Click New 

3. Type in a Description. 

Tip: Some themes that are defined in Zoom By require the 
user to type in a search string in a specific format, so 
that the search string matches the format of the data in 
the theme’s attributes. To help users know what format 
they need to type in, include the format or a sample 
value in the name of the Zoom By Entry.  This will 
show up on the title bar of the window. 

Overview 

To make a theme 
available in Zoom By 
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For example, consider a Zoom By entry based on 
TownshipRange - Section.  The user must type in a 
search string in the form “016N011W - 32” to find a 
match.  Spaces, leading zeroes, and hyphens in this 
example are critical. 

If you include a sample value in the Description, the 
Zoom By window will appear as follows: 

 

4. Choose the theme from the Theme Name list. 

5. Select one or more Search Fields. 

Tip: For themes which contain features with duplicated 
names, it often helps to include more than 1 field from 
the theme’s attribute table.  The user can then search on 
more than one field.  Even if the user won’t search on 
the additional fields, the additional fields can sometimes 
help narrow down the selection when multiple matches 
are found. 

For example, in a gazetteer layer, the Zoom By 
definition could include the Feature Type.  A search for 
the place “Cross Lake” could return several records, but 
the feature type could help determine which record is 
the desired one. 

 

6. Set the Search Method.  The Search Method used for each Zoom 
By entry can be chosen based on the number of records 
available: 

• SEARCH – use this when the theme contains a lot of records 
(e.g. > 1,000).  The user types in a search string to be 
matched against the attribute(s) in the theme. 
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• LIST – use this when the theme contains a few records (e.g. 
< 100).  The user is presented with a list of attributes, and 
chooses one to zoom to. 

• <NOT SET> - use this when the theme contains a moderate 
number of records (e.g. 100 – 1000).  The user will be given 
the choice of searching or picking from a list. 

7. Click OK. 

8. If the theme is tiled, click Update Index (see Tiled Themes 
below for more information). 

9. Click Close. 

 

If the theme being searched is moderately large (e.g. 25,000 – 50,000 
records), consider splitting the theme up into many themes to improve 
performance: 

 

 

 

 

 

 

 

 

 

 

 

Include the original, undivided theme in case the user wants to search 
every record. 

 

If the theme being searched is massive (e.g. 500,000 records), but not 
tiled, searches will be slow.  To improve performance, define the theme 
as a tiled theme containing only 1 tile. The theme can then be indexed in 
Oracle, and searches will be nearly instantaneous: 

1. Create a new polygon theme using Navigator Admin (New Theme 
button—for more information see Section 12.4, “Define Data to 
Navigator”). 

2. Add the new theme to your view, start editing it, and digitize a large 
rectangle covering the entire province or state. 

Performance 
Tuning 

Slow 

Fast 
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3. Add TILENAME (char 8) and PRESENT (char 1) fields to the 
theme’s attribute table.  Set the value of tilename to the name of the 
folder containing the massive theme, and set present to “Y”.  For 
instance, if the large theme is located at K:\Data\Statewide\trs.shp, 
the tilename column should read “Statewide”. 

4. Stop editing the theme. 

5. Redefine the massive theme in Navigator Admin using the Add 
Theme function, this time as a tiled theme, whose index is the theme 
you created in step 1.  For more information see Section 12.4.3 

6. Define a new Zoom By entry based on the massive theme. 

 

To maximize performance when zooming by a tiled theme, make sure 
users have their “Select Features” preference turned off: 

 

 

 

Tiled themes can be used with Zoom By.  They should be indexed for 
effective searching.  The indexing procedure stores the coordinates of 
every shape in Oracle (in the Zoom_by_index table), and makes searches 
extremely fast. 

After you create the Zoom By entry, click on the Update Index button.  
The choose one of the following options: 

• CENTROID – calculates and stores the coordinate of the centroid of 
the feature.  When the zoom is performed, it will behave the same as 

Tiled Themes 
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zooming by a point (even though you may be zooming on a polygon 
theme).  The zoom extent will be applied (from Preferences).  Use 
this option if the users want to zoom to the vicinity of the feature, 
not to the extent of the feature. 

• EXTENT – calculates and stores the coordinates of a bounding box 
that encompasses the feature.  Use this option if the users want to 
zoom to the extent of the feature. 

Indexing large themes can take a long time.  You can drastically reduce 
the amount of time it takes to build the index by temporarily dropping 
the index on the table using SQL*Plus before you click on the Update 
Index button: 

DROP INDEX I_ZOOM_BY_INDEX_THEME_ID; 

After the indexing process is complete, re-create the index: 

CREATE INDEX I_ZOOM_BY_INDEX_THEME_ID ON 

ZOOM_BY_INDEX (THEME_ID, SRCH_FIELD_VALUE); 

Note that you may have to index a massive tiled theme in batches (e.g. 
20 tiles at a time) to avoid errors. 

 

 

You can set the default Zoom By preferences for all users (or only new 
users) using SQL*Plus.  For example, to set the ‘View Extents’ 
preference you would type: 

• For ALL users: 

UPDATE PREFERENCES SET VALUE = '15000' WHERE 

KEY = 'ZOOM_PORTAL_SIZE'; 

• For NEW users: 

UPDATE PREFERENCES SET VALUE = '15000' WHERE 

KEY = 'ZOOM_PORTAL_SIZE' AND USER_ID = 

'$DEFAULT'; 

 

Default Zoom By 
Preference 
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15.  MODIFYING INPUT/EDIT SCENES 

In Biotics Mapper, themes can be grouped into Scenes, which can be 
created and added in Navigator.  The order in which the themes are 
drawn, the legends associated with the themes, and even the scale can be 
saved in a Scene and added when a specific group of themes is desired.   

There are certain system Scenes which are used during the Input/Edit 
sessions in Mapper.  Whenever a user enters Input/Edit mode, a Scene is 
loaded into the view, containing the theme(s) to be edited, and a limited 
number of other layers for reference.  The scene loaded depends on what 
the user selects (Element Occurrences, Managed Areas, or Sites).  For 
example, the scene loaded when the user selects Managed Areas might 
contain: 

• the Managed Area theme 

• jurisdictional boundary themes (e.g. counties) 

• land ownership themes 

• road themes 

Biotics comes with one standard scene that is used for all three types of 
features (element occurrences, managed areas, and sites).  This scene 
contains: 

• EO Source Points 

• EO Source Lines 

• EO Source Polygons 

• EO Reps (Polygons) 

• Managed Area Polygons 

• Site Polygons 

You can modify the contents of this scene, and/or you can create new 
(separate) scenes that are specific to the three types of features (Element 
Occurrences, Managed Areas, and Sites). 

 

Here are some general guidelines that you should follow when 
modifying the Input/Edit scenes: 

• Keep scenes as minimal as possible (use only the necessary layers). 

• Scenes should contain themes that are of interest to all users all the 
time.  Additional scenes can be created that contain themes that are 
used some of the time, or are of interest to only some users.  These 
scenes can be accessed in an ad-hoc manner using Navigator.  In 

Overview 

Input/Edit Scene 
Guidelines 
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addition, users can always add other themes as usual with Navigator 
once inside Input/Edit. 

• Always overwrite an existing scene instead of deleting and re-
creating it (because scenes are referenced in Designer Admin). 

• Don’t include the EO Point Reps theme in the input/edit scene—it is 
slow and not critical to see while creating and editing data. 

• Make sure every theme on the palette is included in the scene.  For 
example, the scene for the EO palette must include Source Points, 
Source Lines, Source Polygons, and EO Reps (Polygons). 

• By default, the input/edit scene will always replace (rather than add 
to) the current themes in the view.  This can prove annoying in some 
cases.  Users can change their “Load Scene” preference if they wish 
(available on the Designer tab in the Preferences window).  Or, you 
can change the setting for all users at once using SQL*Plus: 

UPDATE preferences SET value = ‘ADD’ 

WHERE key = ‘DESIGNER_LOAD_SCENE’; 

 

1. Logon to Biotics Mapper as “mgr” (since this is the user that owns 
the scenes, and only the owner can change the scene). 

2. Open Navigator, choose the Scenes tab, select the scene to be 
modified in the tree view, and click OK.  This will load the scene 
into the view. 

3. Open Navigator, choose the Themes tab, and add/remove themes as 
desired.  Take care to ensure that the themes are in a logical order.  
Click OK to preview the scene. 

4. Open Navigator again, make any final changes that are required, and 
then click on the Save As Scene button. 

5. Choose the “Biotics – Input/Edit” catalog from the drop-down list. 

6. Choose the scene that you are modifying from the scene drop-down 
list. 

7. Click OK.  The existing scene will be overwritten with the new 
scene.  

8. Click OK or CANCEL to close Navigator. 

Note: Always overwrite an existing scene, instead of deleting the 
scene and creating a new one.  Scene IDs are referenced in 
Designer Admin.  Overwriting a scene preserves the scene ID, 
whereas deleting a scene and recreating will result in a new 
scene ID. 

 

To Modify an Existing 
Scene 
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1. Logon to Biotics Mapper as “mgr” (since this is the user that owns 
the catalog that the new scene will be created in). 

2. Open Navigator, choose the Themes tab, and add/remove themes as 
desired.  Take care to ensure that the themes are in a logical order.  
Click OK to preview the scene. 

3. Open Navigator again, make any final changes that are required, and 
then click on the Save As Scene button. 

4. Choose the “Biotics – Input/Edit” catalog from the drop-down list. 

5. Type in a name for the scene. 

6. Click OK.  The new scene has now been created. 

7. Click OK or CANCEL to close Navigator. 

8. Start Designer Admin (available on the Admin menu in long menus). 

9. In the “palettes” section of the dialog, select the row that you want 
to associate the scene with. 

10. In the “palettes” section of the dialog, click on the Edit button.  The 
“Edit Palette” dialog displays. 

11. In the Edit Palette dialog, click on the Select button, choose the new 
scene from the drop-down list, and then click OK. 

12. Click OK on the Edit Palette dialog to save the changes and return to 
the main Designer Admin dialog. 

13. Click Close to leave Designer Admin. 

 

 

To Create a New 
Input/Edit Scene 
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16. DEFINING SPATIAL ATTRIBUTES 

16.1.  Introduction to Spatial Attributes in Biotics 4 
 

Spatial Attributes are an integral part of Biotics Mapper, which take 
advantage of the power of GIS to determine locational properties of 
Heritage data.  Whenever an Element Occurrence, Managed Area, or 
Site shape is created or altered, numerous attributes are automatically 
determined by doing a geographic overlay of the new shape with defined 
theme layers. 

For the core spatial attributes which have standard fields in Tracker, the 
system will pass the calculated values from Mapper to Tracker.  Thus a 
new Element Occurrence created in Mapper will start out in Tracker 
with its Locator values (County, Mapsheet, TRS, Watershed, etc.) 
already populated. 

In order for a theme to be eligible as a source of spatial attributes, it must 
be properly defined in Navigator (see Section 12.4). 

 

Mapper calculates a number of basic spatial attributes for EO 
Representation, Managed Area and Site Polygons.  These attributes 
should not be removed from Designer. 

The basic spatial attributes included with Mapper are:   

Element Occurrences: 

• Acreage  

• Centroid1 

• Hectares  

• MA_Code  

• PARENT_EO_ID2  

• Site_Code  

Managed Areas: 

• Acreage 

• Centroid 

                                                 
1 The "Centroid" spatial attribute is a keyword, that results in the calculation of the 
following spatial attributes: 

• LATITUDE_DD 

• LONGITUDE_DD 

• LATITUDE_DMS 

• LONGITUDE_DMS 

• UTM_NORTHING 

• UTM_EASTING 

• UTM_ZONE 

 

2 "Parent_EO_ID" is used to determine when an EO is a "sub-EO" 

Overview 

Basic Spatial 
Attributes 
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• Hectares 

• MA_Code  

• Site_Code 

Sites: 

• Acreage 

• Centroid 

• Hectares 

• MA_Code 

• Site_Code 

 

Core spatial attributes must be defined to Navigator with standard names 
in order for the stored procedures to properly copy values from the 
spatial_attribute table to the business tables (i.e. eo_county, 
site_watershed, etc.).   

Core spatial attributes include:  
 
Element Occurrences: 

• County 

• Mapsheet 

• Watershed 

• Local_Jurisdiction 

• Town_Range_Section 

• Physiographic_Province 

• Managed_Area 

• Site 

• Min_Elev_Feet 

• Max_Elev_Feet 

• Min_Elev_Meters 

• Max_Elev_Meters 
 
Managed Areas: 

• County 

• Mapsheet 

• Town_Range_Section 

• Managed_Area 

• Major_MA 

• Site 

• Min_Elev_Feet 

• Max_Elev_Feet 

• Min_Elev_Meters 

• Max_Elev_Meters 
 
Sites: 

• County 

Core Spatial 
Attributes 
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• Mapsheet 

• Local_Jurisdiction 

• Town_Range_Section 

• Watershed 
 

Here are some general guidelines that you should follow when defining 
spatial attributes: 

• When calculating core spatial attributes, the system uses the ID 
value of the domain table to insert the attribute in the business table 
so that it can be displayed in the Tracker detail window.  Core 
attributes should be defined exactly as they appear in the above lists 
with multiple fields, with the domain ID value first and another field 
second.  Note that the second field is optional and only for 
descriptive purposes.  For instance, for a County attribute, you could 
define the attribute to return D_COUNTY_ID + CountyName. 

• Do not edit or remove any of the standard spatial attributes.  
Many of these are required by the system (e.g. to calculate 
parent/sub-EO relationships).  Some of the names are also pre-
defined (e.g. MA_Code and Site_Code), and renaming them will 
cause the system to malfunction. 

• Normally all spatial attributes for EOs are calculated based on the 
EO Reps (Polygons), not the Source Features.  By default, Source 
Features have only basic spatial attributes (AREA and LENGTH).  
Additional spatial attributes can be defined for Source Features, but 
will not be inserted into Tracker fields. 

• Not all geographic relationships need to be calculated as spatial 
attributes; standard ArcView spatial functions such as Select By 
Theme can be used to determine spatial relationships for other 
attributes of interest (e.g. soil type) in an ad-hoc manner.   

• For maximum performance, index the SHAPE field of all themes 
that are used as the source of spatial attributes: 

1. Open the theme attribute table for the source theme, 

2. Select the SHAPE field column heading, 

3. Select Create Index from the Field menu. 

• Changes made to spatial attribute definitions are not automatically 
propagated to existing data records.  If you add a new attribute, or 
change the definition of an existing attribute, you must use the 
Recalculate Spatial Attributes function (available on the Admin 
menu when you are in Input/Edit mode) to explicitly (re)calculate 
the spatial attribute for all existing features.  If you delete an 
attribute, you should use SQL*Plus to remove it from all existing 
features as follows: 

Guidelines for 
Defining Additional 
Spatial Attributes 
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DELETE FROM SPATIAL_ATTRIBUTE WHERE 

ATTRIBUTE_NAME = '<deleted attribute name>'; 

COMMIT; 

 

If the Member Program files their EO Records in the Manual Files by 
Central Quad, an attribute can be configured in Mapper to calculate the 
quad that the centroid of the Rep Polygon falls in. 

Because this spatial attribute will become an index to a filing system, it 
should not be recalculated when EOs are changed.  Therefore, users 
must manually uncheck the “Recalculate When Shape Edited” checkbox 
beside the attribute in the Spatial Attribute tab whenever a new EO is 
created (this can also be done in batch using SQL). 

This solution can be implemented using the IsCenterContainedIn 

spatial comparison. 

 

16.2.  Defining Spatial Attributes 
 

To configure spatial attributes, use Designer Admin, which is available 
on the Admin menu.  Use Designer Admin to: 

• Define a new spatial attribute to be calculated 

• Remove a spatial attribute (so that it is no longer calculated) 

• Change the source and/or definition of a spatial attribute (for 
example, specify a different theme or field within the theme that 
is to be used as the source of the spatial attribute). 

 

The basic steps to access the spatial attribute definitions (so you can 
define, remove, or change them) are as follows: 

 

1. From the Admin menu, choose Designer Admin.  The following 
dialog will display:  

Central Quad 
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2. Select the appropriate palette in the “Palettes” section of the dialog 
(e.g. Element Occurrences in the example above).  The contents of 
the palette will display in the lower window. 

3. Select the appropriate feature in the “Palette Contents” section of the 
dialog (e.g. EO Representation in the example above). 

4. Click the Edit button in the Palette Contents section of the dialog. 
The following dialog will display: 

 

5. On the Edit Palette Contents dialog, click the New/Edit button. The 
Feature Details dialog will display: 
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Note: If you receive a segmentation violation at this point, remove 
all themes from your view and try again. 

Existing Spatial attribute definitions for the feature are listed in the 
Spatial Attributes section of the dialog.  You can now create, edit, or 
delete spatial attribute definitions using the buttons to the right of 
the list.  Edit and Delete require you to select a spatial attribute in 
the listbox before clicking the button. 

 

6. When you click New or Edit in the Spatial Attributes section of the 
dialog, the Spatial Attribute details dialog will display: 
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7. Complete the Spatial Attribute details dialog (see the information 
below for complete details on each property on the dialog). When 
you are finished, click OK.  The new or updated spatial attribute will 
display in the list on the Feature Details dialog. 

8. When you are finished defining spatial attributes, click OK or Close 
on all the open dialogs until you are out of Designer Admin. 

  

16.3.  Using the Spatial Attribute Window 
 
The various fields and options in the spatial attribute window are 
explained below. 
 

• Maximum 30 characters 

• No spaces 

• Will appear to the user in the Spatial Attributes tab, so: 

� Make the name descriptive 

� Use “proper case” or “title case” (i.e. not all upper case and not 
all lower case) 

� Use underscores to improve readability (e.g. 
Town_Range_Section, TNC_Ecoregion) 

Attribute Name 
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• A source theme is the theme that contains the spatial attributes (e.g. 
the theme containing the watershed polygons). 

• Must be defined to Navigator (see Section 12.4). 

• Can be tiled or non-tiled. 

• Must be a feature theme (images and grids are not supported). 

• Make sure you create a spatial index on the SHAPE field in the 
source theme to maximize performance (add the theme to the view, 
open the attribute table, make the SHAPE field active, and choose 
Create Index from the FIELD menu). 

 

• The field(s) in the source theme that contain the spatial attribute 
value (e.g. Huc in the watershed theme).  A single field, or multiple 
fields, can be used as the attribute value. 

• To specify a single field, choose it from the dropdown menu at 
“Single.” 

• To specify multiple fields, click the “…” button to choose the fields 
from those available in the chosen theme.  The fields will be listed in 
the order in which you choose them, and each field is separated from 
the next by a dash (“-“).  

• If you wish to define a spatial attribute that is a combination of 
values from two or more themes, use ArcInfo to merge the themes 
together (using the “union” command), and then specify the 
resulting coverage as the source theme. 

 

 

Spatial 
Comparison 

Definition Example 

Intersect Report the features in the 
source theme that the newly 
digitized feature touches 
(overlaps or adjacent).  If 
you do not want adjacent 
features included, use 
IsWithin - see Eliminating 
Adjacent Values note below. 

Find all the Rural 
Municipalities that the 
newly digitized road 
feature passes through. 

IsWithin Report the features in the 
source theme that are within 
the specified distance from 
the newly digitized feature. 

Find all wells that are 
within 100 meters of the 
newly digitized road. 

Contains Report the features in the 
source theme that are 

Find all of the wells that 
are completely contained 

Source Theme 

Source Fields 

Spatial Comparison 
Definitions 
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Spatial 
Comparison 

Definition Example 

completely contained within 
the newly digitized feature. 

within the newly digitized 
plot of land. 

ContainsCenter Report the features in the 
source theme that have their 
center point within the 
newly digitized feature. 

Find all of the sub-
division lots whose center 
point is inside the newly 
digitized school district 
polygon. 

IsContainedIn Report the features in the 
source theme that the newly 
digitized feature is 
completely contained 
within. 

Find the name of the Park 
that the newly digitized 
owl habitat polygon is 
completely within. 

IsCenter 
ContainedIn 

Report the feature in the 
source theme that the center 
of the newly digitized 
feature falls in. 

Find the quarter section 
that the center of the 
newly digitized watershed 
falls in.  

Mostly Within 
 

Report the feature in the 
source theme that contains 
the majority of the newly 
digitized features. 

Find the name of the 
Rural Municipality which 
contains most of the 
newly digitized owl 
habitat polygon. 

Dominant Report the source field value 
that contains the majority of 
the newly digitized features.  
Area is used to determine 
majority. 

Find the dominant tree 
species in a cut block 
considering there are 
many intersecting 
polygons of the same tree 
species. 

 

Eliminating Adjacent Values 

Occasionally you may copy and paste a shape from a theme that is a 
source of spatial attributes into one of the Biotics themes.  For example, 
you may copy and paste a Section to form an EO, and the Section theme 
is a source of spatial attributes (Town_Range_Section). 

If an Intersect spatial comparison is used, all of the surrounding 
(adjacent) sections will be included as spatial attribute values for the 
shape (e.g. EO), which usually is not desirable (since the shape does not 
overlap with the surrounding sections – it is only adjacent to them). 

There are two possible solutions to this problem: 

1. Users can manually delete the spatial attribute values in the EO 
window after the EO has been created.  However this is time 
consuming and also makes subsequent modifications to the EO 
problematic (since TownRange will not be updated when the 
shape is edited). 

2. Use the IsWithin spatial comparison instead of Intersect, with a 
small negative distance (e.g. –1). This will calculate spatial 
attributes of all features within (i.e. inside) the bounds of the 
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polygon (in this example, the Section polygon).  Note that you 
may have to experiment with the distance, as occasionally very 
small distances do not provide correct results (a quirk of 
ArcView).  For example, you might have to increase the distance 
to –10 before it will work properly. 

 

• Normally Operand is ‘None’. 

• One example where it might be set is to calculate Minimum and 
Maximum Elevation - which would be two separate spatial attributes 
based on the same source theme (e.g. a DEM) and with the same 
source fields (e.g. Z), but with different Operands. 

 

 

This indicates where the calculated value will be saved.  Always: 

• Check SQL Database 

• Do not check Shapefile 

 

• Always leave Recalc Set, and Evaluation Order blank. 

• Do not check Calc Intersect Amount. 

• Normally you should leave Mandatory unchecked.  When 
unchecked, the calculation of this attribute can be deferred (i.e. if the 
user has the ‘Defer Calculation of Spatial Attributes’ checkbox 
checked on the Edit/Finish/Cancel dialog, they will not have to wait 
while this attribute is calculated).  If you want this attribute 
calculated right away (e.g. because you want the user to review and 
possibly edit the calculated values at the time the feature is created), 
then check the Mandatory checkbox. 

• The script box will always be empty, except when setting up a 
centriod calculation. For representations it will be set to 
LGI.BioticsGetSelectedSourcesAndEORepEdited  
for Source Features, Sites and MA’s it will be set to 
LGI.BioticsCalcCoordinates 

  

Operand 

Save Value To 

Options 
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17.  MODIFYING DATABASE VIEWS 

Very little data are stored in the Biotics shapefiles other than the shape 
itself; the majority of the data are stored in the SQL database.  To 
facilitate functions such as thematic mapping and labelling, data from 
the SQL database must be joined to the shapefiles. 

Typically, the data joined to a shapefile comes from more than one table 
in the SQL database.  For performance reasons, all the SQL tables are 
combined into a single view in the database, and the view is joined to the 
shapefile.  This results in a single join within ArcView instead of 
multiple joins. 

Three different types of views are created when Biotics is installed: 

• Standard Views 

• Full Views 

• Other Views 

 

Standard Views are joined to the shapefiles by default.  That is, these are 
the views that are defined as “Theme Data” in Navigator Admin.  These 
views are joined when the shapefiles are first added to the view, and 
whenever the user chooses the “Re-establish standard Oracle attributes” 
option in the “Add/Remove Oracle Attributes” dialog. 

The names of the standard views are as follows: 

• SOURCE_VIEW_STD_ATT –  joined to the EO Source Point, 
EO Source Line, and EO Source Polygon themes. 

• EO_VIEW_STD_ATT - joined to the EO Reps (Polygons) 
theme. 

• EO_REF_PT_VIEW_STD_ATT – source of the "EO Point Reps 
- Std Attributes" theme. 

• MANAGED_AREA_VIEW – joined to the Managed Area 
Polygon theme.  Since the MA table has very few attributes, this 
view also doubles as a Full View (see below). 

• SITE_VIEW – joined to the Site Polygon theme. Since the Site 
table has very few attributes, this view also doubles as a Full 
View (see below). 

These views contain only essential attributes to ensure maximum 
performance.  You should only modify these views if it is absolutely 
critical that an additional attribute must be joined to the shapefile at all 
times.  If the attribute is not critical, add it to the Full View instead. 

 

Standard Views 
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Full Views are views that contain all possible attributes.  These are 
intended to be joined to the shapefiles on an as-needed basis using the 
Add/Remove Oracle Attributes function.  Typically this is done to 
perform a specific task, and then the Standard View is re-established to 
maintain performance (since these views contain all possible attributes, 
they tend to be very slow). 

The names of the full views are as follows: 

• SOURCE_VIEW_ALL_ATT –  joined to the EO Source Point, 
EO Source Line, and EO Source Polygon themes. 

• EO_VIEW_ALL_ATT – joined to the EO Reps (Polygons) 
theme.  By default, this view is also the source of the "EO Point 
Reps - All Attributes" theme.  If desired, a separate view can be 
created for this theme (suggested name 
EO_REF_PT_VIEW_ALL_ATT), and the definition of the 
theme changed in NavAdmin. 

• MANAGED_AREA_VIEW – joined to the Managed Area 
Polygon theme.  Since the MA table has very few attributes, this 
view also doubles as a Standard View (see above). 

• SITE_VIEW – joined to the Site Polygon theme. Since the Site 
table has very few attributes, this view also doubles as a 
Standard View (see above). 

Full Views can be modified to suit each installation’s requirements.   

 

In order to minimize the code changes necessary to the Mapper 
application to integrate it with Tracker, several other views were created 
that would allow Mapper to access tables that had been renamed in 
Tracker, but still use the original name.  These views and the tables they 
reference are listed below: 

• ELEMENT_OCCURRENCE references EO table 

• MANAGED_AREA references MA table 

• SITE references CONSERVATION_SITE table 

• FEATURE references SHAPE table 

• SOURCE references SOURCE_FEATURE table 

• ELEMENT_OCCURRENCE_SOURCE references 
EO_SOURCE_FEATURE table 

• D_CONC_FEAT_SPAT_UNCERTAINTY references 
D_CONC_FEAT_LOC_UNCERT table 

• D_CONCEPTUAL_FEATURE_TYPE references 
D_CONC_FEATURE_TYPE table 

Full Views 

Other Views 
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• D_DISTANCE_CLASS references 
D_LOC_UNCERT_DIST_CLASS table 

• D_SPATIAL_UNCERTAINTY_TYPE references 
D_LOC_UNCERTAINTY_TYPE table 

• D_UNIT_OF_MEASURE references D_UNIT table 

• BCD_ET references ELEMENT_GLOBAL, 
ELEMENT_SUBNATIONAL, and SCIENTIFIC_NAME tables 

• BCD_EOR references EO table 

These views have been constructed to allow the Mapper application to 
work using the same tables and column names as in Biotics 3.1.  
Because of this, any modification of these views may cause Mapper to 
fail.  Deleting and renaming any columns from these views will 
definitely cause problems in Mapper.  Adding columns can be done, but 
should be tested thoroughly in Mapper before implementing.  Please 
consult with the Biotics Help Desk before attempting to modify any 
views. 
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18. CREATING THE MANAGED AREA 

AND SITE THEMES 

In most provinces and states, there will be existing themes showing 
protected areas (parks, reserves, wildlife management areas, etc.) and or 
conservation sites.  These themes will have been discovered during the 
data integration phase of the configuration. 

Creating the Managed Area or Site theme is broken down into three 
steps: 

• Preparing polygons 

• Joining polygons to attribute data from Tracker  

• Load MA/Sites into the managed theme in Mapper 

Once the Managed Area or Site theme is configured, Biotics will 
accommodate data entry origination of Managed Area and Site records 
from both the Mapper and Tracker interfaces. 

 

18.1.  Prepare Managed Area or Site Polygons 
 

The goal of this step is to combine all of the polygons from the existing 
protected area or conservation site themes into a single shapefile.  This 
shapefile will then be matched to the tabular data, and eventually loaded 
into the Biotics Managed Area theme (ma.shp) or Biotics Site theme  
(site.shp). 

To prepare the polygons: 

1. Make the attribute table structure identical for all of the protected 
area /conservation site themes.  That is, make the field names and 
field data types the same.  This can be done using ArcView as 
follows: 

a) Add the protected area/conservation site theme to the view 

b) Make the theme active, and open the attribute table 

c) Choose Properties from the Table menu.  Hide extraneous 
fields.  If necessary, assign aliases to the fields that are to be 
preserved, so that the names of these fields are the same as the 
field names in the other protected area themes. 

d) Return to the view, and choose Convert To Shapefile from the 
Theme menu.  This will create a new shapefile using the current 
table property settings. 
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Note: You can use other software to alter the structure of the 
attribute tables, such as ArcInfo or FoxPro. 

2. Merge the themes into a single shapefile: 

a) Add all the themes to be merged into a view 

b) Make the themes active 

c) Choose Merge Themes from the Edit menu (long menus) 

d) Assign a name and location to the new shapefile (e.g. 
ma_polys.shp). 

Note: The "Geoprocessing Wizard" extension that comes with 
ArcView 3.2 can also be used to merge shapefiles together. 

3. Verify that all the shapes were merged, and that all the attributes 
were maintained, by opening the attribute table for the new shapefile 
and visually examining it. 

Note: Make sure you name the shapefile something other than 
“ma.shp” or “site.shp”, otherwise you will encounter errors 
when you try to link the shapes in later steps. 

4. Make sure that each polygon contains an MA Code or Site Code, as 
appropriate, as this field will be used as the join field in the 
following step. 

 

18.2.  Join Biotics Feature-ids to Polygon Data 
 
The goal of this step is to join the feature-id (shape-id) of the managed 
area or site records from the Biotics Shape table to the polygon shapefile 
from which the Managed Areas or Sites are to be loaded.   
 
1. Open Tracker and choose Tools>Query Builder. 
2. From the Query Builder, choose Query>Mode>Free Form 
3. Type the appropriate select statement below into the Query window: 

Select * from biotics_unmapped_ma_vw  
Select * from biotics_unmapped_site_vw 

4. Click the  button to execute the Query and then the  button to 
view all the records. 

5. Choose Result>Export to File to export to a text file, and in the Save 
to File window: 

a. Fill in a file name 
b. Choose Tab as the delimiter to separate your fields  
c. Check the box to Include Field Names on the first row 

d. Click OK 
6. The text file can be brought directly into ArcView.  From the 

ArcView project window, click the table icon and click the Add 
button, then browse to your new table and click OK. 

Create Text file with 
feature-ids 
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7. Open the attribute tables for both the polygon theme prepared above 
and the table just added to the project, and arrange them so that you 
can see both on the screen. 

8. Highlight the field with the MA Code (or Site Code) in both tables. 
9. With the polygon theme attribute table active, choose Table>Join. 
10. You now have the feature-id field from the Biotics database 

associated with your polygons.  Choose Theme>Convert to 
Shapefile. 

 
Note: Again, make sure you name the shapefile something other than 

“ma.shp” or “site.shp”, otherwise you will encounter errors 
when you try to link the shapes in later steps. 

 

18.3.  Load into the MA or Site Theme 
 

You are now ready to load the MAs or Sites into the managed theme 
(either ma.shp or site.shp) in Biotics Mapper.   

 

Warning:  All user-defined spatial attributes (i.e. all attributes except 
Centroid, Acres and Hectares) should be NOT mandatory when 
configured in Designer Admin.  Confirm this before using the Batch 
Match-link function as described below, otherwise spatial attributes will 
be automatically recalculated using an inefficient process, which may 
not be the desired outcome. 

1. If you do not wish to load all the polygons in the shapefile, then you 
must select the polygons that you do want to load. 

2. Choose Input/Edit from the Biotics menu. 

3. Choose Managed Areas or Sites, as appropriate. 

4. Choose Batch Link Shapes to Data Records from the Admin menu. 

5. At Choice, choose the theme (created in step 18.2) that contains the 
data to be processed from the list and click OK. 

6. At Choice, choose the feature-id field from the list of fields and click 
OK. 

7. At Warning, confirm the number of records to be processed by 
clicking Yes.  If this number does not match the expected number of 
records, click No, and determine the reason for the discrepancy 
before continuing. 

8. Click the Post button to exit Input/Edit mode.   

Note:  You will be asked if you want to calculate deferred attributes.  
ALL non-mandatory attributes will be calculated if you choose to 
calculate deferred attributes at this point.  If you choose YES, all defined 
spatial attributes will be recalculated, and your MA/Site Load is 

Batch Match/Link 
MAs 
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complete.  If you had spatial attributes in your MAs or Sites that were 
converted from BCD that you DO NOT want recalculated, choose NO 
and continue with step 9. 

9. If you do not want to calculate spatial attributes, choose NO at the 
calculate deferred attributes prompt.   

10. Quit out of Mapper. 

11. Enter SQL Plus or SQL Plus Worksheet and execute the following 
statement:  delete from ad_defer_calc_spat_att_loc where user_id = 
‘xxx’;  (where xxx = your login). 

12. Commit your changes. 

 

Note: Mapped By and Mapped Date will retain the values that were 
converted from BCD.  Digital_Mapping_By and 
Digital_Mapping_Date will be left blank.  You will need to 
determine with the program, how these fields should be 
populated.  Recommended options are as follows: 

a. Populate digital mapping fields with data from paper 
mapping fields 

b. Populate digital mapping fields with “mgr” user and date of 
installation 

 

There is currently no functionality to bulk load Managed Area or Site 
records that do not have existing tabular records in Tracker.  If shapes 
exist for new records, they can be created manually using the copy-past 
function.  When the Exchanger tool is released, tabular records may be 
able to be uploaded into Tracker to create the tabular records. 

 

You may choose to recalculate spatial attributes for some or all MAs at 
this point. 

Using Navigator, bring all the non-tiled themes that are the source of 
spatial attributes into the view, and turn them off.  This will improve 
speed, and reduce the likelihood of the NO FREE CHANNELS error.  
Also, open the attribute table for each of these themes and make sure the 
SHAPE field is indexed (make the SHAPE field active, and pull down 
the Field menu; if it says Create Index there is no index – so click on 
Create Index; if it days Remove Index then there is an index). 

1. Make sure your Load Scene preference (available on the Designer 
tab in the Preferences window) is set to ‘Add To View’. 

2. Enter Input/Edit mode.  Select the Managed Areas or Sites palette. 

New Records  

Calculate Spatial 
Attributes 
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3. Use the Add/Remove Oracle Attributes function (available on the 
Biotics menu) to ‘Remove all Oracle attributes’ for all Biotics 
themes.  This will speed up processing considerably. 

4. Select the Managed Area or Site polygons that you want to calculate 
spatial attributes for.  If you want to calculate spatial attributes for 
all polygons, then select all the records in the Managed Area or Site 
Polygons theme. 

5. Choose Recalculate Spatial Attributes from the Admin menu. 

6. Click the Custom radio button. 

7. Click the Select All button (or select the attributes you want to 
calculate). 

8. Click OK. 

Processing will now begin, and may take a very long time (many hours) 
to complete. 

 

18.4.  Quality Assurance 
 

Some data checks were done in earlier steps.  However, after the data 
has been loaded into the MA and Sites themes, there are a few additional 
checks that you should perform: 

1. Check the number of records in the MA theme.  The number of 
records should be the same as the number of records that were 
loaded from the shapefile. 

2. Check the number of records in the Sites theme.  The number of 
records should be the same as the number of records that were 
loaded from the shapefile. 

  
 
 

General Checks 
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19. CREATING THE ELEMENT 

OCCURRENCE THEME 

All of the EO records that exist in the Biotics database must be linked to 
shape features by importing existing features into the EO Source feature 
and EO Reps (Polygons) themes, or by creating point features from 
coordinate values.  This is done in four steps: 

• Convert coordinates 

• Prepare Shapefiles 

• Link Source Features 

• Generate EOs 

 

19.1.  Convert Coordinates 
 

This step is only necessary if the datum of the coordinates needs to be 
changed.  For example, if coordinates brought into Biotics from the BCD 
System are "NAD27", and all reference mapping is "NAD83", then the 
coordinates from the BCD System need to be transformed.   

ArcView cannot be used to do datum transformations.  ArcView uses 
general algorithms instead of country or province/state specific 
coordinate shift files, which can lead to errors of several hundred meters.  
Therefore, some other software program must be used to do the 
conversion, such as ArcInfo, PC ArcInfo (3.5), the Geographic 
Calculator, programs from NGS, etc.   

Tip: It is recommended that an event theme (rather than a coordinate 
file) be used to load EOs that do not have previously digitized source 
features.   

Note:  Some programs have a combination of NAD27 and NAD83 
coordinates in their BCD.  If this is the case, and the distinction can be 
made by a logical query (i.e. certain quads are in NAD27 and others in 
NAD83), then the data can be transformed accordingly.  If the program 
cannot discern the NAD27 from the NAD83 data, then the program 
should tell you how they want their data represented in Biotics. 

 

19.2.  Prepare Shapefiles 
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The goal of this step is to create Source Features and EO Representation 
shapes to match the tabular data stored in Oracle and displayed in 
Biotics Tracker. 

Tip: It is a good idea to make a copy of the log files that are created 
by the Link Source Features program.  These can be useful for 
QC and error checking.  The logs are saved into the GIS_WKSP 
folder, and are overwritten every time the Load EO program is 
run.  Copy the log files into a permanent location.   

 

For EOs that do not have previously digitized source features: 

1. Export EOCODE, LAT, LONG and PRECISION values from BCD 
into an ascii file. 

2. Create an Event Theme in ArcView and convert to a shapefile 

3. Project to match the coordinate system defined in the system and 
perform any necessary Datum transformation. 

4. Add fields to the shapefile for DISTANCE and DISTANCE UNITS 
and populate with values as determined by the program (usually 
based on precision value). 

 

For EOs that have been digitized into shapefiles or coverages (themes), 
prepare these as follows: 

1. The projection and datum of the themes must match the coordinate 
system defined in the system. 

2. The shapefile(s) must contain SOURCE FEATURES and the 
following fields: 

o EOCODE 
o Conceptual Feature Type (exact string required) 

� Point 
� Line 
� Polygon 

o Locational uncertainty Type (exact string required): 
� Areal – Estimated 
� Negligible 
� Areal – Delimited  
� Linear 

o Distance (if areal-estimated) 
o Distance Units (if areal-estimated) 

 

You must QC the data across all themes for: 

• Duplicate EOCODES - every record in the theme must have a 
unique EOCODE (combination of ELCODE and EONUM).  Use the 
Summarize function to confirm this.  You may load source features 
from multiple themes, which means you can load an EO that consists 

Prepare Source Feature 
Themes  

QC Shapefiles 
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of different types of shapes – points, lines, polygons.  However, if 
you plan to do so, you must make sure that all “duplicate” 
EOCODES across themes are legitimately part of the same EO. 

 

In order to load Source Features to be loaded into the Source Feature 
themes, they must contain the shape-id from the shape table in the 
database.   
 
1. Open Tracker and choose Tools>Query Builder. 

2. From the Query Builder, choose Query>Mode>Free Form 

3. Type the following select statement into the Query window: 

Select * from eocode_source_vw 

4. Click the  button to execute the Query and then the  button to 
view all the records. 

5. Choose Result>Export to File to export to a text file, and in the Save 
to File window: 

a. Fill in a file name 
b. Choose Tab as the delimiter to separate your fields  
c. Check the box to Include Field Names on the first row 
d. Click OK 

6. The text file can be brought directly into ArcView.  From the 
ArcView project window, click the table icon and click the Add 
button, then browse to your new table and click OK. 

7. Open the attribute tables for both the theme prepared above and the 
table just added to the project, and arrange them so that you can see 
both on the screen. 

8. Highlight the field with the EOCODE in both tables. 

9. With the shapefile attribute table active, choose Table>Join. 

10. You now have the feature-id (shape-id) field from the Biotics 
database associated with your shapefile.  Choose Theme>Convert to 
Shapefile. 

11. Repeat for each theme containing source features. 

 
19.3.   Link Source Features 

 
Now Load the Source features into the source feature themes: 
 
1. Choose Link Source Features from the Admin menu.  

2. In the Link Source Features window: 

o Select the theme radio button  

Join Shapefiles to shape-
ids 
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o Select the All records radio button. 
o Select the field you populated with the source_feature’s 

shape_id in the feature_id box 
o Select the Conceptual Feature Type field from the 

dropdown list 
o Select the Locational Uncertainty Type field from the 

dropdown list 
o Select the distance field from the dropdown list 
o Select the distance units field from the dropdown list 
o Click OK 

If you need to link sources of a different type( ie you have source lines 
and polygons for one EO) you will have to load the sources into the 
database manually. Download the file 
CVS:\hdms\sql\dataConversion\addSources.zip for procedures. 

19.4.  Generate EOs 
 
EO Rep polygons will be automatically generated for all EOs where all 
shapes are present (shape.has_shape_ind = ‘Y’) in one or multiple 
source feature themes.  If all source features have not been loaded, an 
error will be generated.   If there are multiple source features for a single 
Element Occurrence, records will be generated in the shape table for the 
new source features. 
 

Tip:  Before completing this step, confirm that all user-defined spatial 
attributes are set to NOT mandatory in Designer Admin. 

 
1. Select Generate EOs from the Admin menu. 

2. Click Yes to confirm that the number of EOs to be generated is 
correct and Click Yes.  If the number is not correct, click Cancel and 
determine the reason for the discrepancy before continuing.   

3. Check the log file for errors after the EOs complete generation. 

3. Calculation Centroid. 

 

You will need to post the themes explicitly at this point.  To do this: 

1. Make the EO Rep (Polygons) theme active. 

2. Choose Post Features from the Admin menu. 

3. Repeat for all Source Feature themes that were updated. 

Note: Mapped By and Mapped Date will retain the values that 
were converted from BCD.  Digital_Mapping_By and 
Digital_Mapping_Date will be left blank.  You will need to 
determine with the program, how these fields should be 
populated.  Recommended options are as follows: 

Post Themes 
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a. Populate digital mapping fields with data from paper 
mapping fields 

b. Populate digital mapping fields with “mgr” user and 
date of installation 

 

If there are Unmappable EOs in the database, these records will maintain 
the has_shape_ind = ‘N’ in the shape table.  When shapes are created for 
these records, they can be linked and generated as above. 

 

Unless you have chosen to maintain the spatial attributes values that 
were manually entered into the BCD System and not use any values 
calculated by Biotics, you must calculate spatial attributes for all EOs at 

this point.  If you want to maintain the values that were entered in 

BCD, then do not recalculate those attributes. 

Using Navigator, bring all the non-tiled themes that are the source of 
spatial attributes into the view, and turn them off.  This will improve 
speed, and reduce the likelihood of the NO FREE CHANNELS error.  
Also, open the attribute table for each of these themes and make sure the 
SHAPE field is indexed (make the SHAPE field active, and pull down 
the Field menu; if it says Create Index there is no index – so click on 
Create Index; if it days Remove Index then there is an index). 

1. Make sure your Load Scene preference (available on the Designer 
tab in the Preferences window) is set to ‘Add To View’. 

2. Enter Input/Edit mode.  Select the Element Occurrences palette, and 
EO Representation feature. 

3. Use the Add/Remove Oracle Attributes function (available on the 
Biotics menu) to ‘Remove all Oracle attributes’ for all Biotics 
themes.  This will speed up processing considerably. 

4. Select the EO Rep polygons for which you want to calculate spatial 
attributes. 

5. Choose Recalculate Spatial Attributes from the Admin menu. 

6. Click the Custom radio button. 

7. Choose the attributes to be calculated.  If you are calculating all 
attributes (which can only be done on a subset of your EOs), click 
the Select All button.  If you are calculating one attribute (which can 
be done for all EOs), select the attribute in the list. 

8. Click OK. 

Processing will now begin, and will likely take a very long time to 
complete.  Depending on your hardware, the number of attributes being 
calculated, the number of EOs being processed, and the themes used in 
the overlays, it may take several hours to complete processing. 

Unmappable EOs 

Calculate Spatial 
Attributes 
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19.5.  Quality Assurance 
 

The goal of this step is to ensure that all of the data from the BCD 
System has been loaded properly into Biotics.  In addition, Biotics can 
be used to compare spatial attributes that were manually entered into the 
BCD System with attributes calculated from reference theme data. 

 

Extensive data checks were done in the QC / Reformatting step (17.2).  
However, after the data has been loaded into the EO themes, there are a 
few additional checks that you should perform: 

1. Check the number of records in the EO Source Point and EO Reps 
(Polygons) themes.  The number of records should be the same as 
the number of EORs in the BCD System (less the number of 
unmappable EORs). 

 

The greatest potential for error during the creation of the EO themes lies 
in the coordinates. It is impossible to tell if the coordinates are accurate 
by visual examination alone, and mistakes made at this point can be very 
costly.  Great care therefore needs to be taken to confirm that the 
coordinates are correct. 

1. Randomly select a few records, and do as much as you can to 
confirm that the position is correct.  For example, you can use the 
data in the surveysite and directions fields in conjunction with 
reference theme data (e.g. a gazetteer) to confirm the location. 

2. If the coordinates were converted from one coordinate system to 
another, it is wise to confirm the final coordinates using another 
software program.  For example, if ArcInfo was used to convert the 
coordinates, then type the original coordinate into another program 
(e.g. Geographic Calculator), and see if the resulting coordinate is 
exactly the same as the coordinate that ArcInfo produced.  Confirm 
that the coordinate of the shape in ArcView matches the coordinate 
in the original table too. 

  

 

General Checks 

Coordinate Checks 
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20. CONFIGURING POWERPACK 

MAPPER 

Mapper includes Powerpack Mapper, a product used to produce ad-hoc 
or pre-defined map products (i.e. paper maps).  When Biotics is 
installed, there is only one map type - "Ad-hoc" - and only one template - 
"Ad-hoc".   

Map types and templates can be defined for the most commonly 
produced types of paper maps.  For example, you might create a map 
type and template for a province/state-wide 
Rare/Threatened/Endangered Species (RTES) map. 

 

The map type can include details such as: 

• the themes to be included in the map 

• themes to be labelled on the map 

• the scale of the map 

The template can include details such as: 

• paper size 

• cartographic content (titles, north arrows, scale bars, etc.) 

• the Member Program icon or logo 

 

Once map types and templates are defined, users can create standard 
paper maps with a few clicks.  Variables can be created to accept input 
for the Date of the map, the map Title, and so on. 

 

To configure Powerpack Mapper, use the “Mapper Admin” option on 
the Admin menu.  For more information, refer to the on-line help. 
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21. PUTTING BIOTICS INTO 

PRODUCTION 

Note:   the content in this section is intended primarily for 

NatureServe staff and includes links to NatureServe’s internal 

network for supporting material. 

 

21.1.  Installing Biotics Off-Site 
 
To configure Biotics off-site, it is possible to work through the entire 
installation/configuration guide from start to finish, performing the work 
in NatureServe’s support environment instead of directly on the client's 
network. 

The installation that you are creating—converted data, shapefiles, 
configuration details—will be packed up and delivered to the Member 
Program in its entirety.  Therefore, it should replicate the environment of 
the Member Program, as detailed in the Installation and Configuration 
Worksheet, on the support network (see Creating Biotics Environment 
section below). 

The most important consideration when configuring Biotics off-site is to 
make sure that your technical environment matches the client’s technical 
environment in several key areas: 

� Name of Oracle Tablespaces and Oracle user 

� Name of the ODBC data source 

� Drive path to the directory (or directories) 

Otherwise, it will make the delivery process considerably more 
complicated. 

A checklist overview of the steps to Configure and Deliver Biotics off-
site can be found on the NatureServe network at:  
\\cypress\groups\projects\Biotics\NetworkRollout\Installation\Installatio
n_Checklist.doc.  

 

To replicate the Member Program environment, the local environment 
must be configured identically to the destination environment: 
• The Oracle tablespace names should match those in the destination 

Oracle environment.  If the tablespace names differ in any way from 
the standard format (BIOTICS_DATA, BIOTICS_INDEX, 
BIOTICS_AUDIT, BIOTICSDEL_DATA) extra steps are required 
to import the Oracle database (see details below). 

Overview 

Creating the Biotics 
Environment 
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To create a non-standard Oracle environment: 

If the standard tablespace naming will be used, skip these steps.  Scripts 
referenced below can be found on the NatureServe network at 
\\Cypress\groups\projects\Biotics\Database\UtilityScripts\move_tablespac
e. 

1. Using DBA Studio, create tablespaces as they will be named in the 
destination environment. 

2. Create the schema owner as it will be named in the destination 
environment.   

3. Import the latest biotics_user database from the DMP file 
(containing the refresh from NatureServe’s production database for 
references, higher classification and scientific name data) to the 
destination user in your local environment.  Importing the database 
and running the XML2BIOTICS conversion software in the new 
environment, will take advantage of the fact that the tables 
containing CLOB data will be empty before conversion. 

To import the database, use a variation of the following command at 
a DOS prompt: 

imp <destination biotics 

user>/<password>@<SQL*Net alias> file=<DMP 

file path and name> log=<log path and name> 

fromuser=<biotics_user> touser=<destination 

biotics user> commit=y ignore=y 

4. Tables with large object fields will not import correctly to a 
tablespace with a different name.  To create these tables, listed 
below, run script “clob_tables.sql”.  

ALLIANCE 
ANIMAL_CAG 
ANIMAL_CAN 
ANIMAL_CAS 
COMMUNITY_GLOBAL 
CONSERVATION_SITE 
ELEMENT_GLOBAL 
ELEMENT_GLOBAL_RANK 
ELEMENT_GROUP 
ELEMENT_MANAGEMENT 
ELEMENT_NATIONAL_RANK 
ELEMENT_SUBNATL_RANK 
EO 
HIGHER_CLASS_UNIT 
PLANT_CAG 
PLANT_CAN 
PLANT_CAS 
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5. Once the tables have been created, run the batch file 
import_clob_tables.bat to populate the HIGHER_CLASS_UNIT 
table. 

 
6. Run the XML2BIOTICS conversion as usual, in the replicated 

Oracle environment. 
 

 
 
 
 

• Drive Mappings 

Based on the Member Program’s responses in the Installation and 
Configuration Worksheet, recreate the network drive mapping in your 
local environment.   

You can create a BAT file (using a text editor) to map your 
drives.  For example: 

net use G: /delete 

net use G: \\my_machine\biotics_ny /persistent:yes 

pause 

  

 

To deliver the configured version of Biotics: 

1. Check the Oracle privileges on the user to be exported using DBA 
Studio.  Convert the user’s access to connect and resource (if they 

are not already).  You should not export the user with DBA 
privileges due to the possibility of reduced permissions on-site 
leading to import problems. 

2. Export the Oracle database using the exp command (run from a 
command prompt).  For example, if the Oracle user is "biotics_user", 
the password is "password", the SQL*Net alias is "oracle_server", 
you want to name the export file "biotics.dmp", and you want to 
name the log file “biotics_exp.log”, you would run: 

exp biotics_user/password@oracle_server file=biotics.dmp 
log=biotics_exp.log owner=biotics_user compress=N 

The data will now be exported.  The export file will be created in the 
current directory. 

3. Make a data CD with materials to bring to the installation.  Copy the 
following onto the CD: 

� The Oracle .dmp file of the BIOTICS_USER 

� The Oracle .dmp file of the BIOTICS_DEL user 

� The entire “Biotics” application directory 

Preparing for 
Delivery 
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� Scripts (located on NatureServe network at 
\\Cypress\groups\projects\Biotics\Database\UtilityScripts): 

� Create_mtssys.sql 

� Mtssys_roles_privs.sql 

� Invalid_obj_check_and_analyze.txt 

� Disable_trigger_script.sql 

� Enable_trigger_script.sql 

� Any Database patches or upgrade scripts 

� BAT files for Oracle database backups 

 

4. Create a Biotics Installation CD by adding the following items 
(located on the NatureServe network at 
\\Cypress\groups\projects\Biotics\NetworkRollout\Installation\B
iotics_4_CD_Contents: 

� Executables 

� BioticsMapperSetup.exe 

� BioticsTrackerSetup.exe 

� ConnectionTest.exe 

� Powerpack.exe 

� Documentation 

� Biotics_MTS_Oracle_Config.doc 

� Creating_new_OracleDB.doc 

� Install_Config_Guide.doc 

 

To install the configured version of Biotics at the client's site: 

1. If necessary, create and configure the Oracle database to match 
exactly the one on which you prepared the configuration. 

2. Import the Oracle database using the imp command (run from a 
command prompt; for help on the IMP command, type “imp  
help=y”).  If the standard tablespace and Oracle username 
configuration is used, you can run the following import 
command: 

Imp biotics_user/<password>@<SQL*Net alias> 

file=<path and name of DMP file> log=<path and 

name of log file to create> fromuser=biotics_user 

touser=biotics_user 

 If the standard configuration has not been used, replace biotics_user 
above with the appropriate Oracle user name. 

Installing On-Site 
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Note:  If you arrive on site expecting to use the standard user and 
tablespace names, but find that is not possible, the data can be 
imported as described above in “Creating the Biotics Environment.”   

 

3. Copy the entire Biotics Mapper directories from the CD to the 
appropriate location on the server. 

4. Remove the read-only attribute from all files and folders copied 
from CD. 

5. Edit the INSTALL.INI file (located in the \biotics folder) and 
change any settings that were specific to your network.  This 
might include: 

• Name of the SQL*Net database alias 

• Path to the Biotics application directory 

• Tablespace names 

 

6. Install the Tracker application to the server, following Section 
5.1 (Tracker Server Installation).  It is recommended that the 
Authorization file be moved to the same file share as the Biotics 
directory, and the Tracker server registry altered accordingly. 

7. Install and configure Tracker and Mapper on the client 
machines, following Sections 5.2 and 9.8.  

8. Start Mapper, and do the following as necessary: 

• Do a database integrity check. 

• Set a Tiled Theme Index to allow modification of 
Preferences. 

• Alter Navigator definitions (if necessary). 

9. Perform a brief test in Mapper to make sure everything is 
working properly: 

• Start Mapper and login. 

• Add all the themes defined to Navigator to the view using 
Navigator. 

• Test all of the entries in Zoom By. 

• Create a Source Feature, EO, MA, and Site – make sure all 
spatial attributes are calculated properly. 

• Delete the features created above. 

10. Perform a brief test in Tracker to make sure everything is 
working properly: 
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• Start Tracker and login. 

• Search for Elements and add them to a Working List. 

• Click through all the tabs on Element and Element 
Occurrence records. 

• With Mapper open, click the View Shape button in an 
Element Occurrence record. 

 

Some of these tests may seem redundant since you will have tested 
the configuration on your network.  However you should never 
assume that because everything works on your network there will be 
no problems on-site.  All kinds of problems can surface such as 
insufficient privileges, read-only attributes on a master shapefile, 
reference theme data that is not located where it should be, etc. 

 

21.2.  Training 
 

Two separate training courses are recommended for Biotics users.  
Biotics Mapper training for programs new to the spatial methodology 
and the Mapper application should take place on-site during the 
installation week.  The Biotics Tracker and Administrator training 
course should take place about a month following installation, to give 
the users a chance to get familiar with the system.  The Tracker training 
is usually provided via the web over Citrix link and accompanied by a 
conference call. 

The Mapper course will typically require 3 days to complete, and should 
focus on the essential information (Revised EO Methodology, the basics 
of creating and editing EOs, using Mapper functions).  Tracker 
functionality should be demonstrated briefly so that users get a feel for 
what Biotics’ capabilities are, but otherwise should be left for the on-line 
course. 

The Mapper course should include as much “hands-on” training as 
possible.  This is best achieved using a combination of exercises at 
regular intervals (e.g. after an hour or two of instruction), and a one day 
“applied workshop” at the end of the course, where the users apply the 
knowledge they have learned over the past three days to do real work 
(enter EOs, edit EOs, answer data requests, etc.).  Students should bring 
typical or simple work examples, not overly complex ones.  The 
workshop is a very effective way to make sure that users practice what 
they have learned. 

It is essential that all users have Windows training and experience prior 
to the Biotics course.  It is also extremely helpful if users have basic 
ArcView training in advance.  This allows them to focus more on the 
Biotics-specific functionality. 

End-User Training 
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A separate ½ - 1 day training session should be held with the people who 
will administer Biotics (typically the data manager).  Topics covered in 
this course include backing up the system, creating new users, defining 
new themes to Navigator, installing Biotics on a new client machine, etc.  
It is also helpful to walk through where everything is installed on the 
server, and the configuration that has been completed. 

 

 

 

 

 

Administrator Training 
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22. MAINTAINING THE SYSTEM 

 
 

22.1.  Accessing the ADMIN Menu from Biotics Mapper 
 

Within Biotics, there is an “admin” menu that is used to perform various 
administrative functions.  This menu will only appear to users who 
belong to the "Administrators" group. Other users will not see this menu. 

To access the admin menu, log into Biotics as an administrative user 

(e.g. mgr).  If you enter the correct password, a menu titled “Admin” 
will appear when a view document is active. 

Note: To remove the admin menu, exit and restart Biotics as a 
different user. 

Detailed help for all of the options on the Admin menu is available on-
line. 

 
 

22.2.  Creating and Recovering Project Files 
 

ArcView project files can occasionally become corrupted for a variety of 
reasons.  When this happens, users will be unable to start Biotics 
Mapper. 

Generally speaking, project files are expendable, since they do not 
contain any actual data.  Therefore, in most cases, the corrupt project file 
can simply be replaced with a new (empty) project file.  The one 
exception to this is if a user has spent a lot of time creating custom 
layouts within the project.  In this case, it is desirable to recover the 
project file, so that no work is lost. 

 

Important Note:  This section originated with the Biotics 

3.1 Installation and Configuration Guide.  As of the 

publication date of this document, this has not been 

reviewed and revised for Biotics 4.  It will be revised in the 

next version of this document.  However, there is still a lot 

of useful information in this section that may still apply.  

Please keep this in mind as you read this section.  

Thank you. 
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1. Create a shortcut that starts ArcView with the /LOGON 
/APP=Biotics parameter.  Do not specify the name of a project file.  
For example: 

c:\esri\av_gis30\arcview\bin32\arcview.exe  /LOGON /APP=Biotics 

2. Double click on the shortcut to start ArcView.  The logon window 
should appear. 

3. Logon.  The ArcView window will then appear. 

4. Select Extensions from the File menu.  The extensions dialog will 
appear. 

� If you wish to use additional extensions, load them now before 
loading the Biotics extension (i.e. select the extension and click 
OK on the Extensions dialog).  See section 22.3 for more 
information on using other extensions with Biotics. 

5. Click the checkbox next to the Biotics extension. 

6. Click OK.  The Biotics program will now load.  This will take a few 
minutes. 

7. Save the project to the GIS_WKSP directory as "biotics.apr".  If 
there is an existing project file there, overwrite it. 

8. Remove the shortcut created in step (1). 

 

A backup of the project file is made every time the user exits Biotics.  
Backup files are created in the same directory the project file is located 
in (usually the GIS_WKSP directory), and are named based on the day 
of the week.  The first part of the backup filename will be the same as 
the first part of the project filename.  However, the first three letters of 
the current day of the week are used as the file extension instead of 
“.apr”.  For example, biotics.apr is backed up to biotics.mon, biotics.tue, 
biotics.wed, etc. 

If the project file becomes corrupted, replace the project file with the 
most recent valid backup project file.  For example: 

1. rename  biotics.apr  to  biotics.bad 

2. copy  biotics.fri  to  biotics.apr 

Note that regular backups of the entire system should also be made, as 
an additional fail-safe measure. 

 

 

22.3.  Using Other Extensions with Biotics Mapper 
 

Other extensions can be used with Biotics (e.g. the Geoprocessing 
Wizard, MrSID, etc).  However there is a potential that other extensions 

Creating a New 
Project File 

Recovering a 
Project File 
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could conflict with Biotics depending on how they have been 
programmed.  For example if another extension manipulates the object 
tags of themes in the view, Biotics will not function properly.  Generally 
extensions provided by ESRI (e.g. Spatial Analyst, Network Analyst, 
sample extensions, MrSID, etc.) are compatible with Biotics. 

If the extension has a user interface (i.e. it adds items to the menus, 
button bar, and/or toolbar), it must be loaded before the Biotics 
extension is loaded (otherwise you will not see the menus/buttons/tools).  
Therefore you must create a new project file, and load the extension 
before you load the Biotics extension.  See section 22.2 for information 
on how to create a new project file (pay particular attention to the bullet 
in step 4). 

Note: The presence of other extensions may cause Biotics menu items, 
buttons, and/or tools to become misplaced (e.g. shifted to the 
right). This can be corrected using Project Customize if 
necessary. 

If the extension does not have a user interface (e.g. the MrSID 
extension), it can be loaded at any time (there is no need to create a new 
project file). 

Once the project has been saved, the other extension will be 
automatically re-loaded the next time Biotics is started. 

If you wish to make other extensions available within Biotics to all users 
in your organization without having to go through all the steps to create 
a new project for every user, create the project once, and then just copy 
it to each user’s GIS_WKSP directory using Windows Explorer, 
overwriting the existing file (just make sure the project file is completely 
empty when you do this). 

 

 

22.4.  Moving the Application and/or Data 
 

Biotics Mapper maintains several pointers to the location of application 
files and data.  In addition, the project files contain complete paths to all 
data contained in the project.  For this reason, care must be taken when 
moving the application and/or data. 

 

If the Biotics Mapper software (i.e. \biotics\gis_app) is moved to a 
different server, a different drive, or a different location on the drive, 
you will have to make the following changes on each client machine: 

1. Update the following Registry keys: 

[HKEY_Local_Machine\Software\Linnet\Biotics\Logon\AuthorizationFile] 

[HKEY_Local_Machine\Software\Linnet\Biotics\Logon\LogonBitmapFile] 

Moving the Biotics 
Application 
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[HKEY_Local_Machine\Software\Linnet\Biotics\Logon\LogonDLLPath] 

[HKEY_Local_Machine\Software\Linnet\Biotics\Powerpack\Navigator\GIS_APP] 

[HKEY_Local_Machine\SOFTWARE\Linnet\Biotics\Powerpack\Navigator\EXE] 

2. Modify the PATH (…\biotics\gis_app\exe) 

3. Modify the shortcut in the Biotics folder on the Start menu for the 
Biotics Help. 

Note: If the software is moved, but the drive mapping to the software 
remains the same, then these steps can be omitted.  For example, the 
application is in N:\Biotics, but N:\ has changed from \\server1\apps to 
\\server2\apps.  

 

If the user's workspace (GIS_WKSP) is moved to a different drive, or a 
different location on the drive, you will have to make the following 
changes: 

1. The GIS_WKSP registry key needs to be updated to point to the new 
location on the client machine: 

[HKEY_Current_User\Software\Linnet\Biotics\Powerpack\Navigator\GIS_WKSP] 

2. The user's project file must be corrected.  This can be done in one of 
three ways: 

• Start Biotics, select the CANCEL ALL button when it starts 
asking you where all the data files are, and then save the project.  
The themes that were moved will be removed from the project, 
and re-loaded from the new location the first time they are 
needed. 

• Edit the project file using a text editor such as Notepad, and 
replace the old path with the new path using search/replace.  
Remember that ArcView stores all paths with forward slashes 
( / ) instead of back slashes ( \ ).  

• Create a new project file (see section 22.2). 

3. Modify the target in the Biotics shortcuts in the start menu and the 
desktop to point to the new drive. 

Note: If the workspace is moved, but the drive mapping to the 
workspace remains the same, then all these steps can be omitted. 

 

1. If a large amount of theme data has been moved (e.g. an entire 
directory containing dozens of themes), it is easiest to update the 
values in the location column in the THEME_LOCATION table 
directly using SQL. You can do this using tools provided with the 
DBMS (e.g. SQL*Plus).  Note that location values are typed in 
upper case. 

Moving the Biotics 
Workspace 

Moving Theme Data 
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If only a few themes have been moved, it is easiest to use Navigator 
Admin to re-browse for the theme location (edit the existing theme 
definition, click BROWSE, and point to the new theme location). 

2. The users' project files must be corrected (assuming they contain the 
theme data that was moved).  This can be done in one of three ways: 

• Start Biotics, select the CANCEL ALL button when it starts 
asking you where all the data files are, and then save the project.  
The themes that were moved will be removed from the project, 
and re-loaded from the new location the first time they are 
needed. 

• Edit the project file using a text editor such as Notepad, and 
replace the old path with the new path using search/replace.  
Remember that ArcView stores all paths with forward slashes  
( / ) instead of back slashes ( \ ).  

• Create a new project file (see section 22.2). 

Note: If the theme Data are moved, but the drive mapping to the data 
remains the same, then both steps can be omitted. 

 

If the SQL database is moved to a different host computer, you simply 
reconfigure the SQL*Net database alias to point to the new server using 
the utilities that come with Oracle (e.g. Net8 Configuration Assistant).  
Assuming the name of the alias and ODBC data source remains the 
same, no further action is required. 

If a new alias must be created for the new server, then you must update 
the registry: 

[HKEY_Local_Machine\Software\Linnet\Biotics\Database\ServerName] 

If a new ODBC Data Source must be created for the new server, then 
you must update the registry and two Oracle tables: 

[HKEY_Local_Machine\Software\Linnet\Biotics\Powerpack\Navigator\ODBC_DSN] 

• DATA_LOC table: 

UPDATE DATA_LOC SET PATH_ODBC = '<new DSN>' 

WHERE PATH_ODBC = '<old DSN>' 

• THEME_DATA table: 

UPDATE THEME_DATA SET ODBC_DSN = '<new DSN>' 

WHERE ODBC_DSN = '<old DSN>' 

In addition, ArcView stores data source names in the project file when 
SQL Data are present in the project (which is usually the case in 
Biotics).  You will therefore have to correct the users' project files.  This 
can be done one of three ways: 

• Start Biotics, and select the CANCEL button when it starts 
asking you to login to Oracle.  Then, remove all the themes from 

Moving the SQL 
Database 
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the view, and save the project.  The SQL data will be re-loaded 
from the new data source the first time it is needed. 

• Edit the project file using a text editor such as Notepad, and 
replace the old data source name with the new data source name 
using search/replace. 

• Create a new project file (see section 22.2). 

 

 

22.5.  Software Upgrades 
 

Always contact technical support before upgrading Windows, ArcView, 
or Oracle software on a computer that runs Biotics.  In many cases, a 
new version of Biotics will be required to work with the new software. 

 

 

22.6.  Backing Up Biotics Data 
 

The following should be backed up on a regular basis: 

• Oracle Database 

• Biotics theme data (e.g. \themes\biotics\…) 

• The Biotics Mapper application directory (many data files stored in 
the \gis_app sub-directory, such as legends, are modified when the 
application is used). 

• Other volatile theme data (e.g. \themes\user\) 

In addition, you should backup each user’s personal workspace. 
Technically, the “cloned” shapefiles in this directory are normally 
expendable.  However, the user may have created other data in their 
workspace directory, and therefore these directories should be included 
in the regular backup. 

 

In environments where data entry is being done on a daily basis, backups 
should be done daily (usually a full backup once a week, and 
incremental backups Monday through Friday).  In environments where 
data entry is less frequent, weekly backups may suffice. 

 

As long as Oracle is running, the database is “in use” and will be 
skipped by most tape backup software.  There are several different 
approaches to backing up the Oracle database such as (a) shutting down 

What to Backup 

How Often to Backup 

Backing up the Oracle 
Database 
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Oracle while the backup runs; (b) using the backup tools that come with 
Oracle; and (c) dumping (exporting) the database. 

The last approach (dumping the database) is the preferred approach for 
several reasons: (1) Oracle stays running the whole time, which is 
helpful in cases where processes are left running over night; (2) it is 
simple (no worries about Oracle not being restarted after the backup 
completes); and (3) it gives you a lot of flexibility in restoring data (e.g. 
you can pick and choose which tables/records you would like to restore, 
or you can restore the entire database). 

You can set up the server to automatically dump the database using the 
Windows Scheduler (the Windows “at” service). A batch file (.BAT) can 
be created to run at a set time (typically just before the nightly tape 
backup runs). 

For example, if your oracle user is “biotics_user” and the deleted data is 
in biotics_del and your Oracle net service name is “oracle_server”, the 
following commands will dump the database to file s:\biotics.dmp and 
s:\biotics_del.dmp: 

exp biotics_user/thepassword@oracle_server file=biotics_user.dmp 
log=biotics_user.log owner=biotics_user compress=N  

 

exp biotics_del/thepassword@oracle_server file=biotics_del.dmp 
log=biotics_del.log owner=biotics_del compress=N  

 

The dump files can then be scooped up by the regular tape backup (it is 
just an ordinary file, and will not be “in use”). 

Since the BAT file contains the Oracle password, make sure it is in a 
secure location where only Administrators can access it. 

For more information on the Oracle export command (exp), type “exp 
help=Y” at a DOS prompt, or refer to your Oracle documentation. 
 

 

22.7.  Recovering Deleted Data 
 

Although there is no 'undelete' function in Biotics, it is possible to 
recover deleted records from both the SQL database and the shapefiles 
(provided delete archiving has not been deactivated in Designer Admin).  

 

Generally, records in the SQL database are never deleted.  Instead, they 
are simply moved into the deleted schema.   Please consult the Biotics 
Help Desk for assistance with recovering data from your Oracle deleted 
schema. 

 

Recovering a Record 
from the SQL 
Database 
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Records in shapefiles are physically deleted when the shape is deleted.  
However, when delete archiving is activated in Designer Admin (which 
is the default setting), a copy of the shape is made to an archive shapefile 
before the shape is deleted from the original shapefile.  Therefore, by 
copying the shape from the archive shapefile into the original shapefile, 
the shape can essentially be undeleted. 

To undelete a shape: 

1. Go into "long menus" within Biotics Mapper. 

2. Make sure both the original theme and the archive theme are in the 
view (if they aren't, use Navigator to add them). 

3. Start editing the archive theme (make the theme active, and choose 
Start Editing from the Theme menu). 

4. Locate and select the shape to be undeleted. 

5. Choose Copy Features from the Edit menu. 

6. Stop editing the archive theme - do not save the changes (choose 
Stop Editing from the Theme menu). 

7. Start editing the original theme. 

8. Choose Paste from the Edit menu - the shape will be pasted into the 
shapefile. 

9. Open the attribute table for the original theme (choose Table from 
the Theme menu). 

10. Locate the row in the table that is highlighted (e.g. yellow), choose 
the edit tool on the toolbar, and then type in the same values that 
were in the archive theme for the following columns: 

• Feature_id 

• Feat_code 

• MappedBy 

• MappedDate 

Do not type values in for: 

• Record_num 

• Mod_By 

• Mod_Date 

Tip: to see what the original values were, you can do an Identify on 
the shape in the archive theme, or open the attribute table for the 
archive theme. 

11. Close the table document (be sure to press <enter> after typing in 
the last data value). 

12. Stop editing the original theme. 

13. (optional) choose Post Features from the Admin menu (if you don’t 
post the shape now, the shape will be posted the next time you start 
Biotics Mapper). 

Recovering a 
Record from a 
Shapefile 
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22.8.  Change Associated Element for EOs (Code Changes) 
 

From time to time, it is necessary to change the associated element for 
existing element occurrence records.  This process was known as a "code 
change" in BCD.   Since the element record no longer relies on the 
ELCODE as the primary key, this procedure has changed in Biotics 4.  
Detailed help for the “change associated element” procedure is available 
in the Biotics on-line help.   

 

22.9.  Temporary SQL Files 
 

Whenever ArcView queries data from Oracle, it creates a temporary 
SQL dbf file in the temp directory: 

 
These files are supposed to be deleted automatically. However, 
sometimes they are not, and they can be quite sizeable.  If there are 
hundreds of them, the C: drive could fill up. 

The best way to ensure these files are removed regularly is to create a 
BAT file that runs at startup on every Biotics Mapper client.  Depending 
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on the operating system of the client machine, the default temp directory 
location may vary. 

For Windows NT clients, the BAT file should contain the following 
command to delete these temporary files from the default temp directory: 

del c:\temp\sql*.dbf 

 

For Windows 2000 clients, adjust the BAT file for the following default 
temp directory location: 

del c:\"Documents and Settings"\c-datill\"Local Settings"\Temp\sql*.dbf 

(where c-datill=your user profile name) 

Put the BAT file in the Windows Startup folder of each user's profile:  
.../profiles/username/start menu/programs/startup.  Alternatively, you 
may put the file in the "All Users" profile.  This will execute every time 
you logon to Windows, and will automatically clean these files up. 

 

22.10.  Purging Features from Archive Themes 
 
At times, it may be desirable to permanently remove features from an 
Archive theme. This procedure is as follows: 

1. Log into Biotics Mapper as a user with administrator privileges. 

3. Add the archive theme to the view using Navigator. 

4. Choose Long Menus from the File menu. 

5. Select the records you wish to remove using any standard ArcView 
selection function (query builder, select feature tool, etc). 

6. Choose Lock Features from the Admin menu. 

7. Choose Start Editing from the Theme menu. 

8. Re-select the records to be deleted.  A quick way to do this is to 
open the attribute table for the theme (choose Table from the Theme 
menu), choose Select Locked Features from the Table menu, and 
then close the attribute table document. 

9. Choose Delete Features from the Edit menu. 

10. Choose Stop Editing from the Theme menu. 

11. Choose Post Features from the Admin menu. 

 

 

22.11.  Administering Multi-User Shapefiles 
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Multi-user shapefiles work on the following principle: a user never 

views or edits the original shapefile; they always view/edit a copy of the 

shapefile.  The original shapefile is referred to as the ‘MASTER’, and 
the copy is referred to as the ‘CLONE’. 

In general, multi user editing works as follows: 

� The user adds a multi-user shapefile to the list of open themes using 
Navigator.  When they click on the OK button in Navigator, the 
user’s workspace (GIS_WKSP) is searched for a Clone version of 
the shapefile, and then inserts the Clone into the view.  If it is the 
first time loading this particular multi user theme, a Clone version of 
the theme will not be found in the user’s workspace.  In such a case, 
Navigator will create a Clone by copying the Master version of the 
shapefile to the user’s workspace.   This is all transparent to the user. 

� If the user simply wishes to add new features to the shapefile, they 
may do so now using either standard ArcView tools and/or custom 
application tools. 

� If the user wishes to modify or delete an existing feature in the 
shapefile, they must first lock the feature, and then make the edit.  
When features are locked, no other users can edit them. 

� When all the new features have been added, and any desired edits 
made, the changes are posted to the Master shapefile.  

� Viewing changes made by other users that have been posted to the 
Master shapefile, is accomplished by performing a refresh on the 
theme. 

� When a theme is refreshed, all changes posted to the Master by other 
users since the last refresh will be copied to the Clone shapefile.  
The refresh options are available in menus, and are run 
automatically when the user exits Designer, or starts the application.  

� The shapefile is only viewed and edited using Navigator and multi-
user editing tools. 

 

Every time a change is made to a multi-user shapefile, it is logged in 
Oracle.  You can view this history option using the History… option on 
the Edit menu. 

From time to time (e.g. every few months) it is a good idea to purge the 
history information to maintain performance. 

 

Please refer to the document - Multi-user Shapefile Administration for 
more information multi-user shapefiles.  This document is provided on 
the Biotics Installation CD-ROM. 

 

Overview  

Edit History 

Trouble-Shooting and 
Further Reading 
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It is good practice to check the integrity of the database regularly (e.g. 
once a week).  This will help catch inconsistencies that might occur 
between the multi-user shapefiles and the Oracle database.  Biotics 
includes a function on the Admin menu that checks the integrity of the 
Element Occurrence database automatically. 

 

22.12. Error Messages in Biotics Mapper 
 

There are two basic types of error messages: 

• Uncontrolled error messages – errors that the software does not 
trap and handle – often leading to a crash. 

• Controlled error messages – errors that the software does trap 
and handle – often informing the user of a problem or an invalid 
action that has been performed. 

 

Uncontrolled error messages are typically characterized by 
cryptic/meaningless titles and message text.  For example: 

 

Typical uncontrolled ArcView error message: 

 
 

Typical uncontrolled PowerBuilder error message: 

 
 

Controlled error messages on the other hand usually provide a more 
meaningful message.  For example: 

Database Integrity 
Check 

Uncontrolled Error 
Messages 

Controlled Error 
Messages 
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Error messages almost always have the red X icon (or a red stop sign). 

 

In addition to error messages, there are also Warning and Information 
messages.  These are non-severe messages that are displayed to alert or 
inform the user of a particular situation.  Warning messages display with 

a yellow ! icon, and Information messages display with a blue i icon. 

Typical warning message: 

 

Typical information message: 

 

 
 

Dr Watson 
Means either the ArcView or PowerBuilder portion of Biotics has 
crashed.  Close any parts of the Biotics program that are open and restart 
Biotics. 

 

Application Terminated 
Means the PowerBuilder portion of Biotics has crashed.  Close the 
ArcView portion of Biotics and restart Biotics. 

 

Warning and 
Information Messages 

Common Error 
Messages 
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Null Object Reference 
Means the PowerBuilder portion of Biotics has crashed. Close the 
ArcView portion of Biotics and restart Biotics. 

 

Fatal Error 
Means the ArcView portion of Biotics has crashed.  Close the 
PowerBuilder portion of Biotics and restart Biotics. 

 

Shapefile may be corrupt 
A very serious error requiring immediate attention.  Could mean one of 
the clone and/or master shapefiles is corrupted.  Make backup copies of 
all master shapefiles, have all users stop using Biotics and perform a 
database integrity check immediately. 

 

Assertion "self->IsOpen" failed 
A serious uncontrolled ArcView error.  Close & restart Biotics. 

 

Assertion "fnum == self > CurrentSize" failed 
A serious uncontrolled ArcView error. May be an indication of 
corruption. Close & restart Biotics. 

 

AVArray: Index #### not in range 
An ArcView error, usually non-fatal.  May or may not be an indication 
of corruption.  Usually Biotics will continue to function properly.  If not, 
exit and restart Biotics. 

 

Number of shapes does not match number of table records 
A very serious error requiring immediate attention.  Means one of the 
clone and/or master shapefiles is definitely corrupted.  Make backup 
copies of all master shapefiles, have all users stop using Biotics and then 
identify which shapefile is corrupt and then correct the shapefile. 

 

Unable to establish DDE connection 
Usually means part of the Biotics application has crashed, often because 
of one of the above errors.  Close any parts of the Biotics program that 
are open and restart Biotics 

 

Unable to save changes 
PowerBuilder was unable to save the record to Oracle (most likely 
because Oracle is not responding).  Biotics will usually continue 
functioning. 
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Invalid Object for Describe Error 
 
The error message shown in Figure 222-1 may occur when using trying 
to run a query in Biotics Mapper.  One possible reason may be that 
someone had recently created some oracle view objects, which may need 
to be recompiled. 

 

Figure 222-1  - Invalid Object Error 

Using SQL*Plus or SQL*Plus Worksheet, run the following two 
commands (connected to Oracle as the application use, typically 
“biotics_user”): 
 
Spool bio4invalid.sql 
select ' alter '||OBJECT_TYPE||' '||object_name||' compile;'  from 
user_objects where status='INVALID'; 
spool off 
@bio4invalid 
exec 
dbms_utility.analyze_schema('BIOTICS_USER','COMPUTE'); 
REM  
 
Continue running this procedure until you have no more errors. 
 

22.13. Error Messages in Biotics Tracker 
 

Active User by Name Error 
 
If the error in Figure 22-2 occurs during the launch of Administrator or 
Tracker, the application is not able to communicate with the database via 
the COM objects on the application server. This may happen with Oracle 
8i when the application server is rebooted or when installing on a new 
server with Oracle 9i but not applying the dll patch. (See Oracle and 
MTS installation guide for 9i for information on how to install patch). 
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Figure 22-2 – Active User by Name Error 

To remedy this you will have to restart the Oracle service for Microsoft 
Transaction Manager (MTS) and the Distributed Transaction Controller 
(DTC) on the Microsoft Management console on the application server. 
 
First stop and restart the DTC by going to your control panel then 
administrative controls then component services. Right click on 
MyComputer and stop and restart the DTC as shown in Figure 222-3. 
 

 

Figure 222-3 – Stop and Restart DTC 

Next restart the Oracle MTS service (Oracle 8i only).  Go to Start -> 
Oracle Home -> Application Development -> Oracle Manager for 
Microsoft Transaction Manager and right click on the service as shown 
in Figure 222-4. If the service is already started then stop the service and 
restart. 
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Figure 222-4 – Restart Oracle MTS Service 

 
 

Test Connection Errors 
 
The following errors can appear when clicking the "test 
connection" button in the HDMS_ClientConfig.exe program. 
 

Incorrect Username and Password 
 

Check the following registry key:  
 
\HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\framew
ork\Database 
Make sure the USER ID and PASSWORD entries in this 
key match the database user. Note that case matters and the 
server may have to be rebooted after changing this key. 

 

Configured Identity is Incorrect 
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On the server go to control panel -> Administrative tools -> 
Component services -> My Computer -> COM+ 
Applications - > HDMS.  Right click on HDMS and select 
properties and click the identity tab. Account radio button 
must be set to 'this user' and the user entered must have 
administrative privileges on the server. The user may be a 
local user on the server. 
 
For the most up to date solutions to Biotics errors please 
consult the Biotics Knowledge Base located at  
http://support.natureserve.org/customer/default.htm 
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23. INSTALLATION DETAILS 

23.1. Workstation Configuration 
 

On each client that will run Biotics (Tracker or Mapper), changes are 
made to the Windows Registry.  The Biotics Mapper setup program 
makes the required registry edits automatically.  The Biotics Tracker 
installation requires that some registry edits be made manually. 

The following changes are also made on each client that will run Biotics 
Mapper: 

• Path 

• Shortcuts/Program Groups 

• Database Aliases 

• ODBC Data Sources 

• ArcView "default project" 

The Biotics Mapper setup program makes all these changes for you 
when Mapper is first installed.  If for some reason the workstation 
configuration is lost, re-run the setup program to re-establish all the 
settings (choose the User Setup option). 

 

The PATH must include the …\Biotics\GIS_APP\EXE directory.  For 
example, if Biotics is installed in N:\Biotics, the PATH must include 
"n:\Biotics\gis_app\exe". 

 

A shortcut must be created to start Biotics Mapper.  You cannot start 
Mapper by double clicking on a project file (.apr) using "My Computer" 
or "Windows Explorer", or by starting ArcView and then opening the 
project file. 

The properties of the shortcut are usually as follows: 

C:\ESRI\AV_GIS30\ARCVIEW\BIN32\arcview.exe 
Q:\GIS_WKSP\biotics.apr /LOGON /APP=BIOTICS 

Name:  Mapper 

Target:  C:\ESRI\AV_GIS30\ARCVIEW\BIN32\arcview.exe  ~ 

 Q:\GIS_WKSP\biotics.apr /LOGON /APP=BIOTICS 

Start In: Q:\GIS_WKSP\ 
Icon:  Q:\Biotics\gis_app\exe\biotics.exe 

 
Usually you create the shortcut without the project file 
(Q:\Biotics\GIS_WKSP\Biotics.apr) in the target, start the application, 

Summary of 
Changes 

Path 

Shortcuts/Program 
Groups 
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load the Biotics extension, save the project file to 
Q:\Biotics\GIS_WKSP\Biotics.apr, and then modify the shortcut to 
include the project file. 

Alternatively, you can have a ‘blank’ Biotics.apr that you can simply 
copy into each user’s GIS_WKSP folder. 

 

The Mapper setup program for client installation adds the following keys 
to the Registry: 

 

[HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\Biotics\ArcView] 

WaitTime The amount of time (in seconds) PowerBuilder will 
wait for a DDE transaction to complete.  Value should 
be “30”. 

 
[HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\Biotics\Database] 

DBMS Identifies the DBMS being used.  Value must be “O84 
ORACLE 8.0.4”. 

DbParm Database parameter.  Value must be 
DisableBind=1,DelimitIdentifier='No' 

SEQUENCES Indicates whether Oracle sequences are to be used 
instead of seed tables.  Value must be “YES”. 

ServerName The connect string that PowerBuilder uses to connect 
to the database.  This is the Oracle Net Service 
name.  The value for this is installation specific 
(default = “oracle_server”). 

 
 [HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\Biotics\Logon] 

LogonDlgStyle Window style of the logon dialog.  Value should be 
“2”. 

AuthorizationFile Path to the authorization file (accounts.com).  The 
first part of the path  value is installation specific; the 
last part must be “\gis_app\etc\accounts.com”. 

LogonBitmapFile Path to the bitmap to be displayed on the logon 
dialog (Biotics.bmp). The first part of the path  value 
is installation specific; the last part must be 
“\gis_app\icons\Biotics.bmp”. 

LogonDLLPath Path to the location of LinnetLogon.dll.  The first part 
of the path  value is installation specific; the last part 
must be “\gis_app\exe\linnetlogon.dll”. 

 
[HKEY_LOCAL_MACHINE\SOFTWARE\Linnet\Biotics\Powerpack\Navigator] 

DATE Specifies where the current date should be obtained 
from.  Value must be “DBMS”. 

DBMS Specifies which database is being used.  Value must 
be “ORACLE”. 

EXE Path to the Biotics.exe application.  The first part of 
the path  value is installation specific; the last part 
must be “\gis_app\exe\Biotics.exe”. 

ExeDelay This is the number of seconds the Avenue code will 
wait before launching BIOTICS.EXE; value is 1. 

GIS_APP Specifies the location where Biotics is installed on the 
server.  This value is installation specific.  For 

Mapper Registry Keys 
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example, if Biotics is installed on drive “N:” in a 
directory called “Biotics”, the GIS_APP value will be 
"N:\Biotics\". 

ODBC_DSN Name of the ODBC data source that ArcView will use 
to connect to the database.  This value is installation 
specific (default = “ORA_SERVER”). 

RestoreAfterLogon Indicates if the ArcView window should restore after a 
successful logon.  Value must be “YES”. 

SQLConnectString The complete connect string Biotics will use to 
connect to the database.  Value must be 
“dsn=[ODBC_DSN];uid=[USERNAME];pwd=[PASSW
ORD]”. 

 
 [HKEY_CURRENT_USER\SOFTWARE\Linnet\Biotics\Powerpack\Navigator] 

TabIndex ID of the last tab that was active in the Navigator 
window.  This is a system maintained value. 

CatalogType Last setting for the 'Show Catalog' option in 
Navigator.  This is a system maintained value. 

UserLibrary Last setting for the 'Show Library' option in Navigator.  
This is a system maintained value. 

GIS_WKSP Specifies where the current user’s workspace is 
located.  The workspace is a location on disk where 
temporary files generated by Biotics will be placed.  
This value is installation specific.  The workspace can 
be located on a network drive (e.g. 
K:\USERS\SMITH) or on a local drive (e.g. 
C:\USERS\SMITH).   

 

Tracker server and client installation requires the following keys in the 
Registry.  While the Tracker setup program automatically creates these 
Registry keys, some of them must be manually edited by the installer. 
Care must be taken to preserve the case of the keys when 
modifying/adding these keys.  For example: server_name is not the same 
as Server_Name.  If the key uses different case than is outlined in the 
"Registry" sections, Biotics may not function correctly. 

Tracker Client Registry Entries: 

[HKEY_LOCAL_MACHINE\Software\Linnet\BIOTICS] 

server_name: Specifies the MTS server that the Biotics 
client should connect to.  This can be either 
a valid IP address or URL if using RDS or 
the name of a computer on the local network 
if using COM. 

 Note: If using RDS it is recommended to 
prepend the URL or IP address with "http://" 
(of course without the double quotes). 

server_type:  Specifies the communication method to use 
between the Biotics client and MTS server.  
Valid values are COM or RDS and are case 
insensitive.   

Tracker Registry Keys 
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[HKEY_LOCAL_MACHINE\Software\Linnet\BIOTICS\RichT
ext\Dictionary] 

Main:  Specifies the path to the dictionary that the 
Linnet RichTextControl should use as it's 
main dictionary.  The contents of this 
dictionary never change.  

Custom:  Specifies the path to the dictionary that the 
Linnet RichTextControl should use as its 
custom dictionary.  This is the dictionary 
file that is added to when the user elects to 
Add words to the dictionary during spell 
checking. 

Tracker Server Registry Entries: 

[HKEY_LOCAL_MACHINE\Software\Linnet\Framework\Com
ponents] 

This key contains one key for each iBCF class.  
Within each key is a string value: 

ComponentPropertiesFile: This value specifies the location of 
the XML Property File for the given class. 

[HKEY_LOCAL_MACHINE\Software\Linnet\Framework\Data
base] 

ConnectionString: This is the connection string that Biotics 
uses to connect to the Oracle data source.  
This string must use the Oracle OLEDB 
provider for Oracle and NOT the Microsoft 
OLEDB provider for Oracle because the 
Microsoft provider does not support CLOB 
fields. 

Unless there is a valid reason to change it, 
the string should be as follows (of course 
with the USER ID and PASSWORD 
changed): 

PROVIDER=OraOLEDB.Oracle.1;DAT

A SOURCE=ORACLE_SERVER;USER 

ID=Biotics_lgi_test;PASSWORD=B

iotics_lgi_test 

[HKEY_LOCAL_MACHINE\Software\Linnet\Framework\Logg
ing] 

LogFileName: Specifies the file to log framework 
information to.  Caution: This file can grow 

quite quickly if logging is set to it's most 

verbose setting.  
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LogLevel: Specifies the level of framework logging.  
Valid values are between 0 and 15.  0 = 
Logging off, 15 = Most information. 

Note: Only turn logging on for debugging.  
Use of the log file is not intended for use 
when multiple users are accessing Biotics 
and could cause instabilities in the system. 

[HKEY_LOCAL_MACHINE\Software\Linnet\BIOTICS\Logon
] 

AuthorizationFile:  Specifies the file that the Logon.dll should 
use for user authentication.  Since 
authentication in Biotics uses an 
authentication file and values in the 
database, care must be taken that the 
authentication file remains in sync with the 
database.  To ensure this always use the 
Administrator application to make changes 
to user names/passwords and never edit the 
authentication file by hand. 

[HKEY_LOCAL_MACHINE\Software\Linnet\BIOTICS\Server
] 

PersistanceType: This is only used by the High-Speed 
Recordset object and the Working List 
object.  It identifies which persistence type 
that ADO should use when transferring 
ADO Recordsets between the client and the 
server.  Valid values are "adtg" and "xml".  
Adtg is significantly faster! 

Note: The installation program does not 
create this key.  If the key does not exist 
Biotics will default to using adtg. 

 

 

 
Biotics Mapper requires a database alias (Oracle Net Service Name) to 
be defined in order to communicate with the database.  The name of this 
alias can be any value (default is "oracle_server").  The database alias is 
referenced in the following places: 

� ODBC Data Source 

� Registry: 
[HKey_Local_Machine\Software\Linnet\Biotics\Database\ServerName] 

� \Biotics\GIS_App\Install.INI 

 

Database Alias 
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Biotics Mapper requires an ODBC (Open DataBase Connectivity) data 
source to be defined in order to communicate with the Oracle database.  
The data source name references the database alias (e.g. 
"oracle_server").  The name of the data source name can be any value 
(default is "ora_server"). The data source name is referenced in the 
following places: 

� DATA_LOC 

� THEME_DATA 

� THEME_LOCATION 

� The registry 
[HKey_Local_Machine\Software\Linnet\Biotics\Powerpack\Navigator\ODBC_DSN] 

� \Biotics\GIS_App\Install.INI 

� ArcView project files (if SQL Data are in the project) 

 

The standard ArcView "system default project file" (default.apr) in the 
ArcView "etc" directory is replaced when Biotics Mapper is installed 
(the original project file is renamed to "default_av.apr"). 

 

23.2. Server Configuration 
 
Biotics Mapper creates the following directories and files: 

\Biotics\GIS_APP This directory (and all the sub-directories within it) contain 
the Mapper program files, and a variety of ancillary files 
required by the program. 

\Biotics\GIS_APP\Data This directory contains a few database files (DBFs) required 
by Mapper.  Users require READ and WRITE access to this 
directory. 

\Biotics\GIS_APP\Etc This directory contains miscellaneous files required by 
Mapper, including the definition of the coordinate system 
(coordsys.odb).  Users require READ access to this directory; 
and the Mapper administrator requires WRITE access. 

\Biotics\GIS_APP\Exe This directory contains executable programs and batch files 
required by Mapper.  Users require READ access to this 
directory. 

ODBC Data Sources 

ArcView Default 
Project 
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\Biotics\GIS_APP\Ext32 Five extension files are added to this directory when Mapper 
is installed: 

• Biotics.avx 

• Designer.avx 

• Mapper.avx 

• Navigator.avx 

• Nav_Grid.avx 

\Biotics\GIS_APP\Help The Biotics User’s Guide is stored in this directory.  Users 
require READ access to this directory. 

\Biotics\GIS_APP\Icons This directory contains files used as icons and banners within 
Mapper.  Users require READ access to this directory. 

\Biotics\GIS_APP\Incoming This directory is used as a temporary storage area during 
software installation and upgrades.  Users require READ and 
WRITE access to this directory. 

\Biotics\GIS_APP\Incoming\SQL This directory contains database scripts that are used to 
initially create, and subsequently modify the Oracle tables and 
views. 

\Biotics\GIS_APP\Legends Legends saved for themes using the Legend Manager within 
Mapper are stored in this directory.  Users require READ and 
WRITE access to this directory. 

\Biotics\GIS_APP\Outgoing Data exported from Mapper to other systems, such as a data 
warehouse, is placed in this directory.  Users require READ 
and WRITE access to this directory. 

\Themes Some or all of the theme data used within Mapper (including 
the Mapper themes themselves) are located in sub-directories 
within this directory.  This will vary with each installation, 
but as a minimum, will contain the “Biotics” and “USER” 
sub-directories.  If the default location is accepted, the 
THEMES directory will be created in the location specified 
by the GIS_APP environment variable.  However, the person 
installing the software can choose to install the THEMES 
directory anywhere on the network. 

\Themes\Biotics All map data captured and maintained by Mapper is stored in 
this directory.  This includes the “master” shapefiles for 
Element Occurrences, Managed Areas, and Sites. Users 
require READ and WRITE access to this directory. 

\Themes\Biotics\Archive Archive shapefiles for the Mapper themes (Element 
Occurrences, Managed Areas, and Sites) are stored in this 
directory. Archive shapefiles are updated whenever a shape is 
edited or deleted.  Users require READ and WRITE access to 
this directory. 
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\Themes\User All shapefile themes created using Navigator are placed in 
this directory. The shapefiles are named starting with “U” 
followed by a unique number (e.g. U403.shp\shx\dbf).  Users 
require READ and WRITE access to this directory. 

 
23.3. General Data Model Information 

 
The Biotics 4 Physical Data Model is a comprehensive data model 
consisting of all the business tables and views used in the Tracker, 
Administrator, and Mapper applications.  In the future, this model will 
also contain the tables and views used for the Exchanger application.   
 
The data model can be viewed and downloaded at the following 

location: http://whiteoak.natureserve.org/hdms/HDMS-
DataModel.shtml.  There is an html document and a MS Word 

document that can be downloaded and printed.  There is also an Excel 
spreadsheet that contains a listing of all tables and columns with their 
data types.  The model contains some introductory material that explains 
the notation and how to use the model.  This is the definitive source for 
information about the data model.  However, here are some points of 
general information: 
 
� Tables starting with “D_” are domain tables.  The values in these 

tables can be altered during installation / configuration. 

� Oracle “sequences” are used to generate the next ID for feature_id, 
spatial_attribute_id, ma*counter, and site*counter. 

� There are many more Security and Powerpack tables in the database 
that are not shown in the Physical Data Model.  These are all 
maintained through Administrative tools, and very rarely have to be 
accessed directly using SQL. 

� There are many referential integrity constraints between tables.  This 
means that operations must be done in a certain order. 

� Views (shown only in the PDM) are joined to the shapefiles in 
ArcView. 

 

23.4. Shapefiles 
 
The following window displays the attribute table of the EO.Rep 
Polygons theme: 
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All attributes to the left of the vertical line shown on the previous page 
are physically in the shapefile (the DBF that accompanies the 
SHP/SHX).  These attributes are as follows: 

� SHAPE – contains the actual shape (point, line, polygon) 

� FEATURE_ID – the primary key; matches a shape_id in the SHAPE 
table in the Oracle database; should always have a number > 0, and 
must be unique across all shapefiles. 

� FEAT_CODE – indicates what type of feature the record is (EO 
Rep, Source Line, etc).  All records within a shapefile should have 
the same (non-zero) value. 

� RECORD_NUM – a sequential number within each shapefile; 
unrelated to feature_id.  Used by the multi-user shapefile code.  New 
records have a value of 0 until they are posted.  Values > 0 must be 
unique within the shapefile.  ** This field is hidden by default. ** 

� MOD_BY – the user id of the last person who modified the record.  
Usually blank when the record is first created, and then populated 
when the record is posted. 

� MOD_DATE – the date when the record was last modified.  Usually 
blank when the record is first created. 

� MAPPEDBY – the user id of the person who initially created the 
record. 

� MAPPEDDATE – the date when the record was initially created. 

� THEMEFIELD – a “scratch” field, used for multi-field legends in 
Legend Manager 

 

Real Attributes 
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All attributes to the right of the vertical line shown on the previous page 
are joined to the shapefile from an Oracle view. The attributes that are 
present depend on what view is joined to the theme – see section 17 for 
more information on Oracle views.  Refer to the data model report on the 
Biotics CD-ROM for a complete description of Oracle attributes. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Virtual Attributes 


